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About This Book

WARNING! Text set off in this manner indicates that failure to follow directions could result in bodily
harm or loss of life.

CAUTION: Text set off in this manner indicates that failure to follow directions could result in
damage to equipment or loss of information.

NOTE: Text set off in this manner provides important supplemental information.
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1 Product Features

Feature Overview
The HP Pro 3400/3500 series includes the following features:

● Choice of Intel® (HP Pro 3500, HP Pro 3400, and HP Pro 3410) or AMD processor (HP Pro
3505 and HP Pro 3405)

● Choice of integrated graphics or ATI or NVIDIA discrete graphics cards

● Up to 8 GB DDR3 SDRAM system memory available standard (depending on model)

● Hard drives (vary by model):

3.5-inch, 250 GB/320 GB/500 GB/750 GB/1 TB/1.5 TB, 2.0 TB

● Optical drives (vary by model):

SuperMulti LightScribe drive

SuperMulti DVD drive

DVD-ROM drive

● Integrated Realtek RTL8171E Gigabit Ethernet Controller (HP 3500 and HP Pro 3400 Pro only)
or Integrated Realtek RTL8111E PCI-E Gigabit Ethernet Controller (HP 3405 Pro only) and
Integrated Realtek RTL8111EL PCI-E Gigabit Ethernet Controller (HP 3410 Pro only)

● 10 USB 2.0 ports on HP Pro 3500 and HP Pro 3400 (5 on board header (including 2 on Front I/
O, 4 rear, 1 mini card)

● 13 USB 2.0 ports on HP Pro 3405 (4 dual on board header (including 2 on Front I/O, 4 rear, 1
mini card)

● 10 USB 2.0 ports on HP Pro 3410 (5 on board header (including 2 on Front I/O, 4 rear)

● Video ports:

Model 3500 and 3400

DVI

VGA

Model 3405

DVI-I
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DVI-D

Model 3410

VGA

HDMI

● HP Wireless NIC 802.11b/g/n Mini Card (1x1) (optional for HP Pro 3500, 3400, and 3405)

● 5.1 channel audio (HP Pro 3500, 3400, and 3410); 7.1 channel audio (HP Pro 3405)

● Genuine Windows 7 versions, FreeDOS, or RedFlag Linux
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Microtower Components

Table 1-1  Microtower Components

1 (1) external 5.25” drive bay for optional optical
drive

6 Model 3400/3405/3500: (3) PCIe x1 slots, (1) PCIe
x16 slot, (1) miniPCI slot*1

Model 3410: (1) PCIe x1 slot, (1) PCIe x16 slot, (2)
PCI 2.2 slots

2 Power Supply 7 USB Scroll Mouse

3 Rear I/O includes: (4) USB 2.0 ports, RJ-45
network interface, DVI and VGA video interfaces,
microphone jack, audio in/out jacks (5.1 channel
audio out)

8 HP USB Standard Value Keyboard

4 Front I/O includes: (2) USB 2.0 ports, dedicated
headphone output, microphone jack

9 Display (sold separately)

5 (1) internal 3.5” hard drive bays   

1 HP Pro 3500, 3400, and 3405 only, HP Pro 3410 has no mini PCI slot
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Small Form Factor Components

Table 1-2  Small Form Factor Components

1 External 5.25” drive bay for optical drive 6 Power Supply

2 Internal 3.5” hard drive bay 7 USB Scroll Mouse

3 Rear I/O includes: (3) PCIe x1 slots, (1) PCIe x16
slot, (1) miniPCI slot, (4) USB 2.0 ports, RJ-45
network interface, DVI and VGA video interfaces,
microphone jack, audio in/out jacks (5.1 channel
audio out)

8 HP USB Standard Value Keyboard

4 Front I/O includes: (2) USB 2.0 ports, dedicated
headphone output

9 Monitor (sold separately)

5 HP 6-in-1 Media Card Reader (some models)   
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2 Installing and Customizing the
Software

If your computer was not shipped with a Microsoft operating system, some portions of this
documentation do not apply. Additional information is available in online help after you install the
operating system.

NOTE: If the computer was shipped with Windows 7 loaded, you will be prompted to register the
computer with HP Total Care before installing the operating system. You will see a brief movie
followed by an online registration form. Fill out the form, click the Begin button, and follow the
instructions on the screen.

CAUTION: Do not add optional hardware or third-party devices to the computer until the operating
system is successfully installed. Doing so may cause errors and prevent the operating system from
installing properly.

NOTE: Be sure there is a 10.2-cm (4-inch) clearance at the back of the unit and above the monitor
to permit the required airflow.

Installing the Operating System
The first time you turn on the computer, the operating system is installed automatically. This process
takes about 5 to 10 minutes, depending on which operating system is being installed. Carefully read
and follow the instructions on the screen to complete the installation.

CAUTION: Once the automatic installation has begun, DO NOT TURN OFF THE COMPUTER
UNTIL THE PROCESS IS COMPLETE. Turning off the computer during the installation process may
damage the software that runs the computer or prevent its proper installation.

NOTE: If the computer shipped with more than one operating system language on the hard drive,
the installation process could take up to 60 minutes.

If your computer was not shipped with a Microsoft operating system, some portions of this
documentation do not apply. Additional information is available in online help after you install the
operating system.

Downloading Microsoft Windows Updates
1. To set up your Internet connection, click Start > Internet Explorer and follow the instructions on

the screen.

2. Once an Internet connection has been established, click the Start button.
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3. Select the All Programs menu.

4. Click on the Windows Update link.

The Windows Update screen appears. Click view available updates and make sure all critical
updates are selected. Click the Install button and follow the instructions on the screen.

It is recommended that you install all of the critical updates and service packs.

5. After the updates have been installed, Windows will prompt you to reboot the machine. Be sure
to save any files or documents that you may have open before rebooting. Then select Yes to
reboot the machine.

Installing or Upgrading Device Drivers (Windows
systems)

When installing optional hardware devices after the operating system installation is complete, you
must also install the drivers for each of the devices.

If prompted for the i386 directory, replace the path specification with C:\i386, or use the Browse
button in the dialog box to locate the i386 folder. This action points the operating system to the
appropriate drivers.

Obtain the latest support software, including support software for the operating system from
http://www.hp.com/support. Select your country and language, select Download drivers and
software (and firmware), enter the model number of the computer, and press Enter.

Accessing Disk Image (ISO) Files
There are disk image files (ISO files) included on your PC that contain the installation software for
additional software. These CD image files are located in the folder C:\SWSetup\ISOs. Each .iso file
can be burned to CD media to create an installation CD. It is recommended that these disks be
created and the software installed in order to get the most from your PC. The software and image file
names are:

● Corel WinDVD SD and BD – installation software for WinDVD – used to play DVD movies

● HP Insight Diagnostics OR Vision Diagnostics – software to perform diagnostic activities on your
PC

Protecting the Software
To protect the software from loss or damage, keep a backup copy of all system software,
applications, and related files stored on the hard drive. Refer to the operating system or backup utility
documentation for instructions on making backup copies of your data files.
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3 Computer Setup (F10) Utility

Computer Setup (F10) Utilities
Use Computer Setup (F10) Utility to do the following:

● Change factory default settings.

● Set the system date and time.

● Set, view, change, or verify the system configuration, including settings for processor, graphics,
memory, audio, storage, communications, and input devices.

● Modify the boot order of bootable devices such as hard drives, optical drives, or USB flash
media devices.

● Enable Quick Boot, which is faster than Full Boot but does not run all of the diagnostic tests run
during a Full Boot. You can set the system to:

❑ always Quick Boot (default);

❑ periodically Full Boot (from every 1 to 30 days); or

❑ always Full Boot.

● Select Post Messages Enabled or Disabled to change the display status of Power-On Self-Test
(POST) messages. Post Messages Disabled suppresses most POST messages, such as
memory count, product name, and other non-error text messages. If a POST error occurs, the
error is displayed regardless of the mode selected. To manually switch to Post Messages
Enabled during POST, press any key (except F1 through F12).

● Establish an Ownership Tag, the text of which is displayed each time the system is turned on or
restarted.

● Enter the Asset Tag or property identification number assigned by the company to this computer.

● Enable the power-on password prompt during system restarts (warm boots) as well as during
power-on.

● Establish a setup password that controls access to the Computer Setup (F10) Utility and the
settings described in this section.

● Secure integrated I/O functionality, including the serial, USB, or parallel ports, audio, or
embedded NIC, so that they cannot be used until they are unsecured.

● Enable or disable removable media boot ability.
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● Solve system configuration errors detected but not automatically fixed during the Power-On Self-
Test (POST).

● Replicate the system setup by saving system configuration information on a USB device and
restoring it on one or more computers.

● Execute self-tests on a specified ATA hard drive (when supported by drive).

● Enable or disable DriveLock security (when supported by drive).

Using Computer Setup (F10) Utilities

Computer Setup can be accessed only by turning the computer on or restarting the system.
To access the Computer Setup Utilities menu, complete the following steps:

1. Turn on or restart the computer. If you are in Microsoft Windows, click Start > Shut Down >
Restart.

2. Press either Esc or F10 while the “Press the ESC key for Startup Menu” message is displayed at
the bottom of the screen.

Pressing Esc displays a menu that allows you to access different options available at startup.

NOTE: If you do not press Esc or F10 at the appropriate time, you must restart the computer
and again press Esc or F10 when the monitor light turns green to access the utility.

3. If you pressed Esc, press F10 to enter Computer Setup.

4. A choice of five headings appears in the Computer Setup Utilities menu: File, Storage, Security,
Power, and Advanced.

5. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and
down) keys to select the option you want, then press Enter. To return to the Computer Setup
Utilities menu, press Esc.

6. To apply and save changes, select File > Save Changes and Exit.

● If you have made changes that you do not want applied, select Ignore Changes and Exit.

● To reset to factory settings or previously saved default settings (some models), select
Apply Defaults and Exit. This option will restore the original factory system defaults.

CAUTION: Do NOT turn the computer power OFF while the BIOS is saving the Computer Setup
(F10) changes because the CMOS could become corrupted. It is safe to turn off the computer only
after exiting the F10 Setup screen.

Table 3-1  Computer Setup (F10) Utility

Heading Table

File Computer Setup—File on page 9

Storage Computer Setup—Storage on page 10

Security Computer Setup—Security on page 12

Power Computer Setup—Power on page 15

Advanced Computer Setup—Advanced on page 16
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Computer Setup—File

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-2  Computer Setup—File

Option Description

System Information Lists:

● Product name

● SKU number (some models)

● Processor type/speed/stepping

● Cache size (L1/L2/L3) (dual core processors have this listed twice)

● Installed memory size/speed, number of channels (single or dual) (if applicable)

● Integrated MAC address for embedded, enabled NIC (if applicable)

● System BIOS (includes family name and version)

● Chassis serial number

● Asset tracking number

About Displays copyright notice.

Set Time and Date Allows you to set system time and date.

Apply Defaults and
Exit

Applies the currently selected default settings and clears any established passwords.

Ignore Changes
and Exit

Exits Computer Setup without applying or saving any changes.

Save Changes and
Exit

Saves changes to system configuration or default settings and exits Computer Setup.
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Computer Setup—Storage

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-3  Computer Setup—Storage

Option Description

Device Configuration Lists all installed BIOS-controlled storage devices.

When a device is selected, detailed information and options are displayed. The following options
may be presented:

Hard Disk: Size, model, firmware version, serial number.

Emulation type has the following choices:

● None (prevents BIOS data accesses and disables it as a boot device)

● Hard Disk (treated as a hard disk)

CD-ROM: Model, firmware version, serial number.

Storage Options SATA Emulation

Allows you to choose how the SATA controller and devices are accessed by the operating
system. There are two supported options: IDE and AHCI.

The default is set based on the Feature Byte code stored in the SMBIOS Type11/Feature Byte
string as follows:

Feature Byte Default

FBC_SATA_RAID RAID

FBC_SATA_AHCI AHCI

FBC_SATA_IDE IDE

Otherwise (none found) Platform-dependent - to be implemented by BIOS Integrator

IDE - This is the most backwards-compatible setting of the three options. Operating systems
usually do not require additional driver support in IDE mode.

AHCI (default option) - Allows operating systems with AHCI device drivers loaded to take
advantage of more advanced features of the SATA controller.
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Table 3-3  Computer Setup—Storage (continued)

DPS Self-Test Allows you to execute self-tests on ATA hard drives capable of performing the Drive Protection
System (DPS) self-tests.

NOTE: This selection will only appear when at least one drive capable of performing the DPS
self-tests is attached to the system.

Boot Order Allows you to:

● Specify the order in which EFI boot sources (such as a internal hard drive, USB hard drive,
USB optical drive, or internal optical drive) are checked for a bootable operating system
image. Each device on the list may be individually excluded from or included for
consideration as a bootable operating system source.

EFI boot sources always have precedence over legacy boot sources.

● Specify the order in which legacy boot sources (such as a network interface card, internal
hard drive, USB optical drive, or internal optical drive) are checked for a bootable operating
system image. Each device on the list may be individually excluded from or included for
consideration as a bootable operating system source.

● Specify the order of attached hard drives. The first hard drive in the order will have priority in
the boot sequence and will be recognized as drive C (if any devices are attached).

NOTE: You can use F5 to disable individual boot items, as well as disable EFI boot and/or
legacy boot.

NOTE: MS-DOS drive lettering assignments may not apply after a non-MS-DOS operating
system has started.

Shortcut to Temporarily Override Boot Order

To boot one time from a device other than the default device specified in Boot Order, restart the
computer and press Esc (to access the boot menu) and then F9 (Boot Order), or only F9 (skipping
the boot menu) when the monitor light turns green. After POST is completed, a list of bootable
devices is displayed. Use the arrow keys to select the preferred bootable device and press Enter.
The computer then boots from the selected non-default device for this one time.
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Computer Setup—Security

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-4  Computer Setup—Security

Option Description

Setup Password Allows you to set and enable a setup (administrator) password.

NOTE: If the setup password is set, it is required to change Computer Setup options, flash the
ROM, and make changes to certain plug and play settings under Windows.

If a setup password is set, the computer requires that you enter it before accessing the following
functions: Boot Menu (F9), Computer Setup (F10), System Recovery (F11), Network Boot (F12).

See the Desktop Management Guide for more information.

Power-On Password Allows you to set and enable a power-on password. The power-on password prompt appears
after a power cycle. If the user does not enter the correct power-on password, the unit will not
boot.

NOTE: This selection will only appear when at least one drive that supports the DriveLock
feature is attached to the system.

See the Desktop Management Guide for more information.

Password Options

(This selection appears
only if a power-on
password or setup
password is set.)

Allows you to enable/disable:

● Lock Legacy Resources (appears if a setup password is set). Default is enabled.

● Setup Browse Mode (appears if a setup password is set) (allows viewing, but not changing,
the F10 Setup Options without entering setup password). Default is enabled.

● Password prompt on F9, F11, & F12 (allows access to menus without entering setup
password). Default is enabled.

● Network Server Mode (appears if a power-on password is set). Default is disabled.

See the Desktop Management Guide for more information.

Device Security Allows you to set Device Available/Device Hidden (default is Device Available) for:

● System audio

● Serial ports (some models)

● Parallel port (some models)

● Network controller

NOTE: You must disable AMT before trying to hide the network controller.

● SATA0

● SATA1

● SATA2

● SATA3
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Table 3-4  Computer Setup—Security (continued)

USB Security Allows you to set Enabled/Disabled (default is Enabled) for:

● Front USB Ports

◦ USB Port 3

◦ USB Port 4

● Rear USB Ports

◦ USB Port 8

◦ USB Port 9

◦ USB Port 10

◦ USB Port 11

● Internal USB Ports

◦ USB Port 0

◦ USB Port 1

◦ USB Port 2

◦ USB Port 5

Slot Security Allows you to disable any PCI Express or MiniCard slot. Default is enabled.

Network Boot Enables/disables the computer’s ability to boot from an operating system installed on a network
server. (Feature available on NIC models only; the network controller must be either a PCI
expansion card or embedded on the system board.) Default is enabled.
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Table 3-4  Computer Setup—Security (continued)

System IDs Allows you to view:

● Product Name

● Serial number

● Universal Unique Identifier (UUID) number. The UUID can only be updated if the current
chassis serial number is invalid. (These ID numbers are normally set in the factory and are
used to uniquely identify the system.)

● SKU Number

● Family Name

● Asset tag (18-byte identifier), a property identification number assigned by the company to
the computer.

● Feature Byte

● Build ID

● Keyboard locale setting for System ID entry

System Security
(some models: these
options are hardware
dependent)

Data Execution Prevention (enable/disable) - Helps prevent operating system security breaches.
Default is enabled.

Virtualization Technology (VTx/VTd)(some models) (enable/disable) - Controls the virtualization
features of the processor and DMA remapping features of the chipset. Changing this setting
requires turning the computer off and then back on. Default is disabled.

Intel TXT (LT) Support (some models) (enable/disable) - Controls the underlying processor and
chipset features needed to support a virtual appliance. Changing this setting requires turning the
computer off and then back on. Default is disabled. To enable this feature you must enable the
following features:

● Embedded Security Device Support

● Virtualization Technology

● Virtualization Technology Directed I/O

Embedded Security Device Support (some models) (enable/disable) - Permits activation and
deactivation of the Embedded Security Device. Changing this setting requires turning the
computer off and then back on.

NOTE: To configure the Embedded Security Device, a Setup password must be set.

● Reset to Factory Settings (some models) (Do not reset/Reset) - Resetting to factory defaults
will erase all security keys. Changing this setting requires turning the computer off and then
back on. Default is Do not reset.

CAUTION: The embedded security device is a critical component of many security
schemes. Erasing the security keys will prevent access to data protected by the Embedded
Security Device. Choosing Reset to Factory Settings may result in significant data loss.

OS management of Embedded Security Device (some models) (enable/disable) - This option
allows the user to limit operating system control of the Embedded Security Device. Changing this
setting requires turning the computer off and then back on. This option allows the user to limit OS
control of the Embedded Security Device. Default is enabled.

Reset of Embedded Security Device through OS (some models) (enable/disable) - This option
allows the user to limit the operating system ability to request a Reset to Factory Settings of the
Embedded Security Device. Changing this setting requires turning the computer off and then back
on. Default is disabled.

NOTE: To enable this option, a Setup password must be set.

14 Chapter 3   Computer Setup (F10) Utility



Computer Setup—Power

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-5  Computer Setup—Power

Option Description

Hardware Power
Management

SATA Power Management – Enables or disables SATA bus and/or device power management.
Default is enabled.

S5 Maximum Power Savings – Turns off power to all nonessential hardware when system is off to
meet EUP Lot 6 requirement of less than 1 Watt power usage. Default is enabled.

S5 Wake on LAN (enable/disable).

● To disable Wake on LAN during the off state (S5), use the arrow (left and right) keys to
select the Advanced > Device Options menu and set the S5 Wake on LAN feature to
Disable. This obtains the lowest power consumption available on the computer during S5. It
does not affect the ability of the computer to Wake on LAN from suspend or hibernation, but
will prevent it from waking from S5 via the network. It does not affect operation of the
network connection while the computer is on.

● If a network connection is not required, completely disable the network controller (NIC) by
using the arrow (left and right) keys to select the Security > Device Security menu. Set the
Network Controller option to Device Hidden. This prevents the network controller from being
used by the operating system and reduces the power used by the computer in S5.

Thermal CPU Fan Speed (view only) – Lets you view fan speed.

System Fan Speed (view only) – Lets you view fan speed.
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Computer Setup—Advanced

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-6  Computer Setup—Advanced (for advanced users)

Option Heading

Power-On Options Allows you to set:

● POST messages (enable/disable). Default is disabled.

● After Power Loss (off/on/previous state). Default is Power off. Setting this option to:

◦ Power off—causes the computer to remain powered off when power is restored.

◦ Power on—causes the computer to power on automatically as soon as power is
restored.

◦ Previous state—causes the computer to power on automatically as soon as power is
restored, if it was on when power was lost.

NOTE: If you turn off power to the computer using the switch on a power strip, you will not be
able to use the suspend/sleep feature or the Remote Management features.

● POST Delay (in seconds). Enabling this feature will add a user-specified delay to the POST
process. This delay is sometimes needed for hard disks on some PCI cards that spin up very
slowly, so slowly that they are not ready to boot by the time POST is finished. The POST
delay also gives you more time to select F10 to enter Computer (F10) Setup. Default is
None.

BIOS Power-On Allows you to set the computer to turn on automatically at a time you specify.

Bus Options On some models, allows you to enable or disable:

● PCI SERR# Generation. Default is enabled.

● PCI VGA Palette Snooping, which sets the VGA palette snooping bit in PCI configuration
space; only needed when more than one graphics controller is installed. Default is disabled.

Device Options Allows you to set:

● Num Lock State at Power-On (off/on). Default is off.

● Integrated Video (enable/disable). Use this option to disable the integrated video controller
when another video controller is present in the system. Default is enabled.

● Multi-Processor (enable/disable). Use this option to disable multi-processor support under
the OS. Default is enabled.

● NIC PXE Option ROM Download (PXE, iSCSI, disabled). The BIOS contains an embedded
NIC option ROM to allow the unit to boot through the network to a PXE server. This is
typically used to download a corporate image to a hard drive. The NIC option ROM takes up
memory space below 1MB commonly referred to as DOS Compatibility Hole (DCH) space.
This space is limited. This F10 option will allow users to disable the downloading of this
embedded NIC option ROM thus giving more DCH space for additional PCI cards which may
need option ROM space. The default will be to have the NIC option-ROM-enabled. Default is
PXE.
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Recovering the Configuration Settings
This method of recovery requires that you first perform the Save to Removable Media command
with the Computer Setup (F10) Utility before Restore is needed.

NOTE: It is recommended that you save any modified computer configuration settings to a USB
flash media device and save the device for possible future use.

To restore the configuration, insert the USB flash media device with the saved configuration and
perform the Restore from Removable Media command with the Computer Setup (F10) Utility.
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4 Illustrated parts catalog

This chapter provides spare part information for all chassis.

Microtower Chassis Spare Parts

Computer Major Components
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Item Description Spare part number

(1) Access panel 674373-001

(2) Front bezel  

 For use in only the EMEA region 667849-001

 With optical drive door for use in Brazil 667849-201

 For use in the North America and Latin America regions 670692-001

(3) Power supply, 300W  

 300W, active PFC, not for use in Brazil 656721-001

689005-001

 300W 664862-001

692096-001

(4) System board (includes replacement thermal material)  

 For use in 3500 models with Intel processors 687577-001

 For use in 3505 models with AMD processors 687578-001

 For use in 3400 models with Intel processors 660281-001

 For use in 3410 models with Intel processors in Brazil 665223-001

 For use in 3405 models with AMD processors 660155-001

 Memory modules (not illustrated)  

 PC3-10600, 1333-MHz, for use in 3400/3405/3410 models  

 ● 4-GB 585157-001

 ● 2-GB 635803-001

 ● 1-GB 635802-001

 PC3-12800, 1666-MHz, for use in 3500/3505 models  

 ● 4-GB 671613-001

 ● 2-GB 671612-001

 Processors (include replacement thermal material; not illustrated)  

 Intel processors (for use in model 3500/3400/3410)  

 Intel Core i7 2600S (2.8-GHz, 8-MB L3 cache; not for use in Brazil) 638419-001

 Intel Core i7 2600 (3.4-GHz, 8-MB L3 cache) 638632-001

 Intel Core i5 2500 (3.3-GHz, 6-MB L3 cache; not for use in Brazil) 638631-001

 Intel Core i5 2400 (3.1-GHz, 6-MB L3 cache; not for use in Brazil) 638630-001

 Intel Core i5 2320 (3.0-GHz, 6-MB L3 cache) 665121-001

 Intel Core i5 2310 (2.9-GHz, 6-MB L3 cache; not for use in Brazil) 657111-001

 Intel Core i5 2300 (2.8-GHz, 6-MB L3 cache; not for use in Brazil) 654601-001

 Intel Core i3 2130 (3.4-GHz, 3-MB L3 cache; not for use in Brazil) 665120-001
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Item Description Spare part number

 Intel Core i3 2125 for use only in HP Pro 3500 models (3.3-GHz, 3-MB L3 cache; not for
use in Brazil)

677427-001

 Intel Core i3 2120 (3.3-GHz, 3-MB L3 cache; not for use in Brazil) 638629-001

 Intel Core i3 2105 (3.1-GHz, 3-MB L3 cache; not for use in Brazil) 655970-001

 Intel Core i3 2100 (3.1-GHz, 3-MB L3 cache) 638628-001

 Intel Pentium Dual-Core, G860 (3.0-GHz, 3-MB L3 cache; not for use in Brazil) 665123-001

 Intel Pentium Dual-Core, G850 (2.9-GHz, 3-MB L3 cache) 655973-001

 Intel Pentium Dual-Core, G840 (2.8-GHz, 3-MB L3 cache; not for use in Brazil) 655972-001

 Intel Pentium Dual-Core, G630 (2.7-GHz, 3-MB L3 cache; not for use in Brazil) 665122-001

 Intel Pentium Dual-Core, G620 (2.6-GHz, 3-MB L3 cache) 655971-001

 Intel Celeron G540 (2.5-GHz, 2-MB L3 cache; not for use in Brazil) 665119-001

 Intel Celeron G530 (2.4-GHz, 2-MB L3 cache; not for use in Brazil) 665117-001

 Intel Celeron G440 (1.6-GHz, 1-MB L3 cache; not for use in Brazil) 665467-001

 AMD Advanced Processing Units (APUs) (for use in model 3505/3405)  

 A-Series, X4 A8-3870 for use only in HP Pro 3505 models (3.0 GHz, 4-MB L2 cache,
65W; Radeon HD6550D graphics core)

671611-001

 A-Series, X4 A8-3820 for use only in HP Pro 3505 models (2.5 GHz, 4-MB L2 cache,
65W; Radeon HD6550D graphics core)

671610-001

 A-Series, X4 A8-3800 (2.4 GHz, 4-MB L2 cache, 65W; Radeon HD6550D graphics core) 667723-001

 A-Series, X4 A6-3670 for use only in HP Pro 3505 models (2.7 GHz, 4-MB L2 cache,
100W; Radeon HD6550D graphics core)

671609-001

 A-Series, X4 A6-3650 (2.6 GHz, 4-MB L2 cache, 100W; Radeon HD6550D graphics
core)

667722-001

 A-Series, X4 A6-3620 (2.2 GHz, 4-MB L2 cache, 65W; Radeon HD6530D graphics core) 671608-001

 A-Series, X4 A6-3600 (2.1 GHz, 4-MB L2 cache, 65W; Radeon HD6530D graphics core) 667724-001

 A-Series, X4 A8-3550 (2.9 GHz, 4-MB L2 cache, 100W; Radeon HD6550D graphics
core)

667721-001

 A-Series, X4 A4-3420 for use only in HP Pro 3505 models (2.8 GHz, 4-MB L2 cache,
65W; Radeon HD6530D graphics core)

680937-001

 A-Series, X4 A4-3400 (2.7 GHz, 4-MB L2 cache, 65W; Radeon HD6530D graphics core) 667725-001

 A-Series, X2 E2-3200 (2.4 GHz, 1-MB L2 cache, 65W; Radeon HD6370D graphics core) 667726-001
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Cables

Item Description Spare part number

(1) Power switch/LED assembly 667850-001

(2) SATA cable, 165 mm 657102-001

(3) SATA cable, 254 mm 667854-001

 Adapter, DVI to VGA, HF (not illustrated) 657401-001
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Misc Parts

Item Description Spare part number

(1) Fan sink (includes replacement thermal material)  

 For use in models with Intel processors 667727-001

 For use in models with AMD processors 657402-001

(2) Front I/O and USB assembly  

 Does not include card reader 667853-001

 Includes card reader 667852-001

(3) Chassis fan  

 For use in EMEA, North American, and Latin American regions; not for Brazil 657103-001

 For use in Brazil 514238-001, or

434645-001

 Mouse (optical, USB; not illustrated) 596410-001

 HP Business Digital Headset 642738-001

 Rubber feet (not illustrated) 530593-001
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Drives

Description Spare part number

Hard drive  

2-TB, 5400-rpm 613210-001

1.5-TB, 7200-rpm 613209-001

1.5-TB, 5400-rpm 652272-001

1-TB, 7200-rpm 667719-001

750-GB, 7200-rpm 632938-001

500-GB, 7200-rpm 667720-001

250-GB, 7200-rpm 621419-001

Optical drive  

16X SATA DVD-ROM drive (not for Brazil) 581599-001

16X SATA DVD±RW drive 581600-001

Misc Boards

Description Spare part number

AMD Radeon HD 7570 2-GB DDR3 FH PCIe x16 Card for use only in HP Pro 3500/3505 models 679219-001

AMD Radeon HD 7450 1-GB DDR3 FH PCIe x16 Card for use only in HP Pro 3500/3505 models 679218-001

AMD Radeon HD 7350 512MB DDR3 FH PCIe x16 Card for use only in HP Pro 3500/3505
models

676356-001

ATI Radeon HD 6570 2-GB graphics adapter, full height (not for use in Brazil) 638406-001

ATI Radeon HD 6450 1-GB graphics adapter 638132-001

ATI Radeon HD 6450 512-MB graphics adapter 647449-001

AMD Radeon HD 6350 512MB DDR3 FH PCIe x16 Card 671728-001

nVidia GeForce GT640 3-GB graphics adapter, full height for use only in HP Pro 3500/3505
models (not for use in Brazil)

687226-001

nVidia GeForce GT630 2-GB graphics adapter, full height for use only in HP Pro 3500/3505
models (not for use in Brazil)

687580-001

nVidia GeForce GT620 1-GB graphics adapter, full height for use only in HP Pro 3500/3505
models (not for use in Brazil)

687579-001

nVidia GeForce GT530 2-GB graphics adapter, full height (not for use in Brazil) 657106-001

nVidia GeForce GT405 512-MB graphics adapter (not for use in Brazil) 657108-001

nVidia GeForce GT520 1-GB graphics adapter, full height (not for use in Brazil) 657399-001

802.11b/g/n (1x1) WLAN module 634906-001
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Sequential Part Number Listing

Spare part
number

Description

434645-001 Chassis fan for use in Brazil

514238-001 Chassis fan for use in Brazil

530593-001 Rubber feet

581599-001 16X SATA DVD-ROM drive (not for Brazil)

581600-001 16X SATA DVD±RW drive

585157-001 Memory module, 4-GB, PC3 10600, 1333-MH

596410-001 Mouse, USB, optical

613209-001 1.5-TB hard drive

613210-001 2-TB, 5400-rpm hard drive

621419-001 250 GB, 7200 rpm SATA hard drive

632938-001 750-GB, 7200 RPM hard drive

634906-001 802.11b/g/n (1x1) WLAN module

635802-001 Memory module, 1-GB, PC3 10600, 1333-MHz

635803-001 Memory module, 2-GB, PC3 10600, 1333-MHz

638132-001 ATI Radeon HD 6450 1-GB graphics adapter

638406-001 ATI Radeon HD 6570 2-GB graphics adapter, full height (not for use in Brazil)

638419-001 Intel Core i7 2600S processor (2.7-GHz, 8-MB L3 cache; not for use in Brazil)

638628-001 Intel Core i3 2100 processor (3.1-GHz, 3-MB L3 cache)

638629-001 Intel Core i3 2120 processor (3.3-GHz, 3-MB L3 cache)

638630-001 Intel Core i5 2400 processor (3.1-GHz, 6-MB L3 cache; not for use in Brazil)

638631-001 Intel Core i5 2500 processor (3.3-GHz, 6-MB L3 cache; not for use in Brazil)

638632-001 Intel Core i7 2600 processor (3.4-GHz, 8-MB L3 cache)

642738-001 HP Business Digital Headset

647449-001 ATI Radeon HD 6450 512-MB graphics adapter

652272-001 1.5-TB, 5400-rpm hard drive

654601-001 Intel Core i5 2300 processor (2.8-GHz, 6-MB L3 cache; not for use in Brazil)

655970-001 Intel Core i3 2105 processor (3.1-GHz, 3-MB L3 cache; not for use in Brazil)

655971-001 Intel Pentium Dual-Core, G620 (2.6-GHz, 3-MB L3 cache)

655972-001 Intel Pentium Dual-Core, G840 (2.8-GHz, 3-MB L3 cache; not for use in Brazil)

655973-001 Intel Pentium Dual-Core, G850 (2.9-GHz, 3-MB L3 cache)

657399-001 nVidia GeForce GT520 1-GB graphics adapter, full height (not for use in Brazil)

657401-001 DVI to VGA adapter, HF
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Spare part
number

Description

657402-001 Fan sink for use in models with Intel processors (includes replacement thermal material)

656721-001 Power supply, 300W, active PFC, not for use in Brazil

656790-001 Intel Core i5 2405S (2.5-GHz, 6-MB L3 cache; not for use in Brazil)

657102-001 SATA cable, 165 mm

657402-001 Fan sink for use in models with AMD processors (includes replacement thermal material)

657103-001 Chassis fan

657106-001 nVidia GeForce GT530 2-GB graphics adapter, full height (not for use in Brazil)

657108-001 nVidia GeForce GT405 512-MB graphics adapter (not for use in Brazil)

657111-001 Intel Core i5 2310 processor (2.9-GHz, 6-MB L3 cache; not for use in Brazil)

660155-001 System board for use in models with AMD processors on 3405 models (includes replacement thermal
material)

660281-001 System board for use in models with Intel processors on 3400 models (includes replacement thermal
material)

664862-001 Power supply, 300W

665117-001 Intel Celeron G530 processor (2.4 GHz, 2-MB L3 cache, 65W; not for Brazil)

665119-001 Intel Celeron G540 processor (2.5 GHz, 2-MB L3 cache, 65W; not for Brazil)

665120-001 Intel Core i3 2130 processor (3.4 GHz, 3-MB L3 cache, 65W; not for Brazil)

665121-001 Intel Core i5 2320 processor (3.0 GHz, 6-MB L3 cache, 95W)

665122-001 Intel Pentium Dual-Core G630 processor (2.7 GHz, 3-MB L3 cache, 65W; not for Brazil)

665123-001 Intel Pentium Dual-Core G860 processor (3.0 GHz, 3-MB L3 cache, 65W; not for Brazil)

665223-001 System board for use in models with Intel processors on 3410 models in Brazil (includes thermal material)

665467-001 Intel Celeron G440 (1.6 GHz, 1-MB L3 cache, 35W; not for Brazil)

667719-001 1 TB hard drive

667720-001 500 GB hard drive

667721-001 AMD A-Series X4 A8-3550 processor (2.8 GHz, 4-MB L2 cache, 100W; Radeon HD6550D graphics core;
not for use in Brazil)

667722-001 AMD A-Series X4 A6-3650 processor (2.6 GHz, 4-MB L2 cache, 100W; Radeon HD6550D graphics core;
not for use in Brazil)

667723-001 AMD A-Series X4 A8-3800 processor (2.4 GHz, 4-MB L2 cache, 65W; Radeon HD6550D graphics core; not
for use in Brazil)

667724-001 AMD A-Series X4 A6-3600 processor (2.1 GHz, 4-MB L2 cache, 65W; Radeon HD6530D graphics core; not
for use in Brazil)

667725-001 AMD A-Series X2 A4-3400 processor (2.7 GHz, 4-MB L2 cache, 65W; Radeon HD6530D graphics core; not
for use in Brazil)

667726-001 AMD A-Series X2 E2-3200 processor (2.4 GHz, 1-MB L2 cache, 65W; Radeon HD6370D graphics core; not
for use in Brazil)

667727-001 Fan sink for use in models with Intel processors
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Spare part
number

Description

667849-001 Front bezel for use in the EMEA region

667849-201 Front bezel with optical drive door for use in Brazil

667850-001 Power switch/LED assembly with cable

667852-001 Front I/O and USB assembly; includes card reader

667853-001 Front I/O and USB assembly; does not include card reader

667854-001 SATA cable, 254 mm

670692-001 Front bezel for use in North America and Latin America regions

671608-001 AMD A-Series, X4 A6-3620 processor (2.2 GHz, 4-MB L2 cache, 65W; Radeon HD6530D graphics core)

671609-001 AMD A-Series, X4 A6-3670 processor (2.7 GHz, 4-MB L2 cache, 100W; Radeon HD6550D graphics core)
for use only in HP Pro 3505 models

671610-001 AMD A-Series, X4 A8-3820 processor (2.5 GHz, 4-MB L2 cache, 65W; Radeon HD6550D graphics core) for
use only in HP Pro 3505 models

671611-001 AMD A-Series, X4 A8-3870 processor (3.0 GHz, 4-MB L2 cache, 65W; Radeon HD6550D graphics core) for
use only in HP Pro 3505 models

671612-001 2-GB memory module, PC3-12800, 1666-MHz, for use in 3500/3505 models

671613-001 4-GB memory module, PC3-12800, 1666-MHz, for use in 3500/3505 models

671728-001 AMD Radeon HD 6350 512MB DDR3 FH PCIe x16 Card

674373-001 Access panel

676356-001 AMD Radeon HD 7350 512MB DDR3 FH PCIe x16 Card

677427-001 Intel Core i3 2125 for use only in HP Pro 3500 models (3.3-GHz, 3-MB L3 cache; not for use in Brazil)

679218-001 AMD Radeon HD 7450 1-GB DDR3 FH PCIe x16 Card for use only in HP Pro 3500/3505 models

679219-001 AMD Radeon HD 7570 2-GB DDR3 FH PCIe x16 Card for use only in HP Pro 3500/3505 models

680937-001 AMD X2 A4-3420 processor (2.8 GHz, 4-MB L2 cache, 65W; Radeon HD6530D graphics core) for use only
in HP Pro 3505 models

687226-001 nVidia GeForce GT640 3-GB graphics adapter, full height (not for use in Brazil) for use only in HP Pro
3500/3505 models

687577-001 System board for use in 3500 models with Intel processors

687578-001 System board for use in 3505 models with AMD processors

687579-001 nVidia GeForce GT620 1-GB graphics adapter, full height for use only in HP Pro 3500/3505 models (not for
use in Brazil)

687580-001 nVidia GeForce GT630 2-GB graphics adapter, full height for use only in HP Pro 3500/3505 models (not for
use in Brazil)

689005-001 Power supply, 300W, active PFC, not for use in Brazil

692096-001 Power supply, 300W
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Small Form Factor (SFF) Chassis Spare Parts

Computer major components

Item Description Spare part number

(1) Access panel 656832-001

(2) Front bezel 656835-001

(3) Power supply  

 220W 656722-001

 270W 665224-001

(4) System board (includes replacement thermal material) 665223-001

 Memory modules (PC3-10600, 1333-MHz; not illustrated)  

 4-GB 585157-001

 2-GB 635803-001

 1-GB 635802-001

 Processors (include replacement thermal material; not illustrated)  

 Intel Core i7 processor:  

 2600S (2.8-GHz, 8-MB L3 cache, 65W) 638419-001

 Intel Core i5 processors:  

 2500S (2.7-GHz, 6-MB L3 cache, 65W) 638420-001
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Item Description Spare part number

 2500 (3.3 GHz, 6-MB L3 cache, 95W) 638631-001

 2405S (2.5-GHz, 6-MB L3 cache, 65W) 656790-001

 2400S (2.5-GHz, 6-MB L3 cache, 65W) 640953-001

 2400 (3.1 GHz, 6-MB L3 cache, 95W) 638630-001

 2320 (3.0 GHz, 6-MB L3 cache, 95W) 665121-001

 2310 (2.9 GHz, 6-MB L3 cache, 95W) 657111-001

 2300 (2.8 GHz, 6-MB L3 cache, 95W) 654601-001

 Intel Core i3 processors:  

 2130 (3.4 GHz, 3-MB L3 cache, 65W) 665120-001

 2120 (3.3-GHz, 3-MB L3 cache, 65W) 638629-001

 2105 (3.1-GHz, 3-MB L3 cache, 65W) 655970-001

 2100 (3.1-GHz, 3-MB L3 cache, 65W) 638628-001

 Intel Pentium Dual-Core processors:  

 G860 (3.0-GHz, 3-MB L3 cache, 65W) 665123-001

 G850 (2.9-GHz, 3-MB L3 cache, 65W) 655973-001

 G840 (2.8-GHz, 3-MB L3 cache, 65W) 655972-001

 G630 (2.7 GHz, 3-MB L3 cache, 65W) 665122-001

 G620 (2.6-GHz, 3-MB L3 cache, 65W) 655971-001

 G540 (2.5 GHz, 2-MB L3 cache, 65W) 665119-001

 G530 (2.4 GHz, 2-MB L3 cache, 65W) 665117-001

 G530T (2.0 GHz, 2-MB L3 cache, 35W) 665118-001
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Cables

Item Description Spare part number

(1) Power switch/LED assembly 656984-001

(2) SATA cable, 370 mm 656833-001
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Misc Parts

Item Description Spare part number

(1) Chassis fan 656834-001

(2) Fan sink (includes replacement thermal material) 657402-001

(3) Front I/O and card reader (6-in-1) 656983-001

 DVI to VGA adapter (not illustrated) 202997-001

 DVI to VGA adapter, HF (not illustrated) 657401-001

 DVI to VGA adapter, HF, 29-pin (not illustrated) 657851-001

 RTC battery (not illustrated) 319603-001

 Mouse (optical, USB; not illustrated) 596410-001

 Keyboard for use in Brazil 537924-201

 Feet 660261-001

 HP Business Digital Headset 642738-001

 Webcam HD-2200 671734-001

 Printer port 638817-001

 Mouse, wireless 625685-001

 USB webcam 609252-001
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Drives

Description Spare part number

Hard drive  

2-TB, 7200-rpm 616608-001

1.5-TB, 7200-rpm 613209-001

1-TB, 7200-rpm 621418-001

750-GB, 7200-rpm 632938-001

500-GB, 7200-rpm 621421-001

320-GB, 7200-rpm 621420-001

250-GB, 7200-rpm 621419-001

Optical drive  

16X SATA DVD±RW drive 581600-001

DVD-ROM drive 581599-001

Misc Boards

Description Spare part number

nVidia GeForce GT530 2-GB graphics adapter 659354-001

nVidia GeForce GT520 1-GB graphics adapter 657400-001

nVidia GeForce 405 PCIe x16 graphics card, 1 GB 656789-001

ATI Radeon HD7350 512-MB graphics adapter 676356-001

ATI Radeon HD6570 1-GB graphics adapter 659355-001

ATI Radeon HD6450 PCIe x16 graphics card, 1 GB 647451-001

ATI Radeon HD6450 PCIe x16 graphics card, 512 MB 647450-001

802.11b/g/n (1x1) WLAN module 634906-001

Sequential Part Number Listing

Spare part
number

Description

202997-001 DVI to VGA adapter (not illustrated)

319603-001 RTC battery (not illustrated)

537924-201 Keyboard for use in Brazil

581599-001 DVD-ROM drive

581600-001 16X SATA DVD±RW drive

585157-001 Memory module, 4-GB, PC3 10600, 1333-MH
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Spare part
number

Description

596410-001 Mouse, USB, optical

609252-001 USB webcam

613209-001 1.5-TB hard drive

616608-001 2-TB hard drive

621418-001 1-TB hard drive

621420-001 320-GB, 7200-rpm hard drive

621421-001 500-GB, 7200-rpm hard drive

621419-001 250-GB hard drive, SATA3

625685-001 Mouse, wireless

632938-001 750-GB, 7200-rpm hard drive

634906-001 802.11b/g/n (1x1) WLAN module

635802-001 Memory module, 1-GB, PC3 10600, 1333-MHz

635803-001 Memory module, 2-GB, PC3 10600, 1333-MHz

638419-001 Intel Core i7 2600S processor (2.7-GHz, 8-MB L3 cache, 65W)

638420-001 Intel Core i5 2500S processor (2.7-GHz, 6-MB L3 cache, 65W)

638628-001 Intel Core i3 2100 processor (3.1-GHz, 3-MB L3 cache, 65W)

638629-001 Intel Core i3 2120 processor (3.3-GHz, 3-MB L3 cache, 65W)

638630-001 Intel Core i5 2400 processor (3.1 GHz, 6-MB L3 cache, 95W)

638631-001 Intel Core i5 2500 processor (3.3 GHz, 6-MB L3 cache, 95W)

638817-001 Printer port kit

640953-001 Intel Core i5 2400S processor (2.5-GHz, 6-MB L3 cache, 65W)

642738-001 HP Business Digital Headset

647450-001 ATI Radeon HD6450 PCIe x16 graphics card, 512 MB

647451-001 ATI Radeon HD6450 PCIe x16 graphics card, 1 GB

654601-001 Intel Core i5 2300 processor (2.8 GHz, 6-MB L3 cache, 95W)

655970-001 Intel Core i3 2105 (3.1 GHz, 3-MB L3 cache; not for Brazil)

655971-001 Intel Pentium Dual-Core G620 processor (2.6-GHz, 3-MB L3 cache, 65W)

655972-001 Intel Pentium Dual-Core G840 processor (2.8-GHz, 3-MB L3 cache, 65W)

655973-001 Intel Pentium Dual-Core G850 processor (2.9-GHz, 3-MB L3 cache, 65W)

656722-001 Power supply, 220W

656790-001 Intel Core i5 2405S processor (2.5-GHz, 6-MB L3 cache, 65W)

656833-001 SATA cable, 370 mm

656789-001 nVidia GeForce 405 PCIe x16 graphics card, 1 GB

656832-001 Access panel
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Spare part
number

Description

656834-001 Chassis fan

656835-001 Front bezel

656983-001 Front I/O and card reader (6-in-1)

656984-001 Power switch/LED assembly

657111-001 Intel Core i5 2310 processor (2.9 GHz, 6-MB L3 cache, 95W)

657400-001 nVidia GeForce GT520 1-GB graphics adapter

657401-001 DVI to VGA adapter, HF

657402-001 Fan sink (includes replacement thermal material)

657851-001 DVI to VGA adapter, 29-pin HF

659354-001 nVidia GeForce GT530 2-GB graphics adapter

659355-001 ATI Radeon HD6570 1-GB graphics adapter

660261-001 Feet

665117-001 Intel Pentium Dual-Core G530 processor (2.4 GHz, 2-MB L3 cache, 65W)

665118-001 Intel Pentium Dual-Core G530T processor (2.0 GHz, 2-MB L3 cache, 35W)

665119-001 Intel Pentium Dual-Core G540 processor (2.5 GHz, 2-MB L3 cache, 65W)

665120-001 Intel Core i3 2130 processor (3.4 GHz, 3-MB L3 cache, 65W)

665121-001 Intel Core i5 2320 processor (3.0 GHz, 6-MB L3 cache, 95W)

665122-001 Intel Pentium Dual-Core G630 processor (2.7 GHz, 3-MB L3 cache, 65W)

665123-001 Intel Pentium Dual-Core G860 processor (3.0 GHz, 3-MB L3 cache, 65W)

665223-001 System board for use in Brazil

665224-001 Power supply, 270W

671734-001 Webcam HD-2200

676356-001 AMD Radeon HD 7350 512MB DDR3 FH PCIe x16 Card
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5 Serial ATA (SATA) Drive Guidelines
and Features

NOTE: HP only supports the use of SATA hard drives on these models of computer. No Parallel
ATA (PATA) drives are supported.

SATA Hard Drives

Serial ATA Hard Drive Characteristics  

Number of pins/conductors in data cable 7/7

Number of pins in power cable 15

Maximum data cable length 39.37 in (100 cm)

Data interface voltage differential 400-700 mV

Drive voltages 3.3 V, 5 V, 12 V

Jumpers for configuring drive N/A

Data transfer rate 3.0 Gb/s

SATA Hard Drive Cables

SATA Data Cable

Always use an HP approved SATA 3.0 Gb/s cable as it is fully backwards compatible with the SATA
1.5 Gb/s drives.

Current HP desktop products ship with SATA 3.0 Gb/s hard drives.

SATA data cables are susceptible to damage if overflexed. Never crease a SATA data cable and
never bend it tighter than a 30 mm (1.18 in) radius.

The SATA data cable is a thin, 7-pin cable designed to transmit data for only a single drive.
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SMART ATA Drives
The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for the HP Personal
Computers have built-in drive failure prediction that warns the user or network administrator of an
impending failure or crash of the hard drive. The SMART drive tracks fault prediction and failure
indication parameters such as reallocated sector count, spin retry count, and calibration retry count. If
the drive determines that a failure is imminent, it generates a fault alert.

Hard Drive Capacities
The combination of the file system and the operating system used in the computer determines the
maximum usable size of a drive partition. A drive partition is the largest segment of a drive that may
be properly accessed by the operating system. A single hard drive may therefore be subdivided into a
number of unique drive partitions in order to make use of all of its space.

Because of the differences in the way that drive sizes are calculated, the size reported by the
operating system may differ from that marked on the hard drive or listed in the computer specification.
Drive size calculations by drive manufacturers are bytes to the base 10 while calculations by
Microsoft are bytes to the base 2.

Drive/Partition Capacity Limits

 Maximum Size

File System Controller Type Operating System Partition Drive

FAT 32 ATA Windows 7 32 GB 2 TB

NTFS ATA Windows 7 2 TB 2 TB
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6 Routine Care and Disassembly
Preparation

This chapter provides general service information for the computer. Adherence to the procedures and
precautions described in this chapter is essential for proper service.

CAUTION: When the computer is plugged into an AC power source, voltage is always applied to
the system board. You must disconnect the power cord from the power source before opening the
computer to prevent system board or component damage.

Electrostatic Discharge Information
A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive
devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic
device exposed to electrostatic discharge (ESD) may not appear to be affected at all and can work
perfectly throughout a normal cycle. The device may function normally for a while, but it has been
degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the
discharge contains enough power to alter device parameters or melt silicon junctions.

Generating Static

The following table shows that:

● Different activities generate different amounts of static electricity.

● Static electricity increases as humidity decreases.

 Relative Humidity

Event 55% 40% 10%

Walking across carpet

Walking across vinyl floor

Motions of bench worker

Removing DIPs* from plastic tube

7,500 V

3,000 V

400 V

400 V

15,000 V

5,000 V

800 V

700 V

35,000 V

12,000 V

6,000 V

2,000 V
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Removing DIPs* from vinyl tray

Removing DIPs* from Styrofoam

Removing bubble pack from PCB

Packing PCBs in foam-lined box

2,000 V

3,500 V

7,000 V

5,000 V

4,000 V

5,000 V

20,000 V

11,000 V

11,500 V

14,500 V

26,500 V

21,000 V

*These are then multi-packaged inside plastic tubes, trays, or Styrofoam.

NOTE: 700 volts can degrade a product.

Preventing Electrostatic Damage to Equipment

Many electronic components are sensitive to ESD. Circuitry design and structure determine the
degree of sensitivity. The following packaging and grounding precautions are necessary to prevent
damage to electric components and accessories.

● To avoid hand contact, transport products in static-safe containers such as tubes, bags, or
boxes.

● Protect all electrostatic parts and assemblies with conductive or approved containers or
packaging.

● Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.

● Place items on a grounded surface before removing them from their container.

● Always be properly grounded when touching a sensitive component or assembly.

● Avoid contact with pins, leads, or circuitry.

● Place reusable electrostatic-sensitive parts from assemblies in protective packaging or
conductive foam.

Personal Grounding Methods and Equipment

Use the following equipment to prevent static electricity damage to equipment:

● Wrist straps are flexible straps with a maximum of one-megohm ± 10% resistance in the ground
cords. To provide proper ground, a strap must be worn snug against bare skin. The ground cord
must be connected and fit snugly into the banana plug connector on the grounding mat or
workstation.

● Heel straps/Toe straps/Boot straps can be used at standing workstations and are compatible
with most types of shoes or boots. On conductive floors or dissipative floor mats, use them on
both feet with a maximum of one-megohm ± 10% resistance between the operator and ground.

Static Shielding Protection Levels

Method Voltage

Antistatic plastic

Carbon-loaded plastic

Metallized laminate

1,500

7,500

15,000
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Grounding the Work Area

To prevent static damage at the work area, use the following precautions:

● Cover the work surface with approved static-dissipative material. Provide a wrist strap connected
to the work surface and properly grounded tools and equipment.

● Use static-dissipative mats, foot straps, or air ionizers to give added protection.

● Handle electrostatic sensitive components, parts, and assemblies by the case or PCB laminate.
Handle them only at static-free work areas.

● Turn off power and input signals before inserting and removing connectors or test equipment.

● Use fixtures made of static-safe materials when fixtures must directly contact dissipative
surfaces.

● Keep work area free of nonconductive materials such as ordinary plastic assembly aids and
Styrofoam.

● Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

Recommended Materials and Equipment

Materials and equipment that are recommended for use in preventing static electricity include:

● Antistatic tape

● Antistatic smocks, aprons, or sleeve protectors

● Conductive bins and other assembly or soldering aids

● Conductive foam

● Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance

● Static-dissipative table or floor mats with hard tie to ground

● Field service kits

● Static awareness labels

● Wrist straps and footwear straps providing one-megohm +/- 10% resistance

● Material handling packages

● Conductive plastic bags

● Conductive plastic tubes

● Conductive tote boxes

● Opaque shielding bags

● Transparent metallized shielding bags

● Transparent shielding tubes
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Operating Guidelines
To prevent overheating and to help prolong the life of the computer:

● Keep the computer away from excessive moisture, direct sunlight, and extremes of heat and
cold.

● Operate the computer on a sturdy, level surface. Leave a 10.2-cm (4-inch) clearance on all
vented sides of the computer and above the monitor to permit the required airflow.

● Never restrict the airflow into the computer by blocking any vents or air intakes. Do not place the
keyboard, with the keyboard feet down, directly against the front of the desktop unit as this also
restricts airflow.

● Occasionally clean the air vents on all vented sides of the computer. Lint, dust, and other foreign
matter can block the vents and limit the airflow. Be sure to unplug the computer before cleaning
the air vents.

● Never operate the computer with the cover or side panel removed.

● Do not stack computers on top of each other or place computers so near each other that they
are subject to each other’s re-circulated or preheated air.

● If the computer is to be operated within a separate enclosure, intake and exhaust ventilation
must be provided on the enclosure, and the same operating guidelines listed above will still
apply.

● Keep liquids away from the computer and keyboard.

● Never cover the ventilation slots on the monitor with any type of material.

● Install or enable power management functions of the operating system or other software,
including sleep states.

Routine Care

General Cleaning Safety Precautions

1. Never use solvents or flammable solutions to clean the computer.

2. Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth and
then use the cloth on the component.

3. Always unplug the computer when cleaning with liquids or damp cloths.

4. Always unplug the computer before cleaning the keyboard, mouse, or air vents.

5. Disconnect the keyboard before cleaning it.

6. Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the Computer Case

Follow all safety precautions in General Cleaning Safety Precautions on page 39 before cleaning the
computer.
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To clean the computer case, follow the procedures described below:

● To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

● For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping it with
a cloth or swab dampened with clear water.

● For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will
evaporate quickly and not leave a residue.

● After cleaning, always wipe the unit with a clean, lint-free cloth.

● Occasionally clean the air vents on the computer. Lint and other foreign matter can block the
vents and limit the airflow.

Cleaning the Keyboard

Follow all safety precautions in General Cleaning Safety Precautions on page 39 before cleaning the
keyboard.

To clean the tops of the keys or the keyboard body, follow the procedures described in Cleaning the
Computer Case on page 39.

When cleaning debris from under the keys, review all rules in General Cleaning Safety Precautions
on page 39 before following these procedures:

CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from
under the keys.

● Visible debris underneath or between the keys may be removed by vacuuming or shaking.

● Canned, pressurized air may be used to clean debris from under the keys. Caution should be
used as too much air pressure can dislodge lubricants applied under the wide keys.

● If you remove a key, use a specially designed key puller to prevent damage to the keys. This
tool is available through many electronic supply outlets.

CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these
keys are improperly removed or installed, the keyboard may not function properly.

● Cleaning under a key may be done with a swab moistened with isopropyl alcohol and squeezed
out. Be careful not to wipe away lubricants necessary for proper key functions. Use tweezers to
remove any fibers or dirt in confined areas. Allow the parts to air dry before reassembly.

Cleaning the Monitor

● Wipe the monitor screen with a clean cloth moistened with water or with a towelette designed for
cleaning monitors. Do not use sprays or aerosols directly on the screen; the liquid may seep into
the housing and damage a component. Never use solvents or flammable liquids on the monitor.

● To clean the monitor body follow the procedures in Cleaning the Computer Case on page 39.
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Cleaning the Mouse

Before cleaning the mouse, ensure that the power to the computer is turned off.

● Clean the mouse ball by first removing the retaining plate and the ball from the housing. Pull out
any debris from the ball socket and wipe the ball with a clean, dry cloth before reassembly.

● To clean the mouse body, follow the procedures in Cleaning the Computer Case on page 39.

Service Considerations
Listed below are some of the considerations that you should keep in mind during the disassembly and
assembly of the computer.

Power Supply Fan

The power supply fan is a variable-speed fan based on the temperature in the power supply.

CAUTION: The cooling fan is always on when the computer is in the “On” mode. The cooling fan is
off when the computer is in “Standby,” “Suspend,” or “Off” modes.

You must disconnect the power cord from the power source before opening the computer to prevent
system board or component damage.

Tools and Software Requirements

To service the computer, you need the following:

● Torx T-15 screwdriver (HP screwdriver with bits, PN 161946-001)

● Torx T-15 screwdriver with small diameter shank (for certain front bezel removal)

● Flat-bladed screwdriver (may sometimes be used in place of the Torx screwdriver)

● Phillips #2 screwdriver

● Diagnostics software

● HP tamper-resistant T-15 wrench (Smart Cover FailSafe Key, PN 166527-001) or HP tamper-
resistant bits (Smart Cover FailSafe Key, PN 166527-002)

Screws

The screws used in the computer are not interchangeable. They may have standard or metric threads
and may be of different lengths. If an incorrect screw is used during the reassembly process, it can
damage the unit. HP strongly recommends that all screws removed during disassembly be kept with
the part that was removed, then returned to their proper locations.

CAUTION: Metric screws have a black finish. U.S. screws have a silver finish and are used on hard
drives only.

CAUTION: As each subassembly is removed from the computer, it should be placed away from the
work area to prevent damage.
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Cables and Connectors

Most cables used throughout the unit are flat, flexible cables. These cables must be handled with
care to avoid damage. Apply only the tension required to seat or unseat the cables during insertion or
removal from the connector. Handle cables by the connector whenever possible. In all cases, avoid
bending or twisting the cables, and ensure that the cables are routed in such a way that they cannot
be caught or snagged by parts being removed or replaced.

CAUTION: When servicing this computer, ensure that cables are placed in their proper location
during the reassembly process. Improper cable placement can damage the computer.

Hard Drives

Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. This
applies to failed drives as well as replacement spares.

● If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective
packaging and label the package “Fragile: Handle With Care.”

● Do not remove hard drives from the shipping package for storage. Keep hard drives in their
protective packaging until they are actually mounted in the CPU.

● Avoid dropping drives from any height onto any surface.

● If you are inserting or removing a hard drive, turn off the computer. Do not remove a hard drive
while the computer is on or in standby mode.

● Before handling a drive, ensure that you are discharged of static electricity. While handling a
drive, avoid touching the connector. For more information about preventing electrostatic
damage, refer to Electrostatic Discharge Information on page 36

● Do not use excessive force when inserting a drive.

● Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic
fields such as monitors or speakers.

Lithium Coin Cell Battery

The battery that comes with the computer provides power to the real-time clock and has a minimum
lifetime of about three years.

See the appropriate removal and replacement chapter for the chassis you are working on in this
guide for instructions on the replacement procedures.

WARNING! This computer contains a lithium battery. There is a risk of fire and chemical burn if the
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose
in water or fire, or expose it to temperatures higher than 140ºF (60ºC). Do not attempt to recharge the
battery.

NOTE: Batteries, battery packs, and accumulators should not be disposed of together with the
general household waste. In order to forward them to recycling or proper disposal, please use the
public collection system or return them to HP, their authorized partners, or their agents.
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7 Removal and Replacement Procedures
– Microtower Chassis

Adherence to the procedures and precautions described in this chapter is essential for proper service.
After completing all necessary removal and replacement procedures, run the Diagnostics utility to
verify that all components operate properly.

NOTE: Not all features listed in this guide are available on all computers.

Serviceability Features
The computers include features that make them easy to upgrade and service. A Torx T-15, Phillips,
or flat blade screwdriver is needed for many of the installation procedures described in this guide.

Preparation for Disassembly
1. Close any open software applications.

2. Exit the operating system.

3. Remove any diskette or compact disc from the computer.

4. Turn off the computer and any peripheral devices that are connected to it.

CAUTION: Turn off the computer before disconnecting any cables.

CAUTION: Regardless of the power-on state, voltage is always present on the system board
as long as the system is plugged into an active AC outlet. In some systems the cooling fan is on
even when the computer is in the “Standby,” or “Suspend” modes. The power cord should
always be disconnected before servicing a unit.

5. Disconnect the power cord from the electrical outlet and then from the computer.

6. Disconnect all peripheral device cables from the computer.

NOTE: During disassembly, label each cable as you remove it, noting its position and routing.
Keep all screws with the units removed.

CAUTION: The screws used in the computer are of different thread sizes and lengths; using
the wrong screw in an application may damage the unit.
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Access Panel

Description Spare part number

Access panel 674373-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 43).

2. Loosen the captive Torx screw (1) on the back panel that secures the panel to the computer.

3. Slide the side panel toward the back (2), and then pull it away from the computer.

NOTE: Lay the computer on its side to install internal parts.

Figure 7-1  Removing the access panel

To replace the access panel, reverse the removal steps.

44 Chapter 7   Removal and Replacement Procedures – Microtower Chassis



Front Bezel

Description Spare part number

Front bezel for use in EMEA region only 667849-001

Front bezel with optical drive door for use in Brazil 667849-201

Front bezel with for use in North American and Latin American regions 670692-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 43).

2. Remove the access panel (Access Panel on page 44).

3. Press outward on the three latches (1) on the right side of the bezel.

4. Rotate the right side of the bezel off the chassis, and then remove the bezel from the chassis
(2).

Figure 7-2  Removing the Front Bezel

To reinstall the front bezel, reverse the removal procedure.
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Memory

Description Spare part number

PC3-10600 for use in 3400/3405/3410 models  

4-GB 585157-001

2-GB 635803-001

1-GB 635802-001

PC3-12800 for use in 3500/3505 models  

4-GB 671613-001

2-GB 671612-001

The computer comes with double data rate 3 synchronous dynamic random access memory (DDR3-
SDRAM) dual inline memory modules (DIMMs).

DDR3-SDRAM DIMMs

The system board offers two memory sockets.

These memory sockets are populated with at least one preinstalled DIMM. To achieve the maximum
memory support, you can populate the system board with up to 8-GB of memory.

For proper system operation, the DDR3-SDRAM DIMMs must be:

● industry-standard 240-pin

● unbuffered non-ECC PC3-10600 DDR3-1333 MHz-compliant

● 1.5 volt DDR3-SDRAM DIMMs

The DDR3-SDRAM DIMMs must also:

● support CAS latency 9 DDR3 1333 MHz (9-9-9 timing)

● contain the mandatory JEDEC SPD information

In addition, the computer supports:

● 512-Mbit, 1-Gbit, and 2-Gbit non-ECC memory technologies

● single-sided and double-sided DIMMs

● DIMMs constructed with x8 and x16 DDR devices; DIMMs constructed with x4 SDRAM are not
supported

NOTE: The system will not operate properly if you install unsupported DIMMs.
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Populating DIMM Sockets

Populate the DIMM sockets in the following order: XMM1, XMM2 or Channel A, Channel B.

Figure 7-3  DIMM Socket Locations (HP Pro 3400 model shown)

Table 7-1  DIMM Sockets

Description Socket Color Insertion Order

XMM1 socket, Channel A (populate
first)

HP Pro 3400: Black

HP Pro 3405/3410/3500: Blue

1

XMM2 socket, Channel A

NOTE: HP Pro 3505 models label
this connector as XMM3.

HP Pro 3400: Black

HP Pro 3405/3410/3505: Blue

2

NOTE: A memory module must occupy the XMM1/Channel A socket.

The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the DIMMs are installed.

● The system will operate in single channel mode if the DIMM sockets are populated in one
channel only.

● The system will operate in a higher-performing dual channel mode if the total memory capacity
of the DIMMs in Channel A is equal to the total memory capacity of the DIMMs in Channel B.
The technology and device width can vary between the channels. For example, if Channel A is
populated with one 1-GB DIMM and Channel B is populated with one 2-GB DIMM, the system
will operate in dual channel mode.

● The system will operate in flex mode if the total memory capacity of the DIMMs in Channel A is
not equal to the total memory capacity of the DIMMs in Channel B. In flex mode, the channel

Memory 47



populated with the least amount of memory describes the total amount of memory assigned to
dual channel and the remainder is assigned to single channel. For optimal speed, the channels
should be balanced so that the largest amount of memory is spread between the two channels.
If one channel will have more memory than the other, the larger amount should be assigned to
Channel A. For example, if you are populating the sockets with one 2-GB DIMM, and one 1-GB
DIMM, Channel A should be populated with the 2-GB DIMM, and Channel B should be
populated with the 1-GB DIMM. With this configuration, 2 GB will run as dual channel and 1 GB
will run as single channel.

● In any mode, the maximum operational speed is determined by the slowest DIMM in the system.

The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the DIMMs are installed.

Removing Memory Modules

CAUTION: You must disconnect the power cord and wait approximately 30 seconds for the power
to drain before adding or removing memory modules. Regardless of the power-on state, voltage is
always supplied to the memory modules as long as the computer is plugged into an active AC outlet.
Adding or removing memory modules while voltage is present may cause irreparable damage to the
memory modules or system board.

The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is
important to use memory modules with gold-plated metal contacts to prevent corrosion and/or
oxidation resulting from having incompatible metals in contact with each other.

Static electricity can damage the electronic components of the computer or optional cards. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object.

When handling a memory module, be careful not to touch any of the contacts. Doing so may damage
the module.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 43).

2. Remove the access panel (Access Panel on page 44).

3. Locate the memory module sockets on the system board.

WARNING! To reduce risk of personal injury from hot surfaces, allow the internal system
components to cool before touching.

48 Chapter 7   Removal and Replacement Procedures – Microtower Chassis



4. Open both latches (1) of the memory module socket , and remove the memory module from the
socket (2).

Figure 7-4  Removing a DIMM

To install a memory module, reverse the removal procedures.

NOTE: A memory module can be installed in only one way. Match the notch on the module with the
tab on the memory socket.

A DIMM must occupy the XMM1 socket.

To create a dual-channel memory configuration, the memory capacity of Channel A must equal the
memory capacity of Channel B.
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Expansion Cards

Description Spare part number

AMD Radeon HD 7570 2-GB DDR3 FH PCIe x16 Card for use only in HP Pro 3500/3505 models 679219-001

AMD Radeon HD 7450 1-GB DDR3 FH PCIe x16 Card for use only in HP Pro 3500/3505 models 679218-001

AMD Radeon HD 7350 512MB DDR3 FH PCIe x16 Card for use only in HP Pro 3500/3505
models

676356-001

ATI Radeon HD 6570 2-GB graphics adapter, full height (not for use in Brazil) 638406-001

ATI Radeon HD 6450 1-GB graphics adapter 638132-001

ATI Radeon HD 6450 512-MB graphics adapter 647449-001

AMD Radeon HD 6350 512MB DDR3 FH PCIe x16 Card 671728-001

nVidia GeForce GT640 3-GB graphics adapter, full height (not for use in Brazil) for use only in HP
Pro 3500/3505 models

687226-001

nVidia GeForce GT630 2-GB graphics adapter, full height for use only in HP Pro 3500/3505
models (not for use in Brazil)

687580-001

nVidia GeForce GT620 1-GB graphics adapter, full height for use only in HP Pro 3500/3505
models (not for use in Brazil)

687579-001

nVidia GeForce GT530 2-GB graphics adapter, full height (not for use in Brazil) 657106-001

nVidia GeForce GT405 512-MB graphics adapter (not for use in Brazil) 657108-001

nVidia GeForce GT520 1-GB graphics adapter, full height (not for use in Brazil) 657399-001

802.11b/g/n (1x1) WLAN module 634906-001

The computer has the following expansion slots:

Table 7-2  Expansion Slots

Slot Type Number of Slots

PCI 2.3 slots. Can accommodate an expansion card up to 17.46 cm
(6.875 inches) in length.

2 (HP Pro 3410 only)

PCI Express x1 slots 3 (HP Pro 3500, 3505, 3400, 3405); 1 (HP Pro
3410)

PCI Express x16 slots 1

MiniPCI slot 1 (HP Pro 3500, 3505, 3400, 3405)
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Figure 7-5  Expansion Slot Locations (HP Pro 3400/3405/3500/3505 [3400 shown])

Table 7-3  Expansion Slots

Item Description

PCIe X16 PCI Express x16 expansion slot

PCIe x1 PCIe x1 expansion slot

PCIe x1 PCIe x1 expansion slot

PCIe x1 PCIe x1 expansion slot

Mini PCIe Mini PCIe slot (WLAN module)
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Figure 7-6  Expansion Slot Locations (HP Pro 3410)

NOTE: Board appearance and color may vary.

NOTE: You can install a PCI Express x1, x4, x8, or x16 expansion card in the PCI Express x16
expansion slot.

Table 7-4  Expansion Slots

Item Description

PCIe X16 PCI Express x16 expansion slot

PCIe x1 PCIe x1 expansion slot

PCI PCI expansion slot

PCI PCI expansion slot

NOTE: You can install a PCI Express x1, x4, x8, or x16 expansion card in the PCI Express x16
expansion slot.

To remove, replace, or add an expansion card:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 43).

2. Remove the access panel (Access Panel on page 44).

3. Locate the correct vacant expansion socket on the system board and the corresponding
expansion slot on the back of the computer chassis.
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4. On the rear of the computer, a slot cover lock secures the expansion card brackets in place.
Remove the screw from the slot cover lock then slide the slot cover lock up to remove it from the
chassis.

Figure 7-7  Opening the Slot Cover Lock

5. Before installing an expansion card, remove the expansion slot cover or the existing expansion
card.

NOTE: Before removing an installed expansion card, disconnect any cables that may be
attached to the expansion card.

a. If you are installing an expansion card in a vacant socket, you must use a flat blade
screwdriver to pry out the metal shield on the rear panel that covers the expansion slot. Be
sure to remove the appropriate shield for the expansion card you are installing.

Figure 7-8  Removing an Expansion Slot Cover
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b. If you are removing a PCI Express x1 card, hold the card at each end and carefully rock it
back and forth until the connectors pull free from the socket. Be sure not to scrape the card
against the other components.

Figure 7-9  Removing a PCI Express x1 Expansion Card

c. If you are removing a PCI Express x16 card, pull the retention arm on the back of the
expansion socket away from the card and carefully rock the card back and forth until the
connectors pull free from the socket. Be sure not to scrape the card against the other
components.

Figure 7-10  Removing a PCI Express x16 Expansion Card

6. Store the removed card in anti-static packaging.
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7. If you are not installing a new expansion card, install an expansion slot cover to close the open
slot.

CAUTION: After removing an expansion card, you must replace it with a new card or
expansion slot cover for proper cooling of internal components during operation.

8. To install a new expansion card, hold the card just above the expansion socket on the system
board then move the card toward the rear of the chassis so that the bottom of the bracket on the
card slides into the small slot on the chassis. Press the card straight down into the expansion
socket on the system board.

Figure 7-11  Installing an Expansion Card

NOTE: When installing an expansion card, press firmly on the card so that the whole
connector seats properly in the expansion card slot.

9. Replace the slot cover lock and secure it in place with the screw that was previously removed.

Figure 7-12  Securing the Expansion Cards and Slot Covers
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10. Connect external cables to the installed card, if needed. Connect internal cables to the system
board, if needed.

11. Reconfigure the computer, if necessary. Refer to Computer Setup (F10) Utility on page 7 for
instructions on using Computer Setup.

Cable Management
Always follow good cable management practices when working inside the computer.

● Keep cables away from major heat sources like the heat sink.

● Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like these
are not designed to take excessive pressure on them.

● Some flat ribbon cables come prefolded. Never change the folds on these cables.

● Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius.

● Never crease a SATA data cable.

● Do not rely on components like the drive cage, power supply, or computer cover to push cables
down into the chassis. Always position the cables to lay properly by themselves.

When removing the power supply power cable from the P1 connector on the system board, always
follow these steps:

1. Squeeze on the top of the retaining latch attached to the cable end of the connector (1).

2. Grasp the cable end of the connector and pull it straight up (2).

CAUTION: Always pull the connector - NEVER pull on the cable. Pulling on the cable could
damage the cable and result in a failed power supply.
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Cable Connections

System board connectors are color-coded to make it easier to find the proper connection.

Connector Name Connector Color Description

ATX_POWER white Power supply, 24-pin

ATX_CPU white Power supply, 4-pin

SYS_FAN (HP Pro
3400/3405/3410/3500)

SYS_FAN1 (HP Pro 3505)

brown Chassis fan

CPU_FAN (HP Pro
3400/3405/3500)

CPU_FAN1 (HP Pro 3410)

white Heat sink fan

INT_SPKR (HP Pro
3500/3400/3405 only)

white Speaker

F_PANEL black Power switch

F_AUDIO yellow Front I/O audio

CARD_READER black HP Pro 3505: Media card reader

F_USB1 white HP Pro 3400/3410/3500: Media card
reader

HP Pro 3405: Front I/O USB

F_USB2 white HP Pro 3400/3410/3500:Front I/O
USB

HP Pro 3405: Media card reader

F_USB3 white HP Pro 3400/3410:Front I/O USB

F_USB4 white HP Pro 3405:Front I/O USB

SATA0 dark blue Primary hard drive

SATA1 white Primary optical drive

SATA2 light blue Second hard drive

SATA3 orange Second optical drive
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Drives

Description Spare part number

16X SATA DVD±RW drive 581600-001

6X SATA DVD-ROM drive (not for Brazil) 581599-001

2 TB, 7200 rpm SATA hard drive 613210-001

1.5 TB, 7200 rpm SATA hard drive 613209-001

1.5-TB, 5400-rpm SATA hard drive 652272-001

1 TB, 7200 rpm SATA hard drive 667719-001

750 GB, 7200 rpm SATA hard drive 632938-001

500 GB, 7200 rpm SATA hard drive 667720-001

250 GB, 7200 rpm SATA hard drive 621419-001

The computer supports up to three drives that may be installed in various configurations.

Table 7-5  Drive locations

Item Description

1 Optical drive

2 Optical drive or media card reader

3 Hard drive (internal)

This section describes the procedure for replacing or upgrading the storage drives. A Torx T-15
screwdriver is needed to remove and install the guide screws on a drive.
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Installing Additional Drives

When installing drives, follow these guidelines:

● The primary Serial ATA (SATA) hard drive must be connected to the dark blue primary SATA
connector on the system board labeled SATA0.

● Connect an optical drive to the light blue SATA connector on the system board labeled SATA2.

● Connect a media card reader to:

◦ HP Pro 3400/3410/3500: F_USB1 system board connector

◦ HP Pro 3405: F_USB2 system board connector

◦ HP Pro 3505: CARD_READER system board connector

● The power cables for the SATA drives connect directly to the power supply. The primary hard
drive connects to the power connector labeled P4. the primary optical drive connects to the
power connector labeled P3.

● The system does not support Parallel ATA (PATA) optical drives or PATA hard drives.

CAUTION: To prevent loss of work and damage to the computer or drive:

If you are inserting or removing a drive, shut down the operating system properly, turn off the
computer, and unplug the power cord. Do not remove a drive while the computer is on or in standby
mode.

Before handling a drive, ensure that you are discharged of static electricity. While handling a drive,
avoid touching the connector. For more information about preventing electrostatic damage, refer to
Electrostatic Discharge Information on page 36.

Handle a drive carefully; do not drop it.

Do not use excessive force when inserting a drive.

Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields
such as monitors or speakers.

If a drive must be mailed, place the drive in a bubble-pack mailer or other protective packaging and
label the package “Fragile: Handle With Care.”
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System Board Drive Connections

Refer to the following illustration and table to identify the system board drive connectors.

Figure 7-13  System Board Drive Connections (HP Pro 3400 shown)

Table 7-6  System Board Drive Connections

System Board Connector System Board Label Color

SATA0 SATA0 dark blue

SATA1 SATA1 white

SATA2 SATA2 light blue

SATA3 SATA3 orange

Media Card Reader F_USB1 (HP Pro
3400/3410/3500)

CARD_READER (HP Pro
3505)

white

black
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Figure 7-14  System Board Drive Connections (HP Pro 3405 shown)

Table 7-7  System Board Drive Connections – Model 3405

System Board Connector System Board Label Color

SATA1 SATA1 dark blue

SATA2 SATA2 white

SATA3 SATA3 light blue

SATA4 SATA4 orange

Media Card Reader F_USB2 white
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Figure 7-15  System Board Drive Connections (HP Pro 3505 shown)

Table 7-8  System Board Drive Connections – Model 3505

System Board Connector System Board Label Color

SATA1 SATA1 dark blue

SATA2 SATA2 white

SATA3 SATA3 light blue

SATA4 SATA4 orange

Media Card Reader CARD_READER black
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Removing an Optical Drive

CAUTION: All removable media should be taken out of a drive before removing the drive from the
computer.

To remove an optical drive:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 43).

2. Remove the access panel (Access Panel on page 44).

3. Remove the front bezel (Front Bezel on page 45).

4. Disconnect the power and data cables (1) from the rear of the optical drive.

5. Remove the two Torx screws (2) that secure the drive to the computer.

6. Slide the drive out of the computer (3).

Figure 7-16  Removing the optical drive

To install an optical drive, reverse the removal procedures.

Removing a Hard Drive

NOTE: Before you remove the old hard drive, be sure to back up the data from the old hard drive so
that you can transfer the data to the new hard drive. Also, if you are replacing the primary hard drive,
make sure you have created a Recovery Disc Set to restore the operating system, software drivers,
and any software applications that were preinstalled on the computer.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 43).

2. Remove the access panel (Access Panel on page 44).

3. Disconnect the power and data cables (1) from the rear of the hard drive.

4. Remove the four Torx screws (2) that secure the drive to the computer.
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5. Slide the hard drive toward the bottom of the computer (3), and then remove it from the
computer..

Figure 7-17  Removing the hard drive

To install a hard drive, reverse the removal procedures.
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Front I/O and USB Panel Housing Assembly

Description Spare part number

Front I/O and USB assembly without card reader 667853-001

Front I/O and USB assembly with card reader 667852-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 43).

2. Remove the access panel (Access Panel on page 44)

3. Lay the computer on its side with the front facing toward you.

4. Remove the front bezel (Front Bezel on page 45).

5. Remove the cables from the metal clip built into the bottom of the chassis, and then unplug the
three cables that connect the assembly to the system board. The assembly cables connect to
the following system board connectors:

Table 7-9  Front I/O connectors

HP Pro 3400/3410 models HP Pro 3405 models HP Pro 3500 models HP Pro 3505 models

F_AUDIO – yellow connector F_AUDIO – yellow
connector

F_AUDIO – yellow
connector

F_AUDIO – yellow
connector

F_USB2 – white connector F_USB1 – white connector F_USB1 – white connector F_USB2 – white connector

F_USB3 – white connector F_USB4 – white connector F_USB2 – white connector SPDIF_OUT1 – white
connector

Figure 7-18  Front I/O connectors- HP Pro 3400/3410 models[3400 shown)
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6. Push in on the lever to the left of the assembly.

Figure 7-19  Front I/O connectors

7. Pull the assembly outward away from the front of the chassis while guiding the cables through
the hole in the chassis.

To install the housing assembly, reverse the removal procedures.

When installing the assembly, note that some cables have two separate connectors that plug into the
same system board.

Figure 7-20  Front I/O connectors
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Power Switch/LED Assembly

Description Spare part number

Power switch/LED assembly 667850-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 43).

2. Remove the access panel (Access Panel on page 44).

3. Remove the front bezel (Front Bezel on page 45).

4. Remove the optical drive (Removing an Optical Drive on page 63).

5. Disconnect the braided cables from the black system board connector labeled F_PANEL (1).

6. Remove the cable from the metal clip (2) built into the computer.

7. From the inside of the computer, push up on the tab on the bottom of the assembly (3) to
disengage it from the computer.

Figure 7-21  Removing the power switch cable, disengaging the assembly
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8. Pull the power switch away from the chassis while guiding the wires through the hole in the
chassis.

Figure 7-22  Removing the power switch assembly

To install the power switch/LED assembly, reverse the removal procedures.
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System Fan

Description Spare part number

Chassis fan for use in EMEA, North American, and Latin American regions; not for Brazil 657103-001

Chassis fan for use in Brazil 514238-001

434645-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 43).

2. Remove the access panel (Access Panel on page 44).

3. Lay the computer on its side with the rear facing toward you.

4. Remove the three Phillips screws that secure the fan to the chassis.

Figure 7-23  Removing the fan

NOTE: System board appearance may vary.
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5. From the inside of the computer, disconnect the cable from the red/brown system board
connector labeled SYS_FAN (1), pull the fan into the chassis until it clears the chassis lip, and
then lift it out of the chassis (2).

NOTE: On some models the connector label is SYS_FAN1.

Figure 7-24  Removing the fan

To install the fan, reverse the removal procedures.
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Fan Sink Assembly

Description Spare part number

Fan sink for use in models with Intel processors 667727-001

Fan sink for use in models with AMD processors 657402-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 43).

2. Remove the access panel (Access Panel on page 44).

3. Disconnect the fan sink cable from the white system board connector labeled CPU FAN (1).

NOTE: On AMD models the connector label is CPU_FAN1.

4. Loosen the four captive Torx screws (2) that secure the fan sink to the system board.

5. Lift the heat sink from the processor (3) and set it on its side to keep from contaminating the
work area with thermal grease.

Figure 7-25  Removing the fan sink

CAUTION: Heat sink retaining screws should be tightened in diagonally opposite pairs (as in an X)
to evenly seat the heat sink to the processor. This is especially important as the pins on the socket
are very fragile and any damage to them may require replacing the system board.

When reinstalling an existing heat sink, make sure that its bottom has been cleaned with an alcohol
wipe and fresh thermal grease has been applied to the top of the processor. New heat sinks come
from the factory with fresh thermal grease already applied.
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Processor
HP Pro 3400/3410/3500 uses Intel processors. HP Pro 3405/3505 uses AMD processors.

Description Spare part number

Intel Core i7 processors  

2600S (2.7 GHz, 8-MB L3 cache; not for Brazil) 638419-001

2600 (3.4 GHz, 8-MB L3 cache, 95W) 638632-001

Intel Core i5 processors  

2500 (3.3 GHz, 6-MB L3 cache; not for Brazil) 638631-001

2400 (3.1-GHz, 6-MB L3 cache; not for use in Brazil) 638630-001

2320 (3.0 GHz, 6-MB L3 cache, 95W) 665121-001

2310 (2.9-GHz, 6-MB L3 cache; not for Brazil) 657111-001

2300 (2.8-GHz, 6-MB L3 cache; not for Brazil) 654601-001

Intel Core i3 processors  

2130 (3.4 GHz, 3-MB L3 cache; not for Brazil) 665120-001

2125 (3.3 GHz, 3-MB L3 cache; not for Brazil; for use only in HP Pro 3500 models) 677427-001

2120 (3.3 GHz, 3-MB L3 cache; not for Brazil) 638629-001

2105 (3.1 GHz, 3-MB L3 cache; not for Brazil) 655970-001

2100 (3.1 GHz, 3-MB L3 cache) 638628-001

Intel Pentium Dual-Core processors  

G860 (3.0-GHz, 3-MB L3 cache; not for use in Brazil) 665123-001

G850 (2.9-GHz, 3-MB L3 cache) 655973-001

G840 (2.8-GHz, 3-MB L3 cache; not for Brazil) 655972-001

G630 (2.7-GHz, 3-MB L3 cache; not for use in Brazil) 665122-001

G620 (2.6-GHz, 3-MB L3 cache) 655971-001

Intel Celeron processors:  

G540 (2.5 GHz, 2-MB L3 cache, 65W; not for Brazil) 665119-001

G530 (2.4 GHz, 2-MB L3 cache, 65W; not for Brazil) 665117-001

G440 (1.6 GHz, 1-MB L3 cache, 35W; not for Brazil) 665467-001

AMD A-Series Advanced Processing Units (APU); not for use in Brazil:  

X4 A8-3870 (3.0 GHz, 4-MB L2 cache, 65W; Radeon HD6550D graphics core) for use only in HP
Pro 3505 models

671611-001

X4 A8-3820 (2.5 GHz, 4-MB L2 cache, 65W; Radeon HD6550D graphics core) for use only in HP
Pro 3505 models

671610-001

X4 A8-3800 (2.4 GHz, 4-MB L2 cache, 65W; Radeon HD6550D graphics core) 667723-001

X4 A6-3670 (2.7 GHz, 4-MB L2 cache, 100W; Radeon HD6550D graphics core) for use only in
HP Pro 3505 models

671609-001
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Description Spare part number

X4 A6-3650 (2.6 GHz, 4-MB L2 cache, 100W; Radeon HD6550D graphics core) 667722-001

X4 A6-3620 (2.2 GHz, 4-MB L2 cache, 65W; Radeon HD6350D graphics core) 671608-001

X4 A6-3600 (2.1 GHz, 4-MB L2 cache, 65W; Radeon HD6530D graphics core) 667724-001

X4 A8-3550 (2.8 GHz, 4-MB L2 cache, 65W; Radeon HD6550D graphics core) 667721-001

X2 A4-3420 (2.8 GHz, 4-MB L2 cache, 65W; Radeon HD6530D graphics core) for use only in HP
Pro 3505 models

680937-001

X2 A4-3400 (2.7 GHz, 4-MB L2 cache, 65W; Radeon HD6530D graphics core) 667725-001

X2 E2-3200 (2.4 GHz, 1-MB L2 cache, 65W; Radeon HD6370D graphics core) 667726-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 43).

2. Remove the access panel (Access Panel on page 44).

3. Lay the computer on its side with the rear facing toward you.

4. Remove the fan sink Fan Sink Assembly on page 71).

5. If removing an AMD processor, skip to step 6. If removing an Intel processor, rotate the locking
lever to its full open position (1), raise and rotate the microprocessor retainer to its full open
position (2), and then carefully lift the processor from the socket (3).

CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and
handling them could cause irreparable damage. Once pins are damaged it may be necessary to
replace the system board.

CAUTION: The heat sink must be installed within 24 hours of installing the processor to
prevent damage to the processor’s solder connections.

Figure 7-26  Removing an Intel processor
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6. If removing an AMD processor, rotate the locking lever to its full open position (1), and then
carefully lift the processor from the socket (2).

CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and
handling them could cause irreparable damage. Once pins are damaged it may be necessary to
replace the system board.

CAUTION: The heat sink must be installed within 24 hours of installing the processor to
prevent damage to the processor’s solder connections.

Figure 7-27  Removing an AMD processor

To install a new processor:

1. Place the processor in its socket.

2. If installing an AMD processor, skip to step 3. If installing an Intel processor, close the retainer.

3. Secure the locking lever.

If reusing the existing heat sink, go to step 4.

If using a new heat sink, go to step 7.

4. If reusing the existing heat sink, clean the bottom of the heat sink with the alcohol pad provided
in the spares kit.

5. Apply the thermal grease provided in the spares kit to the top of the processor and install the
heat sink atop the processor.

6. Go to step 8.
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7. If using a new fan sink, remove the protective covering from the bottom of the fan sink and place
it in position atop the processor.

8. Secure the fan sink to the system board and system board tray with the 4 captive screws and
attach the fan sink control cable to the system board.

CAUTION: Heat sink retaining screws should be tightened in diagonally opposite pairs (as in
an X) to evenly seat the heat sink on the processor. This is especially important as the pins on
the socket are very fragile and any damage to them may require replacing the system board.

NOTE: After installing a new processor onto the system board, always update the system
ROM to ensure that the latest version of the BIOS is being used on the computer. The latest
system ROM BIOS can be found on the Web at: http:\\h18000.www1.hp.com/support/files.
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Power Supply

Description Spare part number

Power supply, 300W (Active PFC; not for use in Brazil) 656721-001

689005-001

Power supply, 300W 664862-001

692096-001

WARNING! Voltage is always present on the system board when the computer is plugged into an
active AC outlet. To avoid possible personal injury and damage to the equipment the power cord
should be disconnected from the computer and/or the AC outlet before opening the computer.

NOTE: When installing a new power supply, be sure to set the red switch to the setting (230 V or
115 V) appropriate for the country in which the computer is used. Spare power supplies normally
arrive set for 230 V.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 43).

2. Remove the access panel (Access Panel on page 44).

3. Disconnect all power cables from the mass storage devices and from the system board
connectors labeled ATX_CPU and PWR.

4. From the rear of the computer, remove the four Torx screws that secure the power supply to the
chassis.

Figure 7-28  Power supply screws

5. Inside of the unit, press the power supply release latch on the chassis base (1).
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6. Slide the power supply toward the front of the computer (2), then lift the power supply out of the
computer (3).

Figure 7-29  Removing the power supply

To install the power supply, reverse the removal procedure.

System Board

Description Spare part number

System board for use in 3400 models with Intel processors (includes thermal material) 660281-001

System board for use in 3410 models with Intel processors in Brazil (includes thermal material) 665223-001

System board for use in 3405 models with AMD processors (includes thermal material) 660155-001

System board for use in 3500 models with Intel processors (includes thermal material) 687577-001

System board for use in 3505 models with AMD processors (includes thermal material) 687578-001

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

● Memory modules

● Processor

● Expansion cards

To remove the system board:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 43).

2. Remove the access panel (Access Panel on page 44).

3. Remove the front bezel (Front Bezel on page 45).
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4. Remove any expansion cards (Expansion Cards on page 50).

5. Disconnect all cables from the system board.

6. Remove the six screws that secure the system board to the chassis.

NOTE: HP Pro 3405/3505 model system boards are secured with eight screws.

7. Slide the system board toward the front of the chassis, and then lift it up and out of the chassis.

Figure 7-30  Removing the system board (HP Pro 3400 shown)

To install the system board, reverse the removal procedure.

NOTE: When replacing the system board, you must also change the chassis serial number in the
BIOS.

NOTE: After installing a new system board, always update the system ROM to ensure that the
latest version of the BIOS is being used on the computer. The latest system ROM BIOS can be found
at: http:\\h18000.www1.hp.com/support/files.

Battery
The battery that comes with your computer provides power to the real-time clock and has a lifetime of
about three years. When replacing the battery, use a battery equivalent to the battery originally
installed on the computer. The computer comes with a 3-volt lithium coin cell battery.

NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC
wall socket. The lithium battery is only used when the computer is NOT connected to AC power.

WARNING! This computer contains an internal lithium manganese dioxide battery. There is a risk of
fire and burns if the battery is not handled properly. To reduce the risk of personal injury:

❑ Do not attempt to recharge the battery.

❑ Do not expose to temperatures higher than 60°C (140°F)
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❑ Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.

❑ Replace the battery only with the HP/Compaq spare designated for this product.

CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings.
When the battery is removed or replaced, the CMOS settings will be cleared. Refer to the
Troubleshooting Without Diagnostics on page 141 chapter for information on backing up the CMOS
settings.

NOTE: Batteries, battery packs, and accumulators should not be disposed of together with the
general household waste. In order to forward them to recycling or proper disposal, please use the
public collection system or return them to HP, its authorized partners, or its agents.

CAUTION: Static electricity can damage the electronic components of the computer or optional
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by
briefly touching a grounded metal object.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 43).

2. Remove the access panel (Access Panel on page 44).

NOTE: It may be necessary to remove an expansion card to gain access to the battery.

3. Locate the battery and battery holder on the system board.

4. To release the battery from its holder, squeeze the metal clamp that extends above one edge of
the battery. When the battery pops up, lift it out (1).

5. To insert the new battery, slide one edge of the replacement battery under the holder’s lip with
the positive side up (2). Push the other edge down until the clamp snaps over the other edge of
the battery.

6. Replace the computer access panel.

7. Plug in the computer and turn on power to the computer.

8. Reset the date and time, your passwords, and any special system setups, using Computer
Setup. Refer to Computer Setup (F10) Utility on page 7.
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8 Removal and Replacement Procedures
– Small Form Factor (SFF) Chassis

Adherence to the procedures and precautions described in this chapter is essential for proper service.
After completing all necessary removal and replacement procedures, run the Diagnostics utility to
verify that all components operate properly.

NOTE: Not all features listed in this guide are available on all computers.

Preparation for Disassembly
See Routine Care and Disassembly Preparation on page 36 for initial safety procedures.

1. Remove/disengage any security devices that prohibit opening the computer.

2. Close any open software applications.

3. Exit the operating system.

4. Remove any compact disc or media card from the computer.

5. Turn off the computer and any peripheral devices that are connected to it.

CAUTION: Turn off the computer before disconnecting any cables.

Regardless of the power-on state, voltage is always present on the system board as long as the
system is plugged into an active AC outlet. In some systems the cooling fan is on even when the
computer is in the “Standby,” or “Suspend” modes. The power cord should always be
disconnected before servicing a unit.

6. Disconnect the power cord from the electrical outlet and then from the computer.

7. Disconnect all peripheral device cables from the computer.

NOTE: During disassembly, label each cable as you remove it, noting its position and routing.
Keep all screws with the units removed.

CAUTION: The screws used in the computer are of different thread sizes and lengths; using
the wrong screw in an application may damage the unit.
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Access Panel

Description Spare part number

Access panel 656832-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 80).

2. If the computer is on a stand, remove the computer from the stand.

3. Remove the Torx screw that secures the access panel to the computer.

Figure 8-1  Removing the access panel screw
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4. Slide the access panel toward the back of the computer, and then pull it away from the
computer.

Figure 8-2  Removing the access panel

To install the access panel, reverse the removal procedure.
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Front Bezel

Description Spare part number

Front bezel 656835-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 80).

2. Remove the access panel (Access Panel on page 81).

3. Lift up the three tabs on the top of the bezel.

Figure 8-3  Removing the front bezel

4. Rotate the bezel off the chassis.

Figure 8-4  Removing the front bezel

To install the front bezel, reverse the removal procedure.
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Memory

Description Spare part number

4-GB, PC3-10600 585157-001

2-GB, PC3-10600 635803-001

1-GB, PC3-10600 635802-001

The computer comes with double data rate 3 synchronous dynamic random access memory (DDR3-
SDRAM) dual inline memory modules (DIMMs).

DDR3-SDRAM DIMMs

The memory sockets on the system board can be populated with up to two DIMMs.

These memory sockets are populated with at least one preinstalled DIMM. To achieve the maximum
memory support, you can populate the system board with up to 8 GB of memory:

For proper system operation, the DDR3-SDRAM DIMMs must be:

● industry-standard 240-pin

● unbuffered non-ECC PC3-10600 DDR3-1333 MHz-compliant

● 1.5 volt DDR3-SDRAM DIMMs

The DDR3-SDRAM DIMMs must also:

● support CAS latency 9 DDR3 1333 MHz (9-9-9 timing)

● contain the mandatory JEDEC SPD information

In addition, the computer supports:

● 512-Mbit, 1-Gbit, and 2-Gbit non-ECC memory technologies

● single-sided and double-sided DIMMs

● DIMMs constructed with x8 and x16 DDR devices; DIMMs constructed with x4 SDRAM are not
supported

NOTE: The system will not operate properly if you install unsupported DIMMs.
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Populating DIMM Sockets

There are two DIMM sockets on the system board, with one socket per channel.

Populate the DIMM sockets in the following order: Channel A then Channel B

Figure 8-5  DIMM Socket Locations

Table 8-1  DIMM Socket Locations

Description Socket Color Insertion Order

Channel A (populate first) Blue 1

Channel B Blue 2

NOTE: A DIMM must occupy the Channel A socket.

● The system will operate in single channel mode if the DIMM sockets are populated in one
channel only.

● The system will operate in a higher-performing dual channel mode if the total memory capacity
of the DIMM in Channel A is equal to the total memory capacity of the DIMM in Channel B. The
technology and device width can vary between the channels. For example, if Channel A is
populated with one 2-GB DIMMs and Channel B is populated with one 2-GB DIMM, the system
will operate in dual channel mode.

● The system will operate in flex mode if the total memory capacity of the DIMM in Channel A is
not equal to the total memory capacity of the DIMM in Channel B. In flex mode, the channel
populated with the least amount of memory describes the total amount of memory assigned to
dual channel and the remainder is assigned to single channel. For optimal speed, the channels
should be balanced so that the largest amount of memory is spread between the two channels.
If one channel will have more memory than the other, the larger amount should be assigned to
Channel A. For example, if you are populating the sockets with one 2-GB DIMM, and one 1-GB
DIMMs, Channel A should be populated with the 2-GB DIMM, and Channel B should be
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populated with the 1-GB DIMM. With this configuration, 2 GB will run as dual channel and 1 GB
will run as single channel.

● In any mode, the maximum operational speed is determined by the slowest DIMM in the system.

The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the DIMMs are installed.

Removing DIMMs

CAUTION: You must disconnect the power cord and wait approximately 30 seconds for the power
to drain before adding or removing memory modules. Regardless of the power-on state, voltage is
always supplied to the memory modules as long as the computer is plugged into an active AC outlet.
Adding or removing memory modules while voltage is present may cause irreparable damage to the
memory modules or system board.

The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is
important to use memory modules with gold-plated metal contacts to prevent corrosion and/or
oxidation resulting from having incompatible metals in contact with each other.

Static electricity can damage the electronic components of the computer or optional cards. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object. For more information, refer to Electrostatic Discharge Information on page 36.

When handling a memory module, be careful not to touch any of the contacts. Doing so may damage
the module.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 80).

2. Remove the access panel (Access Panel on page 81).

3. Remove the front bezel (Front Bezel on page 83).

4. Rotate the optical drive to its upright position.

Figure 8-6  Rotating the optical drive
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5. Open both latches of the memory module socket (1), and remove the memory module from the
socket (2).

Figure 8-7  Removing a DIMM

NOTE: A memory module can be installed in only one way. Match the notch on the module
with the tab on the memory socket.

For maximum performance, populate the sockets so that the memory capacity is spread as
equally as possible between Channel A and Channel B.
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6. To install a memory module, holding the module by the edges, completely slide it into the slot.
Make sure the module is pressed completely into the socket, and then gently push down on the
module until it snaps in place.

Figure 8-8  Installing a DIMM

NOTE: A memory module can be installed in only one way. Match the notch on the module
with the tab on the memory socket.

For maximum performance, populate the sockets so that the memory capacity is spread as
equally as possible between Channel A and Channel B.

The computer should automatically recognize the additional memory the next time you turn on the
computer.
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Expansion Card

Description Spare part number

Graphics cards  

nVidia GeForce GT530 2-GB graphics adapter 659354-001

nVidia GeForce GT520 1-GB graphics adapter 657400-001

nVidia GeForce 405 PCIe x16 graphics card, 1 GB 656789-001

ATI Radeon HD6570 1-GB graphics adapter 659355-001

ATI Radeon HD6450 PCIe x16 graphics card, 1 GB 647451-001

ATI Radeon HD6450 PCIe x16 graphics card, 512 MB 647450-001

The HP Pro 3410 SFF has one PCIe x16 expansion slot, one PCIe x1 expansion slots, and two PCI
2.2 slots.

Figure 8-9  Expansion Slot Locations

NOTE: Board appearance and color may vary.

NOTE: You can install a PCI Express x1, x4, x8, or x16 expansion card in the PCI Express x16
expansion slot.
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Table 8-2  Expansion Slots

Item Description

PCIe X16 PCI Express x16 expansion slot

PCIe x1 PCIe x1 expansion slot

PCI PCI expansion slot

PCI PCI expansion slot

To remove, replace, or add an expansion card:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 80).

2. Remove the access panel (Access Panel on page 81).

3. Locate the correct vacant expansion socket on the system board and the corresponding
expansion slot on the back of the computer chassis.

4. Release the slot cover bracket by removing the screw that secures the bracket, and then lifting
the bracket off the computer.

Figure 8-10  Opening the expansion slot bracket

5. Before installing an expansion card, remove the expansion slot cover or the existing expansion
card.

NOTE: Before removing an installed expansion card, disconnect any cables that may be
attached to the expansion card.

a. If you are installing an expansion card in a vacant socket, remove the appropriate
expansion slot cover on the back of the chassis. Pull the slot cover straight up then away
from the inside of the chassis.
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b. If you are removing a PCI Express x16 card, pull the retention arm on the back of the
expansion socket away from the card and carefully rock the card back and forth until the
connectors pull free from the socket. Pull the expansion card straight up from the socket
then away from the inside of the chassis to release it from the chassis frame. Be sure not to
scrape the card against the other components.

NOTE: PCI cards and PCI Express x1 cards do not have the retention arm. PCI Express
X16 card is shown below.

Figure 8-11  Removing a standard PCI expansion card

6. Store the removed card in anti-static packaging.

7. If you are not installing a new expansion card, install an expansion slot cover to close the open
slot.

CAUTION: After removing an expansion card, you must replace it with a new card or
expansion slot cover for proper cooling of internal components during operation.
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8. To install a new expansion card, hold the card just above the expansion socket on the system
board then move the card toward the rear of the chassis so that the bracket on the card is
aligned with the open slot on the rear of the chassis. Press the card straight down into the
expansion socket on the system board.

Figure 8-12  Installing an expansion card

NOTE: When installing an expansion card, press firmly on the card so that the whole
connector seats properly in the expansion card slot.

9. Reattach the bracket to the back of the computer

Figure 8-13  Replacing the expansion slot bracket
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10. Connect external cables to the installed card, if needed. Connect internal cables to the system
board, if needed.

11. Reconfigure the computer, if necessary.

Cable Management
Always follow good cable management practices when working inside the computer.

● Keep cables away from major heat sources like the heat sink.

● Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like these
are not designed to take excessive pressure on them.

● Some flat ribbon cables come prefolded. Never change the folds on these cables.

● Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius.

● Never crease a SATA data cable.

● Do not rely on components like the drive cage, power supply, or computer cover to push cables
down into the chassis. Always position the cables to lay properly by themselves.

When removing the power supply power cable from the P1 connector on the system board, always
follow these steps:

1. Squeeze on the top of the retaining latch attached to the cable end of the connector (1).

2. Grasp the cable end of the connector and pull it straight up (2).

CAUTION: Always pull the connector - NEVER pull on the cable. Pulling on the cable could
damage the cable and result in a failed power supply.
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Cable Connections

System board connectors are color-coded to make it easier to find the proper connection.

Connector Name Connector Color Description

ATX_POWER white Power supply, 24-pin

ATX_CPU white Power supply, 4-pin

SYS_FAN brown Chassis fan

CPU_FAN1 white Heat sink fan

F_PANEL black Power switch

F_AUDIO yellow Front I/O audio

F_USB1 white Media card reader

F_USB2 white Front I/O USB

F_USB3 white Front I/O USB

SATA0 dark blue Primary hard drive

SATA1 white Primary optical drive

SATA2 light blue Second hard drive

SATA3 orange Second optical drive
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Drives

Description Spare part number

16X SATA DVD±RW drive 581600-001

16X SATA DVD±RW drive 581600-001

2 TB, 7200 rpm SATA hard drive 616608-001

1.5 TB, 7200 rpm SATA hard drive 613209-001

1 TB, 7200 rpm SATA hard drive 621418-001

750 GB, 7200 rpm SATA hard drive 632938-001

500 GB, 7200 rpm SATA hard drive 621421-001

320 GB, 7200 rpm SATA hard drive, 2.5-inch 621420-001

250 GB, 7200 rpm SATA hard drive 621419-001

Drive Positions

Figure 8-14  Drive positions

Table 8-3  Drive Positions

1 5.25-inch external drive bay for an optical drive

2 3.5-inch internal drive bay for a hard drive
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To verify the type and size of the storage devices installed in the computer, run Computer Setup.

Removing Drives

When installing drives, follow these guidelines:

● The primary Serial ATA (SATA) hard drive must be connected to the dark blue primary SATA
connector on the system board labeled SATA0.

● Connect an optical drive to the light blue SATA connector on the system board labeled SATA2.

● The power cables for the SATA drives connect directly to the power supply. The primary hard
drive connects to the power connector labeled P4. the primary optical drive connects to the
power connector labeled P3.

● The system does not support Parallel ATA (PATA) optical drives or PATA hard drives.

CAUTION: To prevent loss of work and damage to the computer or drive:

If you are inserting or removing a drive, shut down the operating system properly, turn off the
computer, and unplug the power cord. Do not remove a drive while the computer is on or in standby
mode.

Before handling a drive, ensure that you are discharged of static electricity. While handling a drive,
avoid touching the connector. For more information about preventing electrostatic damage, refer to
Electrostatic Discharge Information on page 36.

Handle a drive carefully; do not drop it.

Do not use excessive force when inserting a drive.

Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields
such as monitors or speakers.

If a drive must be mailed, place the drive in a bubble-pack mailer or other protective packaging and
label the package “Fragile: Handle With Care.”

Removing an Optical Drive

CAUTION: All removable media should be taken out of a drive before removing the drive from the
computer.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 80).

2. Remove the access panel (Access Panel on page 81).

3. Remove the front bezel (Front Bezel on page 83).

4. Rotate the drive cage to its upright position.
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5. If removing an optical drive, disconnect the cables from the rear of the drive.

Figure 8-15  Removing the drive cables

6. Remove the Torx screw from the cage.

Figure 8-16  Removing the optical drive screw

7. Return the drive to its normal position.
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8. Push the optical drive from behind, and then remove it from the front of the computer.

Figure 8-17  Removing the optical drive

Removing the Hard Drive

NOTE: Before you remove the old hard drive, be sure to back up the data from the old hard drive so
that you can transfer the data to the new hard drive.

The preinstalled 3.5-inch hard drive is located under the power supply. To remove and replace the
hard drive:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 80).

2. Remove the access panel (Access Panel on page 81).

3. Remove the front bezel (Front Bezel on page 83).

4. Rotate the drive cage to its upright position.
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5. On the front of the computer, pull and hold the hard drive release latch to unlock the hard drive.

Figure 8-18  Pulling the hard drive release latch

6. With the release latch pulled out, lift the rear of the hard drive.

Figure 8-19  Lifting the hard drive
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7. Disconnect the cables from the rear of the hard drive.

Figure 8-20  Disconnecting the hard drive cables

8. Remove the hard drive from the computer.

Figure 8-21  Removing the hard drive
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9. Remove the four guide screws from the hard drive for use in the replacement hard drive.

Figure 8-22  Removing the hard drive guide screws

To replace the hard drive, reverse the removal procedures.
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Power Switch

Description Spare part number

Power switch/LED assembly 656984-001

The power switch is attached to the front of the chassis using tabs (no screws). Its cable routes
through metal tabs in the chassis floor. The power switch cable connects to the front USB assembly
cable.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 80).

2. Remove the access panel (Access Panel on page 81).

3. Remove the front bezel (Front Bezel on page 83).

4. From the inside of the computer, remove the power switch cable from the tabs on the computer
floor.

Figure 8-23  Removing the power switch cable
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5. Disconnect the power switch cable from the front USB assembly cable.

Figure 8-24  Disconnecting the power switch cable

6. From the outside, front of the computer, press the tab on the right side of the power switch (1) to
disengage it from the chassis.

7. Rotate the power switch right to left (2), and then remove it from the computer (3) while routing
the cable through the hole in the front of the chassis.

Figure 8-25  Removing the power switch

To install the power switch, reverse the removal procedure.
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Front USB Assembly

Description Spare part number

Front I/O and card reader (6-in-1) 656983-001

The front USB assembly is secured to the front of the chassis with one screw. Push the assembly into
the chassis to remove it.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 80).

2. Remove the access panel (Access Panel on page 81).

3. Remove the front bezel (Front Bezel on page 83).

4. Disconnect the four cables from the system board as follows:

● Yellow connector labeled F_AUDIO

● White connector labeled MINI_LED

● White connector labeled F_USB3

● Black connector labeled F_USB2

Figure 8-26  Disconnecting the front I/O cables
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5. Remove the cables from the clip on the base pan of the computer.

Figure 8-27  Removing the cables from the clip

6. From the front of the computer, remove the screw that secures the assembly to the front of the
chassis.

Figure 8-28  Removing the front USB assembly screw
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7. Push the left side of the assembly down slightly (1), and then push the assembly into the
computer (2).

Figure 8-29  Disengaging the front USB assembly

8. Remove the assembly from the computer.

To install the front USB assembly, reverse the removal procedure.
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Fan Assembly

Description Spare part number

Fan 656834-001

The fan assembly is attached to the inside floor of the chassis using two screws. The fan is inside of a
removal metal cage.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 80).

2. Remove the access panel (Access Panel on page 81).

3. Remove the front bezel (Front Bezel on page 83).

4. Disconnect the fan cable from the system board connector labeled SYS_FAN.

5. Remove the Torx screw that secures the left side of the fan to the computer.

6. Cut the plastic tie (1) that secures the fan cable to the power supply power cables.

7. Remove the two screws (2) that secure the fan to the computer. The screw near the computer
side is not shown in the following image.

8. Lift the fan assembly up and out of the computer (3).

Figure 8-30  Removing the fan

Fan Assembly 107



9. if you need to remove the fan from the metal case, remove the four screws that secure the fan to
the case, and remove the fan from the case.

Figure 8-31  Removing the fan from the metal case

To install the fan, reverse the removal procedure.
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Fan Sink

Description Spare part number

Fan sink 657402-001

The fan sink is secured atop the processor with four captive Torx screws. A fan cable connects to the
system board.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 80).

2. Remove the access panel (Access Panel on page 81).

3. Loosen the four captive screws that secure the fan sink to the system board tray.

CAUTION: Fan sink retaining screws should be removed in diagonally opposite pairs (as in an
X) to even the downward forces on the processor. This is especially important as the pins on the
socket are very fragile and any damage to them may require replacing the system board.

Figure 8-32  Loosening the fan sink screws
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4. Disconnect the cable from the system board (1), lift the fan sink from atop the processor (2) and
set it on its side to keep from contaminating the work area with thermal grease.

Figure 8-33  Removing the fan sink

When reinstalling the fan sink, make sure that its bottom has been cleaned with an alcohol wipe and
fresh thermal grease has been applied to the top of the processor.

CAUTION: Fan sink retaining screws should be tightened in diagonally opposite pairs (as in an X)
to evenly seat the heat sink on the processor to avoid damage that could require replacing the system
board.

Failure to install the fan duct may cause the computer to overheat.
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Processor

Description Spare part number

Intel Core i7 processors  

2600S (2.7 GHz, 8-MB L3 cache, 65W) 638419-001

Intel Core i5 processors  

2500S (2.7 GHz, 6-MB L3 cache, 65W) 638420-001

2500 (3.3 GHz, 6-MB L3 cache, 95W) 638631-001

2405S (2.5-GHz, 6-MB L3 cache, 65W) 656790-001

2400S (2.5 GHz, 6-MB L3 cache, 65W) 640953-001

2400 (3.1 GHz, 6-MB L3 cache, 95W) 638630-001

2320 (3.0 GHz, 6-MB L3 cache, 95W) 665121-001-001

2310 (2.9 GHz, 6-MB L3 cache, 95W) 657111-001

2300 (2.8 GHz, 6-MB L3 cache, 95W) 654601-001

Intel Core i3 processors  

2130 (3.4 GHz, 3-MB L3 cache, 65W) 665120-001

2120 (3.3 GHz, 3-MB L3 cache, 65W) 638629-001

2105 (3.1 GHz, 3-MB L3 cache, 65W) 655970-001

2100 (3.1 GHz, 3-MB L3 cache, 65W) 638628-001

Intel Pentium Dual-Core processors  

G860 (3.0 GHz, 3-MB L3 cache, 65W) 665123-001

G850 (2.9-GHz, 3-MB L3 cache, 65W) 655973-001

G840 (2.8-GHz, 3-MB L3 cache, 65W) 655972-001

G630 (2.7 GHz, 3-MB L3 cache, 65W) 665122-001

G620 (2.6-GHz, 3-MB L3 cache, 65W) 655971-001

G540 (2.5 GHz, 2-MB L3 cache, 65W) 665119-001

G530 (2.4 GHz, 2-MB L3 cache, 65W) 665117-001

G530T (2.0 GHz, 2-MB L3 cache, 35W) 665118-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 80).

2. Remove the access panel (Access Panel on page 81).

3. Remove the fan sink (Fan Sink on page 109).

4. Rotate the locking lever to its full open position (1).

5. Raise and rotate the microprocessor retainer to its fully open position (2).
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6. Carefully lift the processor from the socket (3).

CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and
handling them could cause irreparable damage. Once pins are damaged it may be necessary to
replace the system board.

The heat sink must be installed within 24 hours of installing the processor to prevent damage to
the processor’s solder connections.

Figure 8-34  Removing the processor

To install a new processor:

1. Place the processor in its socket and close the retainer. Make sure the slot in the processor fits
into the post on the socket.

2. Secure the locking lever. If reusing the existing heat sink, go to step 3. If using a new heat sink,
go to step 6.

3. If reusing the existing fan sink, clean the bottom of the fan sink with the alcohol pad provided in
the spares kit.

CAUTION: Before reinstalling the fan sink you must clean the top of the processor and the
bottom of the fan sink with an alcohol pad supplied in the spares kit. After the alcohol has
evaporated, apply thermal grease to the top of the processor from the syringe supplied in the
spares kit.

4. Apply the thermal grease provided in the spares kit to the top of the processor and install the fan
sink atop the processor.

5. Go to step 7.
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6. If using a new fan sink, remove the protective covering from the bottom of the fan sink and place
it in position atop the processor.

7. Secure the fan sink to the system board and system board tray.

CAUTION: Fan sink retaining screws should be tightened in diagonally opposite pairs (as in an
X) to evenly seat the fan sink on the processor. This is especially important as the pins on the
socket are very fragile and any damage to them may require replacing the system board.

NOTE: After installing a new processor onto the system board, always update the system ROM to
ensure that the latest version of the BIOS is being used on the computer. The latest system BIOS can
be found on the Web at: http://h18000.www1.hp.com/support/files.

Power Supply

Description Spare part number

Power supply, 220W 656722-001

Power supply, 270W 665224-001

WARNING! To reduce potential safety issues, only the power supply provided with the computer, a
replacement power supply provided by HP, or a power supply purchased as an accessory from HP
should be used with the computer.

The rotating power supply is located at the rear of the chassis. It is held in place by a bracket – no
screws are used.

WARNING! Voltage is always present on the system board when the computer is plugged into an
active AC outlet. To avoid possible personal injury and damage to the equipment the power cord
should be disconnected from the computer and/or the AC outlet before opening the computer.

The power supply is secured to the rear of the computer with four Torx screws. On the inside of the
computer, a tab secures the power supply to the base pan.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 80).

2. Remove the access panel (Access Panel on page 81).

3. Rotate the drive cage up and disconnect the power cables from all of the drives.

4. Disconnect the power cables from the system board as follows:

● white 24-pin labeled P1 from ATX_POWER system board connector

● white 4-pin labeled P2 from ATX_CPU system board connector
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5. From the rear of the computer, remove the four screws that secure the power supply to the
computer.

Figure 8-35  Removing the power supply screws

6. On the inside of the computer, press the tab at the front of the power supply (1), pull the power
supply forward, slide it back and toward the side of the computer so it can sit lower on the
bottom of the computer, and then rotate it and lift it out of the computer (2).

Figure 8-36  Removing the power supply

To install the power supply, reverse the removal procedure.

CAUTION: When installing the power supply cables, make sure they are properly positioned so
they are not cut by the drive cage and are not pinched by the rotating power supply.
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System Board

Description Spare part number

System board (includes thermal material) 665223-001

The system board is secured to the computer with six screws.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 80).

2. Remove the access panel (Access Panel on page 81).

3. When replacing the system board, make sure the following components are removed from the
defective system board and installed on the replacement system board:

● Memory modules (seeMemory on page 84)

● Expansion cards (Expansion Card on page 89)

● Heat sink (Fan Sink on page 109)

● Processor (Processor on page 111)

4. Remove the fan from the chassis (Fan Assembly on page 107).

5. Rotate the drive cage to its upright position.

6. Rotate the power supply to its full upright position.

7. Disconnect all data and power cables from the system board.

8. Disconnect the balance of the cables from the system board.
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9. Remove the six screws that secure the system board to the chassis.

NOTE: System board appearance may vary.

Figure 8-37  Removing the system board screws

10. Slide the system board away from the rear of the computer to disengage the ports, and then lift
the board up and out of the chassis.

Figure 8-38  Removing the system board

To install the system board, reverse the removal procedure.
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NOTE: When replacing the system board, you must also change the chassis serial number in the
BIOS.

CAUTION: Before reinstalling the heat sink you must clean the top of the processor and the bottom
of the heat sink with an alcohol pad supplied in the spares kit. After the alcohol has evaporated, apply
thermal grease to the top of the processor from the syringe supplied in the spares kit.

CAUTION: When reconnecting the cables it is important that they be positioned so they do not
interfere with the rotation of the drive cage or power supply.

Battery
The battery that comes with your computer provides power to the real-time clock and has a lifetime of
about three years. When replacing the battery, use a battery equivalent to the battery originally
installed on the computer. The computer comes with a 3-volt lithium coin cell battery.

NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC
wall socket. The lithium battery is only used when the computer is NOT connected to AC power.

WARNING! This computer contains an internal lithium manganese dioxide battery. There is a risk of
fire and burns if the battery is not handled properly. To reduce the risk of personal injury:

❑ Do not attempt to recharge the battery.

❑ Do not expose to temperatures higher than 60°C (140°F)

❑ Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.

❑ Replace the battery only with the HP/Compaq spare designated for this product.

CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings.
When the battery is removed or replaced, the CMOS settings will be cleared. Refer to the
Troubleshooting Without Diagnostics on page 141 chapter for information on backing up the CMOS
settings.

NOTE: Batteries, battery packs, and accumulators should not be disposed of together with the
general household waste. In order to forward them to recycling or proper disposal, please use the
public collection system or return them to HP, its authorized partners, or its agents.

CAUTION: Static electricity can damage the electronic components of the computer or optional
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by
briefly touching a grounded metal object.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 43).

2. Remove the access panel (Access Panel on page 44).

NOTE: It may be necessary to remove an expansion card to gain access to the battery.

3. Locate the battery and battery holder on the system board.

4. To release the battery from its holder, squeeze the metal clamp that extends above one edge of
the battery. When the battery pops up, lift it out (1).
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5. To insert the new battery, slide one edge of the replacement battery under the holder’s lip with
the positive side up (2). Push the other edge down until the clamp snaps over the other edge of
the battery.

6. Replace the computer access panel.

7. Plug in the computer and turn on power to the computer.

8. Reset the date and time, your passwords, and any special system setups, using Computer
Setup. Refer to Computer Setup (F10) Utility on page 7.
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A Connector Pin Assignments

This appendix contains the pin assignments for many computer and workstation connectors. Some of
these connectors may not be used on the product being serviced.

Ethernet BNC

Connector and Icon Pin Signal

1

2

Data

Ground

USB

Connector and Icon Pin Signal

1

2

3

4

+5 VDC

- Data

+ Data

Ground

Microphone

Connector and Icon (1/8” miniphone) Pin Signal

1 (Tip)

2 (Ring)

3 (Shield)

Audio_left

Audio_Right

Ground
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Headphone

Connector and Icon (1/8” miniphone) Pin Signal

1 (Tip)

2 (Ring)

3 (Shield)

Audio_left

Power_Right

Ground

Line-in Audio

Connector and Icon (1/8” miniphone) Pin Signal

1 (Tip)

2 (Ring)

3 (Shield)

Audio_In_Left

Audio_In_Right

Ground

Line-out Audio

Connector and Icon (1/8” miniphone) Pin Signal

1 (Tip)

2 (Ring)

3 (Shield)

Audio_Out_Left

Audio_Out_Right

Ground

4-Pin Power (for CPU)

Connector and Icon Pin Signal

1

2

3

4

GND

GND

+12V CPU

-12V CPU
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Monitor

Connector and Icon

Pin Signal  Pin Signal

1

2

3

4

Red Analog

Green Analog

Blue Analog

Not used

 9

10

11

12

+5V (fused)

Ground

Not used

DDC Serial Data

5

6

7

8

Ground

Ground

Ground

Ground

 13

14

15

Horizontal Sync

Vertical Sync

DDC Serial Clock

Serial Interface, Powered and Non-Powered

Connector and Icon Pin Signal

1

2

3

Carrier Detect (12V if powered)

Receive Data

Transmit Data

4

5

6

Data Terminal Ready

Signal Ground

Data Set Ready

7

8

9

Request to Send

Clear to Send

Ring Indicator (5V if powered)
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DVI Connector

Connector and Icon

Pin Signal  Pin Signal

1

2

3

4

T.M.D.S. Data2–

T.M.D.S. Data2+

T.M.D.S. Data2/4 Shield

T.M.D.S. Data4–

 13

14

15

16

T.M.D.S. Data3+

+5V Power

Ground (for +5V)

Hot Pug Detect

5

6

7

8

T.M.D.S. Data4+

DDC Clock

DDC Data

No Connect

 17

18

19

20

T.M.D.S. Data0–

T.M.D.S. Data0+

T.M.D.S. Data0/5 Shield

T.M.D.S. Data5–

9

10

11

12

T.M.D.S. Data1–

T.M.D.S. Data1+

T.M.D.S. Data1/3 Shield

T.M.D.S. Data3–

 21

22

23

24

T.M.D.S. Data5+

T.M.D.S. Data Shield

T.M.D.S. Clock+

T.M.D.S. Clock-
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24-Pin Power

Connector

Pin Signal Pin Signal Pin Signal Pin Signal

1

2

3

4

5

6

+3.3V

+3.3V

GND

+5V

GND

+5V

7

8

9

10

11

12

GND

POK

+5 Vaux

+12V

+12V

+3.3V

13

14

15

16

17

18

+3.3V

–12V

GND

PSON

GND

GND

19

20

21

22

23

24

GND

open

+5V

+5V

+5V

GND
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PCI Express

x1, x4, x8, and x16 PCI Express Connector

Pin A

Pin Signal Pin Signal Pin Signal Pin Signal Pin Signal

1

2

3

4

5

PRSNT1

+12V

+12V

GND

JTAG2

6

7

8

9

10

JTAG3

JTAG4

JTAG5

+3.3V

+3.3V

11

12

13

14

15

PERST#

GND

REFCLK+

REFCLK-

GND

16

17

18

19

20

PERp0

PERn0

GND

RSVD

GND

21

22

23

24

25

PERp1

PERn1

GND

GND

PERp2

26

27

28

29

30

PERn(2)

GND

GND

PERp3

PERn3

31

32

33

34

35

GND

RSVD

RSVD

GND

PERp4

36

37

38

39

40

PERn4

GND

GND

PERp5

PERn5

41

42

43

44

45

GND

GND

PERp6

PERn6

GND

46

47

48

49

50

GND

PERp7

PERn7

GND

RSVD

51

52

53

54

55

GND

PERp8

PERN8

GND

GND

56

57

58

59

60

PERp9

PERn9

GND

GND

PERp10

61

62

63

64

65

PERn10

GND

GND

PERp11

PERn11

66

67

68

69

70

GND

GND

PERp12

PERn12

GND

71

72

73

74

75

GND

PERp13

PERn13

GND

GND

76

77

78

79

80

PERp14

PERn14

GND

GND

PERp15

81

82

PERn15

GND

      

Pin B information is on the next page

NOTE: x1 PCI Express uses pins 1-18

x4 PCI Express uses pins 1-32

x8 PCI Express uses pins 1-49

x16 PCI Express uses pins 1-8
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PCI Express

x1, x4, x8, and x16 PCI Express Connector

Pin B

Pin Signal Pin Signal Pin Signal Pin Signal Pin Signal

1

2

3

4

5

+12V

+12V

RSVD

GND

SMCLK

6

7

8

9

10

SMDAT

GND

+3.3 V

JTAG1

3.3vAux

11

12

13

14

15

WAKE#

RSVD

GND

PETp0

PETn0

16

17

18

19

20

GND

GND

PETp1

PETn1

21

22

23

24

25

GND

GND

PETp2

PETn2

GND

26

27

28

29

30

GND

PETp3

PETn3

GND

RSVD

31

32

33

34

35

PRSNT2#

GND

PETp4

PETn4

GND

36

37

38

39

40

GND

PETp5

PETn5

GND

GND

41

42

43

44

45

PETp6

PRTn6

GND

GND

PETp7

46

47

48

49

50

PETn7

GND

PRSNT2#

GND

PETp8

51

52

53

54

55

PETn8

GND

GND

PETp9

PETn9

56

57

58

59

60

GND

GND

PETp10

PETn10

GND

61

62

63

64

65

GND

PETp11

PETn11

GND

GND

66

67

68

69

70

PETp12

PETn12

GND

GND

PETp13

71

72

73

74

75

PETn13

GND

GND

PETp14

PETn14

76

77

78

79

80

GND

GND

PETp15

PETn15

GND

81

82

PRSNT2#

RSVD

      

Pin B information is on the next page

NOTE: x1 PCI Express uses pins 1-18

x4 PCI Express uses pins 1-32

x8 PCI Express uses pins 1-49

x16 PCI Express uses pins 1-8
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B Power Cord Set Requirements

The power supplies on some computers have external power switches. The voltage select switch
feature on the computer permits it to operate from any line voltage between 100-120 or 220-240 volts
AC. Power supplies on those computers that do not have external power switches are equipped with
internal switches that sense the incoming voltage and automatically switch to the proper voltage.

The power cord set received with the computer meets the requirements for use in the country where
you purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you use
the computer.

General Requirements
The requirements listed below are applicable to all countries:

1. The power cord must be approved by an acceptable accredited agency responsible for
evaluation in the country where the power cord set will be installed.

2. The power cord set must have a minimum current capacity of 10A (7A Japan only) and a
nominal voltage rating of 125 or 250 volts AC, as required by each country’s power system.

3. The diameter of the wire must be a minimum of 0.75 mm2 or 18AWG, and the length of the cord
must be between 1.8 m (6 feet) and 3.6 m (12 feet).

The power cord should be routed so that it is not likely to be walked on or pinched by items placed
upon it or against it. Particular attention should be paid to the plug, electrical outlet, and the point
where the cord exits from the product.

WARNING! Do not operate this product with a damaged power cord set. If the power cord set is
damaged in any manner, replace it immediately.

Japanese Power Cord Requirements
For use in Japan, use only the power cord received with this product.

CAUTION: Do not use the power cord received with this product on any other products.
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Country-Specific Requirements
Additional requirements specific to a country are shown in parentheses and explained below.

Country Accrediting Agency  Country Accrediting Agency

Australia (1)

Austria (1)

Belgium (1)

Canada (2)

EANSW

OVE

CEBC

CSA

 Italy (1)

Japan (3)

Norway (1)

Sweden (1)

IMQ

METI

NEMKO

SEMKO

Denmark (1)

Finland (1)

France (1)

Germany (1)

DEMKO

SETI

UTE

VDE

 Switzerland (1)

United Kingdom (1)

United States (2)

SEV

BSI

UL

1. The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm2 conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country where it
will be used.

2. The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A, 250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. Flexible cord must be Type VCT or VCTF, 3-conductor, 0.75 mm2 conductor size. Wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7A, 125V) configuration.
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C POST Error Messages

This appendix lists the error codes, error messages, and the various indicator light and audible
sequences that you may encounter during Power-On Self-Test (POST) or computer restart, the
probable source of the problem, and steps you can take to resolve the error condition.

POST Message Disabled suppresses most system messages during POST, such as memory count
and non-error text messages. If a POST error occurs, the screen will display the error message. To
manually switch to the POST Messages Enabled mode during POST, press any key (except F10,
F11, or F12). The default mode is POST Message Disabled.

The speed at which the computer loads the operating system and the extent to which it is tested are
determined by the POST mode selection.

Quick Boot is a fast startup process that does not run all of the system level tests, such as the
memory test. Full Boot runs all of the ROM-based system tests and takes longer to complete.

Full Boot may also be enabled to run every 1 to 30 days on a regularly scheduled basis. To establish
the schedule, reconfigure the computer to the Full Boot Every x Days mode, using Computer Setup.

NOTE: For more information on Computer Setup, see Computer Setup (F10) Utility on page 7.
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POST Numeric Codes and Text Messages
This section covers those POST errors that have numeric codes associated with them. The section
also includes some text messages that may be encountered during POST.

NOTE: The computer will beep once after a POST text message is displayed on the screen.

Table C-1  Numeric Codes and Text Messages

Control panel message Description Recommended action

101-Option ROM Checksum Error System ROM or expansion board option
ROM checksum.

1. Verify the correct ROM.

2. Flash the ROM if needed.

3. If an expansion board was recently
added, remove it to see if the problem
remains.

4. Clear CMOS. (See Appendix B,
Password Security and Resetting
CMOS on page 178.)

5. If the message disappears, there may
be a problem with the expansion card.

6. Replace the system board.

103-System Board Failure DMA or timers. 1. Clear CMOS. (See Appendix B,
Password Security and Resetting
CMOS on page 178.)

2. Remove expansion boards.

3. Replace the system board.

110-Out of Memory Space for Option ROMs Recently added PCI expansion card
contains an option ROM too large to
download during POST.

1. If a PCI expansion card was recently
added, remove it to see if the problem
remains.

2. In Computer Setup, set Advanced >
Device Options > NIC PXE Option
ROM Download to DISABLE to
prevent PXE option ROM for the
internal NIC from being downloaded
during POST to free more memory for
an expansion card's option ROM.
Internal PXE option ROM is used for
booting from the NIC to a PXE server.

162-System Options Not Set Configuration incorrect.

RTC (real-time clock) battery may need to
be replaced.

Run Computer Setup and check the
configuration in Advanced > Onboard
Devices.

Reset the date and time under Control
Panel. If the problem persists, replace the
RTC battery. See the Removal and
Replacement section for instructions on
installing a new battery, or contact an
authorized dealer or reseller for RTC battery
replacement.
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Table C-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

163-Time & Date Not Set Invalid time or date in configuration
memory.

RTC (real-time clock) battery may need to
be replaced.

Reset the date and time under Control
Panel (Computer Setup can also be used).
If the problem persists, replace the RTC
battery. See the Removal and Replacement
section for instructions on installing a new
battery, or contact an authorized dealer or
reseller for RTC battery replacement.

163-Time & Date Not Set CMOS jumper may not be properly
installed.

Check for proper placement of the CMOS
jumper if applicable.

164-MemorySize Error Memory amount has changed since the last
boot (memory added or removed).

Press the F1 key to save the memory
changes.

164-MemorySize Error Memory configuration incorrect. 1. Run Computer Setup or Windows
utilities.

2. Make sure the memory module(s) are
installed properly.

3. If third-party memory has been added,
test using HP-only memory.

4. Verify proper memory module type.

201-Memory Error RAM failure. 1. Ensure memory modules are correctly
installed.

2. Verify proper memory module type.

3. Remove and replace the identified
faulty memory module(s).

4. If the error persists after replacing
memory modules, replace the system
board.

213-Incompatible Memory Module in
Memory Socket(s) X, X, ...

A memory module in memory socket
identified in the error message is missing
critical SPD information, or is incompatible
with the chipset.

1. Verify proper memory module type.

2. Try another memory socket.

3. Replace DIMM with a module
conforming to the SPD standard.

214-DIMM Configuration Warning Populated DIMM Configuration is not
optimized.

Rearrange the DIMMs so that each channel
has the same amount of memory.

219-ECC Memory Module Detected ECC
Modules not supported on this Platform

Recently added memory module(s) support
ECC memory error correction.

1. If additional memory was recently
added, remove it to see if the problem
remains.

2. Check product documentation for
memory support information.

301-Keyboard Error Keyboard failure. 1. Reconnect keyboard with computer
turned off.

2. Check connector for bent or missing
pins.

3. Ensure that none of the keys are
depressed.

4. Replace keyboard.
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Table C-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

303-Keyboard Controller Error I/O board keyboard controller. 1. Reconnect keyboard with computer
turned off.

2. Replace the system board.

304-Keyboard or System Unit Error Keyboard failure. 1. Reconnect the keyboard with computer
turned off.

2. Ensure that none of the keys are
depressed.

3. Replace the keyboard.

4. Replace the system board.

501-Display Adapter Failure Graphics display controller. 1. Reseat the graphics card
(if applicable).

2. Clear CMOS. (See Appendix B,
Password Security and Resetting
CMOS on page 178.)

3. Verify monitor is attached and turned
on.

4. Replace the graphics card (if possible).

510-Flash Screen Image Corrupted Flash Screen image has errors. Reflash the system ROM with the latest
BIOS image.

511-CPU, CPUA, or CPUB Fan not
Detected

CPU fan is not connected or may have
malfunctioned.

1. Reseat CPU fan.

2. Reseat fan cable.

3. Replace CPU fan.

512-Chassis, Rear Chassis, or Front
Chassis Fan not Detected

Chassis, rear chassis, or front chassis fan is
not connected or may have malfunctioned.

1. Reseat chassis, rear chassis, or front
chassis fan.

2. Reseat fan cable.

3. Replace chassis, rear chassis, or front
chassis fan.

513-Front Chassis fan not detected Front chassis fan is not connected or may
have malfunctioned.

1. Reseat front chassis fan.

2. Reseat fan cable.

3. Replace front chassis fan.

514-CPU or Chassis Fan not Detected CPU or chassis fan is not connected or may
have malfunctioned.

1. Reseat CPU or chassis fan.

2. Reseat fan cable.

3. Replace CPU or chassis fan.

515-Power Supply fan not detected Power supply fan is not connected or may
have malfunctioned.

1. Reseat power supply fan.

2. Reseat fan cable.

3. Replace power supply fan.
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Table C-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

601-Diskette Controller Error Diskette controller circuitry or floppy drive
circuitry incorrect.

1. Check and/or replace cables.

2. Clear CMOS. (See Appendix B,
Password Security and Resetting
CMOS on page 178.)

3. Replace diskette drive.

4. Replace the system board.

605-Diskette Drive Type Error Mismatch in drive type. 1. Disconnect any other diskette
controller devices (tape drives).

2. Clear CMOS. (See Appendix B,
Password Security and Resetting
CMOS on page 178.)

660-Display cache is detected unreliable Integrated graphics controller display cache
is not working properly and will be disabled.

Replace system board if minimal graphics
degrading is an issue.

912-Computer Cover Has Been Removed
Since Last System Startup

Computer cover was removed since last
system startup.

No action required.

917-Front Audio Not Connected Front audio harness has been detached or
unseated from motherboard.

Reconnect or replace front audio harness.

918-Front USB Not Connected Front USB harness has been detached or
unseated from motherboard.

Reconnect or replace front USB harness.

921-Device in PCI Express slot failed to
initialize

There is an incompatibility/problem with this
device and the system or PCI Express Link
could not be retrained to an x1.

Try rebooting the system. If the error
reoccurs, the device may not work with this
system

1151-Serial Port A Address Conflict
Detected

Both external and internal serial ports are
assigned to COM1.

1. Remove any serial port expansion
cards.

2. Clear CMOS. (See Appendix B,
Password Security and Resetting
CMOS on page 178.)

3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1152-Serial Port B Address Conflict
Detected

Both external and internal serial ports are
assigned to COM2.

1. Remove any serial port expansion
cards.

2. Clear CMOS. (See Appendix B,
Password Security and Resetting
CMOS on page 178.)

3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1155-Serial Port Address Conflict Detected Both external and internal serial ports are
assigned to same IRQ.

1. Remove any serial port expansion
cards.

2. Clear CMOS. (See Appendix B,
Password Security and Resetting
CMOS on page 178.)

3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

132 Appendix C   POST Error Messages



Table C-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

1720-SMART Hard Drive Detects Imminent
Failure

Hard drive is about to fail. (Some hard
drives have a hard drive firmware patch that
will fix an erroneous error message.)

1. Determine if hard drive is giving correct
error message. Enter Computer Setup
and run the Drive Protection System
test under Storage > DPS Self-test.

2. Apply hard drive firmware patch
if applicable. (Available at
http://www.hp.com/support.)

3. Back up contents and replace hard
drive.

1796-SATA Cabling Error One or more SATA devices are improperly
attached. For optimal performance, the
SATA 0 and SATA 1 connectors must be
used before SATA 2 and SATA 3.

Ensure SATA connectors are used in
ascending order. For one device, use SATA
0. For two devices, use SATA 0 and SATA
1. For three devices, use SATA 0, SATA 1,
and SATA 2.

1797-SATA Drivelock is not supported in
RAID mode.

Drivelock is enabled on one or more SATA
hard drives, and they cannot be accessed
while the system is configured for RAID
mode.

Either remove the Drivelocked SATA device
or disable the Drivelock feature. To disable
the Drivelock feature, enter Computer
Setup, change Storage > Storage
Options > SATA Emulation to IDE, and
select File > Save Changes and Exit.
Reenter Computer Setup and select
Security > Drivelock Security. For each
listed Drivelock-capable SATA device,
ensure Drivelock is Disabled. Lastly,
change Storage > Storage Options >
SATA Emulation back to RAID and select
File > Save Changes and Exit.

1801-Microcode Patch Error Processor is not supported by ROM BIOS. 1. Upgrade BIOS to proper version.

2. Change the processor.

2200-PMM Allocation Error during MEBx
Download

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was
recently changed, unplug the
computer, restore the original memory
configuration, and reboot the
computer.

4. If the error persists, replace the system
board.
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Table C-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

2201-MEBx Module did not checksum
correctly

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was
recently changed, unplug the power
cord, restore the original memory
configuration, and reboot the
computer.

4. If the error persists, replace the system
board.

2202-PMM Deallocation Error during MEBx
cleanup

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was
recently changed, unplug the power
cord, restore the original memory
configuration, and reboot the
computer.

4. If the error persists, replace the system
board.

2203-Setup error during MEBx execution MEBx selection or exit resulted in a setup
failure.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was
recently changed, unplug the power
cord, restore the original memory
configuration, and reboot the
computer.

4. If the error persists, replace the system
board.

2204-Inventory error during MEBx execution BIOS information passed to the MEBx
resulted in a failure.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version.

3. If the error still persists, replace the
system board.

2205-Interface error during MEBx execution MEBx operation experienced a hardware
error during communication with ME.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version.

3. If the error still persists, replace the
system board.
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Table C-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

2211-Memory not configured correctly for
proper MEBx execution.

DIMM1 or XMM1 is not installed. Make sure there is a memory module in the
black DIMM1 socket and that it is properly
seated.

2212-USB Key Provisioning failure writing to
device

USB device used for USB key provisioning
will not allow BIOS to update provision file
properly.

1. Try a different USB key device for
provisioning.

2. If the error persists, update to the latest
BIOS version and ME firmware
version.

3. If the error still persists, replace the
system board.

2217-ME Firmware Version request failure ME firmware is not properly responding to
BIOS query for version information.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version and ME firmware
version.

3. If the error still persists, replace the
system board.

2218-ME Firmware Version should be
updated

ME firmware must be updated to match
current functionality contained in the system
BIOS.

1. Update to the latest ME firmware
version.

2. If the error persists and system BIOS
has been recently updated, restore
previous system BIOS version.

3. If the error still persists, replace the
system board.

2219-USB Key Provisioning file has invalid
header identifier

Provisioning file contained on the USB key
has been corrupted or is not a valid version
for the current ME firmware.

1. Recreate the provisioning file using
third party management console
software.

2. If the error persists and system BIOS
has been recently updated, restore
previous system BIOS version.
Otherwise, update the ME firmware
version.

3. If the error still persists, replace the
system board.

2220-USB Key Provisioning file has
mismatch version

Provisioning file contained on the USB key
is not a valid version for the current ME
firmware.

1. Reboot the computer.

2. If the error persists and system BIOS
has been recently updated, restore
previous system BIOS version.
Otherwise, update the ME firmware
version.

3. If the error still persists, replace the
system board.
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Table C-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

2230-General error during MEBx execution Error occurred during MEBx execution
which fails into the “General” grouping.
Status information displayed along with the
error provides further clarity into the failure.
MEBx handles transference of information
between the system BIOS and ME
firmware.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version and ME firmware
version.

3. If the error still persists, replace the
system board.

2231-ME error during MEBx execution Error occurred during MEBx execution
which fails into “ME” grouping.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version and ME firmware
version.

3. If the error still persists, replace the
system board.

2232-AMT error during MEBx execution Error occurred during MEBx execution
which fails into “AMT” grouping.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version and ME firmware
version.

3. If the error still persists, replace the
system board.

2233-HECI error during MEBx execution Error occurred during MEBx execution
which fails into “MEI or HECI” grouping.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version and ME firmware
version.

3. If the error still persists, replace the
system board.

2239-ME image lock failure Special system configurations with reduced
ME firmware image require BIOS control of
ME firmware upgrading. A failure has
occurred after the ME firmware update
process in which the BIOS could not relock
the ME firmware region.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version and ME firmware
version.

3. If the error still persists, replace the
system board.

2240-ME image unlock failure Special system configurations with reduced
ME firmware image require BIOS control of
ME firmware upgrading. A failure has
occurred prior to the ME firmware update
process in which the BIOS could not unlock
the ME firmware region.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version and ME firmware
version.

3. If the error still persists, replace the
system board.

Invalid Electronic Serial Number Electronic serial number is missing. Enter the correct serial number in Computer
Setup.
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Table C-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

Network Server Mode Active and No
Keyboard Attached

Keyboard failure while Network Server
Mode enabled.

1. Reconnect keyboard with computer
turned off.

2. Check connector for bent or missing
pins.

3. Ensure that none of the keys are
depressed.

4. Replace keyboard.

Parity Check 2 Parity RAM failure. Run Computer Setup and Diagnostic
utilities.

Interpreting POST Diagnostic Front Panel LEDs and
Audible Codes

This section covers the front panel LED codes as well as the audible codes that may occur before or
during POST that do not necessarily have an error code or text message associated with them.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to
cool before touching.

NOTE: If you see flashing LEDs on a PS/2 keyboard, look for flashing LEDs on the front panel of
the computer and refer to the following table to determine the front panel LED codes.

Recommended actions in the following table are listed in the order in which they should be
performed.

Not all diagnostic lights and audible codes are available on all models.

Table C-2  Diagnostic Front Panel LEDs and Audible Codes

Activity Beeps Possible Cause Recommended Action

Green Power LED On. None Computer on. None

Green Power LED flashes
every two seconds.

None Computer in Suspend to
RAM mode (some models
only) or normal Suspend
mode.

None required. Press any key or move the
mouse to wake the computer.
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Table C-2  Diagnostic Front Panel LEDs and Audible Codes (continued)

Activity Beeps Possible Cause Recommended Action

Red Power LED flashes two
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

2 Processor thermal
protection activated:

A fan may be blocked or
not turning.

OR

The heat sink/fan
assembly is not properly
attached to the processor.

1. Ensure that the computer air vents are not
blocked and the processor cooling fan is
running.

2. Open hood, press power button, and see if
the processor fan spins. If the processor fan
is not spinning, make sure the fan's cable is
plugged onto the system board header.

3. If fan is plugged in, but is not spinning, then
replace heat sink/fan assembly.

4. Contact an authorized reseller or service
provider.

Red Power LED flashes three
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

3 Processor not installed
(not an indicator of bad
processor).

1. Check to see that the processor is present.

2. Reseat the processor.

Red Power LED flashes four
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

4 Power failure (power
supply is overloaded).

OR

The incorrect external
power supply adapter is
being used on the USDT.

1. Open the hood and ensure the 4 or 6-wire
power supply cable is seated into the
connector on the system board.

2. Check if a device is causing the problem by
removing ALL attached devices (such as
hard, diskette, or optical drives, and
expansion cards). Power on the system. If
the system enters the POST, then power off
and replace one device at a time and
repeat this procedure until failure occurs.
Replace the device that is causing the
failure. Continue adding devices one at a
time to ensure all devices are functioning
properly.

3. Replace the power supply.

4. Replace the system board.

OR

The USDT power supply adapter must be at
135W and use the Smart ID technology before
the system will power up. Replace the power
supply adapter with the HP-supplied USDT
power supply adapter.
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Table C-2  Diagnostic Front Panel LEDs and Audible Codes (continued)

Activity Beeps Possible Cause Recommended Action

Red Power LED flashes five
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

5 Pre-video memory error. CAUTION: To avoid damage to the DIMMs or
the system board, you must unplug the computer
power cord before attempting to reseat, install, or
remove a DIMM module.

1. Reseat DIMMs.

2. Replace DIMMs one at a time to isolate the
faulty module.

3. Replace third-party memory with HP
memory.

4. Replace the system board.

Red Power LED flashes six
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

6 Pre-video graphics error. For systems with a graphics card:

1. Reseat the graphics card.

2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace
the system board.

Red Power LED flashes
seven times, once every
second, followed by a two
second pause. Beeps stop
after fifth iteration but LEDs
continue until problem is
solved.

7 System board failure
(ROM detected failure
prior to video).

Replace the system board.

Red Power LED flashes eight
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

8 Invalid ROM based on
bad checksum.

1. Reflash the system ROM with the latest
BIOS image. See the “Boot Block
Emergency Recovery Mode” section of the
Desktop Management Guide for more
information.

2. Replace the system board.

Red Power LED flashes nine
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

9 System powers on but is
unable to boot.

1. Check that the voltage selector, located on
the rear of the power supply (some
models), is set to the appropriate voltage.
Proper voltage setting depends on your
region.

2. Unplug the AC power cord from the
computer, wait 30 seconds, then plug the
power cord back in to the computer.

3. Replace the system board.

4. Replace the processor.
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Table C-2  Diagnostic Front Panel LEDs and Audible Codes (continued)

Activity Beeps Possible Cause Recommended Action

Red Power LED flashes ten
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

10 Bad option card. 1. Check each option card by removing the
card (one at a time if multiple cards), then
power on the system to see if fault goes
away.

2. Once a bad card is identified, remove and
replace the bad option card.

3. Replace the system board.

Red Power LED flashes
eleven times, once every
second, followed by a two
second pause. Beeps stop
after fifth iteration but LEDs
continue until problem is
solved.

11 The current processor
does not support a
feature previously
enabled on this system.

1. Install a TXT capable processor.

2. Disable TXT in the Computer Setup (F10)
utility.

3. Reinstall the original processor.

System does not power on
and LEDs are not flashing.

None System unable to power
on.

Press and hold the power button for less than 4
seconds. If the hard drive LED turns green, the
power button is working correctly. Try the
following:

1. Check that the voltage selector (some
models), located on the rear of the power
supply, is set to the appropriate voltage.
Proper voltage setting depends on your
region.

2. Replace the system board.

OR

Press and hold the power button for less than 4
seconds. If the hard drive LED does not turn on
green then:

1. Check that the unit is plugged into a
working AC outlet.

2. Open hood and check that the power button
harness is properly connected to the
system board.

3. Check that both power supply cables are
properly connected to the system board.

4. Check to see if the 5V_aux light on the
system board is turned on. If it is turned on,
then replace the power button harness. If
the problem persists, replace the system
board.

5. If the 5V_aux light on the system board is
not turned on, remove the expansion cards
one at a time until the 5V_aux light on the
system board turns on. It the problem
persists, replace the power supply.
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D Troubleshooting Without Diagnostics

This chapter provides information on how to identify and correct minor problems, such as diskette
drive, hard drive, optical drive, graphics, audio, memory, and software problems. If you encounter
problems with the computer, refer to the tables in this chapter for probable causes and recommended
solutions.

Safety and Comfort
WARNING! Misuse of the computer or failure to establish a safe and comfortable work environment
may result in discomfort or serious injury. Refer to the Safety & Comfort Guide at http://www.hp.com/
ergo for more information on choosing a workspace and creating a safe and comfortable work
environment. For more information, refer to the Safety & Regulatory Information guide.

Before You Call for Technical Support
If you are having problems with the computer, try the appropriate solutions below to try to isolate the
exact problem before calling for technical support.

● Run the HP diagnostic tool.

● Run the hard drive self-test in Computer Setup. Refer to Computer Setup (F10) Utility on page 7
for more information.

● Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights
are error codes that will help you diagnose the problem. Refer to Appendix A, POST Error
Messages on page 128 for more information.

● If the screen is blank, plug the monitor into a different video port on the computer if one is
available. Or, replace the monitor with a monitor that you know is functioning properly.

● If you are working on a network, plug another computer with a different cable into the network
connection. There may be a problem with the network plug or cable.

● If you recently added new hardware, remove the hardware and see if the computer functions
properly.

● If you recently installed new software, uninstall the software and see if the computer functions
properly.

● Boot the computer to the Safe Mode to see if it will boot without all of the drivers loaded. When
booting the operating system, use “Last Known Configuration.”
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● Refer to the comprehensive online technical support at http://www.hp.com/support.

● Refer to Helpful Hints on page 142 in this guide.

To assist you in resolving problems online, HP Instant Support Professional Edition provides you with
self-solve diagnostics. If you need to contact HP support, use HP Instant Support Professional
Edition's online chat feature. Access HP Instant Support Professional Edition at: http://www.hp.com/
go/ispe.

Access the Business Support Center (BSC) at http://www.hp.com/go/bizsupport for the latest online
support information, software and drivers, proactive notification, and worldwide community of peers
and HP experts.

If it becomes necessary to call for technical assistance, be prepared to do the following to ensure that
your service call is handled properly:

● Be in front of your computer when you call.

● Write down the computer serial number, product ID number, and monitor serial number before
calling.

● Spend time troubleshooting the problem with the service technician.

● Remove any hardware that was recently added to your system.

● Remove any software that was recently installed.

● Restore the system from the Recovery Disc Set that you created or restore the system to its
original factory condition in HP Backup and Recovery Manager.

CAUTION: Restoring the system will erase all data on the hard drive. Be sure to back up all data
files before running the restore process.

NOTE: For sales information and warranty upgrades (Care Packs), call your local authorized
service provider or dealer.

Helpful Hints
If you encounter problems with the computer, monitor, or software, see the following list of general
suggestions before taking further action:

● Check that the computer and monitor are plugged into a working electrical outlet.

● Check that the voltage select switch (some models) is set to the appropriate voltage for your
region (115V or 230V).

● Check that the computer is turned on and the green power light is on.

● Check that the monitor is turned on and the green monitor light is on.

● Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights
are error codes that will help you diagnose the problem. Refer to Appendix A, POST Error
Messages on page 128 for more information.

● Turn up the brightness and contrast controls of the monitor if the monitor is dim.

● Press and hold any key. If the system beeps, then the keyboard should be operating correctly.

● Check all cable connections for loose connections or incorrect connections.
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● Wake the computer by pressing any key on the keyboard or pressing the power button. If the
system remains in suspend mode, shut down the computer by pressing and holding the power
button for at least four seconds then press the power button again to restart the computer. If the
system will not shut down, unplug the power cord, wait a few seconds, then plug it in again. The
computer will restart if it is set to power on automatically as soon as power is restored in
Computer Setup. If it does not restart, press the power button to start the computer.

● Reconfigure the computer after installing a non-plug and play expansion board or other option.
See Solving Hardware Installation Problems on page 164 for instructions.

● Be sure that all the needed device drivers have been installed. For example, if you are using a
printer, you need a driver for that model printer.

● Remove all bootable media (diskette, CD, or USB device) from the system before turning it on.

● If you have installed an operating system other than the factory-installed operating system,
check to be sure that it is supported on the system.

● If the system has multiple video sources (embedded, PCI, or PCI-Express adapters) installed
(embedded video on some models only) and a single monitor, the monitor must be plugged into
the monitor connector on the source selected as the primary VGA adapter. During boot, the
other monitor connectors are disabled and if the monitor is connected into these ports, the
monitor will not function. You can select which source will be the default VGA source in
Computer Setup.

CAUTION: When the computer is plugged into an AC power source, there is always voltage applied
to the system board. You must disconnect the power cord from the power source before opening the
computer to prevent system board or component damage.
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Solving General Problems
You may be able to easily resolve the general problems described in this section. If a problem
persists and you are unable to resolve it yourself or if you feel uncomfortable about performing the
operation, contact an authorized dealer or reseller.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to
cool before touching.

Table D-1  Solving General Problems

Computer appears locked up and will not turn off when the power button is pressed.

Cause Solution

Software control of the power switch is not functional. 1. Press and hold the power button for at least four
seconds until the computer turns off.

2. Disconnect the power cord from the electrical outlet.

Computer will not respond to USB keyboard or mouse.

Cause Solution

Computer is in standby mode. To resume from standby mode, press the power button or
press any key.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

System has locked up. Restart computer.

Computer date and time display is incorrect.

Cause Solution

RTC (real-time clock) battery may need to be replaced.

NOTE: Connecting the computer to a live AC outlet
prolongs the life of the RTC battery.

First, reset the date and time under Control Panel
(Computer Setup can also be used to update the RTC date
and time). If the problem persists, replace the RTC battery.
See the Removal and Replacement section for instructions
on installing a new battery, or contact an authorized dealer or
reseller for RTC battery replacement.

Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key may be on. Press the Num Lock key. The Num Lock light should not be
on if you want to use the arrow keys. The Num Lock key can
be disabled (or enabled) in Computer Setup.
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There is no sound or sound volume is too low.

Cause Solution

System volume may be set low or muted. 1. Check the F10 BIOS settings to make sure the internal
system speaker is not muted (this setting does not
affect the external speakers).

2. Make sure the external speakers are properly
connected and powered on and that the speakers'
volume control is set correctly.

3. Use the system volume control available in the
operating system to make sure the speakers are not
muted or to increase the volume.

Poor performance is experienced.

Cause Solution

Processor is hot. 1. Make sure airflow to the computer is not blocked. Leave
a 10.2-cm (4-inch) clearance on all vented sides of the
computer and above the monitor to permit the required
airflow.

2. Make sure fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Hard drive is full. Transfer data from the hard drive to create more space on
the hard drive.

Low on memory. Add more memory.

Hard drive fragmented. Defragment hard drive.

Program previously accessed did not release reserved
memory back to the system.

Restart the computer.

Virus resident on the hard drive. Run virus protection program.

Too many applications running. 1. Close unnecessary applications to free up memory.

2. Add more memory. Some applications run in the
background and can be closed by right-clicking on their
corresponding icons in the task tray. To prevent these
applications from launching at startup, go to Start > All
Programs > Accessories > Run and type msconfig.
On the Startup tab of the System Configuration Utility,
clear applications that you do not want to launch
automatically.

Some software applications, especially games, are stressful
on the graphics subsystem

1. Lower the display resolution for the current application
or consult the documentation that came with the
application for suggestions on how to improve
performance by adjusting parameters in the application.

2. Add more memory.

3. Upgrade the graphics solution.

Cause unknown. Restart the computer.
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Computer powered off automatically and the Power LED flashes Red two times, once every second, followed by a
two second pause, and the computer beeps two times. (Beeps stop after fifth iteration but LEDs continue flashing).

Cause Solution

Processor thermal protection activated:

A fan may be blocked or not turning.

OR

The heat sink is not properly attached to the processor.

1. Ensure that the computer air vents are not blocked and
the processor cooling fan is running.

2. Open hood, press power button, and see if the
processor fan spins. If the processor fan is not spinning,
make sure the fan's cable is plugged onto the system
board header.

3. If fan is plugged in, but is not spinning, then replace the
heat sink/fan assembly.

4. Contact an authorized reseller or service provider.

System does not power on and the LEDs on the front of the computer are not flashing.

Cause Solution

System unable to power on. Press and hold the power button for less than 4 seconds. If
the hard drive LED turns green, then:

1. Check that the voltage selector, located on the rear of
the power supply on some models, is set to the
appropriate voltage. Proper voltage setting depends on
your region.

2. Remove the expansion cards one at a time until the
5V_aux light on the system board turns on.

3. Replace the system board.

OR

Press and hold the power button for less than 4 seconds. If
the hard drive LED does not turn on green then:

1. Check that the unit is plugged into a working AC outlet.

2. Open hood and check that the power button harness is
properly connected to the system board.

3. Check that both power supply cables are properly
connected to the system board.

4. Check to see if the 5V_aux light on the system board is
turned on. If it is turned on, then replace the power
button harness.

5. If the 5V_aux light on the system board is off, then
replace the power supply.

6. Replace the system board.
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Solving Power Problems
Common causes and solutions for power problems are listed in the following table.

Table D-2  Solving Power Problems

Power supply shuts down intermittently.

Cause Solution

Voltage selector switch on rear of computer chassis (some
models) not switched to correct line voltage (115V or 230V).

Select the proper AC voltage using the selector switch.

Power supply will not turn on because of internal power
supply fault.

Contact an authorized service provider to replace the power
supply.

Computer powered off automatically and the Power LED flashes Red two times, once every second, followed by a
two second pause, and the computer beeps two times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Processor thermal protection activated:

A fan may be blocked or not turning.

OR

The heat sink is not properly attached to the processor.

1. Ensure that the computer air vents are not blocked and
the processor cooling fan is running.

2. Open hood, press power button, and see if the
processor fan spins. If the processor fan is not spinning,
make sure the fan's cable is plugged onto the system
board header.

3. If fan is plugged in, but is not spinning, then replace the
heat sink/fan assembly.

4. Contact an authorized reseller or service provider.

Power LED flashes Red four times, once every second, followed by a two second pause, and the computer beeps
four times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Power failure (power supply is overloaded). 1. Check that the voltage selector, located on the rear of
the power supply (some models), is set to the
appropriate voltage. Proper voltage setting depends on
your region.

2. Open the hood and ensure the 4- or 6-wire power
supply cable is seated into the connector on the system
board.

3. Check if a device is causing the problem by removing
ALL attached devices (such as hard, diskette, or optical
drives, and expansion cards). Power on the system. If
the system enters the POST, then power off and
replace one device at a time and repeat this procedure
until failure occurs. Replace the device that is causing
the failure. Continue adding devices one at a time to
ensure all devices are functioning properly.

4. Replace the power supply.

5. Replace the system board.
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Solving Diskette Problems
Common causes and solutions for diskette problems are listed in the following table.

NOTE: The computer does not support internal diskette drives. Only USB diskette drives are
supported.

NOTE: You may need to reconfigure the computer when you add or remove hardware, such as an
additional diskette drive. See Solving Hardware Installation Problems on page 164 for instructions.

Table D-3  Solving Diskette Problems

Diskette drive light stays on.

Cause Solution

Diskette is damaged. Right-click Start, click Explore, and right-click on a drive.
Select Properties then select the Tools tab. Under Error-
checking click Check Now.

Diskette is incorrectly inserted. Remove diskette and reinsert.

Drive cable is not properly connected. Reconnect drive cable. Ensure that all four pins on the
diskette power cable are connected to the drive.

Drive not found.

Cause Solution

Cable is loose. Reseat diskette drive data and power cable.

Removable drive is not seated properly. Reseat the drive.

The device has been hidden in Computer Setup. Run the Computer Setup utility and ensure Device Available
is selected for the Legacy Diskette in Security > Device
Security.

Diskette drive cannot write to a diskette.

Cause Solution

Diskette is not formatted. Format the diskette.

1. From Windows Explorer select the disk (A) drive.

2. Right-click the drive letter and select Format.

3. Select the desired options, and click Start to begin
formatting the diskette.

Diskette is write-protected. Use another diskette or remove the write protection.

Writing to the wrong drive. Check the drive letter in the path statement.

Not enough space is left on the diskette. 1. Use another diskette.

2. Delete unneeded files from diskette.

Diskette is damaged. Replace the damaged disk.
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Cannot format diskette.

Cause Solution

Invalid media reported. When formatting a disk in MS-DOS, you may need to specify
diskette capacity. For example, to format a 1.44-MB diskette,
type the following command at the MS-DOS prompt:

FORMAT A: /F:1440

Disk may be write-protected. Open the locking device on the diskette.

Legacy diskette writes are disabled in Computer Setup. Enter Computer Setup and enable Legacy Diskette Write in
Storage > Storage Options.

A problem has occurred with a disk transaction.

Cause Solution

The directory structure is bad, or there is a problem with a
file.

Right-click Start, click Explore, and right-click on a drive.
Select Properties then select the Tools tab. Under Error-
checking click Check Now.

Diskette drive cannot read a diskette.

Cause Solution

You are using the wrong diskette type for the drive type. Check the type of drive that you are using and use the
correct diskette type.

You are reading the wrong drive. Check the drive letter in the path statement.

Diskette is damaged. Replace the diskette with a new one.

“Invalid system disk” message is displayed.

Cause Solution

A diskette that does not contain the system files needed to
start the computer has been inserted in the drive.

When drive activity stops, remove the diskette and press the
Spacebar. The computer should start up.

Diskette error has occurred. Restart the computer by pressing the power button.

Cannot Boot to Diskette.

Cause Solution

Diskette is not bootable. Replace with a bootable diskette.
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Table D-3  Solving Diskette Problems (continued)

Cannot Boot to Diskette.

Cause Solution

Diskette boot has been disabled in Computer Setup. 1. Run Computer Setup and enable USB device in
Storage > Boot Order.

2. Run Computer Setup and enable USB device in
Storage > Storage Options > Removable Media
Boot.

NOTE: Both steps should be used as the Removable
Media Boot function in Computer Setup overrides the Boot
Order enable command.

Network server mode is enabled in Computer Setup. Run Computer Setup and disable Network Server Mode in
Security > Password Options.

Solving Hard Drive Problems

Table D-4  Solving Hard Drive Problems

Hard drive error occurs.

Cause Solution

Hard disk has bad sectors or has failed. 1. Right-click Start, click Explore, and right-click on a
drive. Select Properties then select the Tools tab.
Under Error-checking click Check Now.

2. Use a utility to locate and block usage of bad sectors. If
necessary, reformat the hard disk.

Disk transaction problem.

Cause Solution

Either the directory structure is bad or there is a problem with
a file.

Right-click Start, click Explore, and right-click on a drive.
Select Properties then select the Tools tab. Under Error-
checking click Check Now.

Drive not found (identified).

Cause Solution

Cable could be loose. Check cable connections.
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Table D-4  Solving Hard Drive Problems (continued)

Drive not found (identified).

Cause Solution

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 164 section. If the system still
does not recognize the new device, check to see if the
device is listed within Computer Setup. If it is listed, the
probable cause is a driver problem. If it is not listed, the
probable cause is a hardware problem.

If this is a newly installed drive, run the Computer Setup
utility and try adding a POST delay under Advanced >
Power-On.

The device is attached to a SATA port that has been hidden
in Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up. Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.

Nonsystem disk/NTLDR missing message.

Cause Solution

The system is trying to start from a diskette that is not
bootable.

Remove the diskette from the diskette drive.

The system is trying to start from the hard drive but the hard
drive may have been damaged.

1. Insert a bootable diskette into the diskette drive and
restart the computer.

2. Check the hard drive format using fdisk: If NTFS
formatting, use a third party reader to evaluate the
drive. If FAT32 formatting, the hard drive cannot be
accessed.

System files missing or not properly installed. 1. Insert a bootable diskette into the diskette drive and
restart the computer.

2. Check the hard drive format using Fdisk: If NFTFS
formatting, use a third party reader to evaluate the
drive. If FAT32 formatting, the hard drive cannot be
accessed.

3. Install system files for the appropriate operating system.

Hard drive boot has been disabled in Computer Setup. Run the Computer Setup utility and enable the hard drive
entry in the Storage > Boot Order list.

Bootable hard drive is not attached as first in a multi-hard
drive configuration.

If attempting to boot from a hard drive, ensure it is attached
to the system board dark blue SATA connector.

Bootable hard drive's controller is not listed first in the Boot
Order.

Run the Computer Setup utility and select Storage > Boot
Order and ensure the bootable hard drive's controller is
listed immediately under the Hard Drive entry.
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Computer will not boot from hard drive.

Cause Solution

The device is attached to a SATA port that has been hidden
in Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Boot order is not correct. Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Hard Drive's “Emulation Type” is set to “None.” Run the Computer Setup utility and change the “Emulation
Type” to “Hard Disk” in the device's details under Storage >
Device Configuration.

Hard drive is damaged. Observe if the front panel Power LED is blinking RED and if
any beeps are heard. See Appendix A, POST Error
Messages on page 128 to determine possible causes for the
blinking red and beep codes.

See the Worldwide Limited Warranty for terms and
conditions.

Computer seems to be locked up.

Cause Solution

Program in use has stopped responding to commands. Attempt the normal Windows “Shut Down” procedure. If this
fails, press the power button for four or more seconds to turn
off the power. To restart the computer, press the power
button again.

The removable hard drive has no power to the hard drive enclosure.

Cause Solution

The lock on the enclosure is not turned to the “ON” position. Insert the key and turn the lock clockwise 90 degrees. The
green LED on the front of the enclosure should be on.

Power cable from the computer power supply to the
enclosure frame is not properly connected.

Check the power supply to make sure it is properly
connected to the rear of the enclosure frame.

The removable hard drive is not recognized by the computer.

Cause Solution

The removable hard drive carrier is not fully seated in the
enclosure frame or the hard drive is not fully seated in the
carrier.

Push the carrier into the enclosure frame so that the
connector on the rear of the frame is properly seated. If this
does not solve the problem, turn off the computer, remove
the carrier, and check to see if the connector on the hard
drive is properly seated in the carrier.
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The removable hard drive enclosure is beeping and the green LED is flashing.

Cause Solution

Fan failure alarm on the removable hard drive enclosure has
been activated.

Shut down the computer and contact HP for a replacement
enclosure.

Solving Media Card Reader Problems

Table D-5  Solving Media Card Reader Problems

A write-protected or locked error occurs when attempting to write to the media card.

Cause Solution

Media card is locked. Locking the media card is a safety
feature that prevents writing to and deleting from an SD/
Memory Stick/PRO card.

If using an SD card, make sure that the lock tab located on
the right of the SD card is not in the locked position. If using
a Memory Stick/PRO card, make sure that the lock tab
located on the bottom of the Memory Stick/PRO card is not
in the locked position.

Can not write to the media card.

Cause Solution

The media card is a read-only memory (ROM) card. Check the manufacturer’s documentation included with your
card to see if it writable. Refer to the previous section for a
list of compatible cards.

Media card is locked. Locking the media card is a safety
feature that prevents writing to and deleting from an SD/
Memory Stick/PRO card.

If using an SD card, make sure that the lock tab located on
the right of the SD card is not in the locked position. If using
a Memory Stick/PRO card, make sure that the lock tab
located on the bottom of the Memory Stick/PRO card is not
in the locked position.

Unable to access data on the media card after inserting it into a slot.

Cause Solution

The media card is not inserted properly, is inserted in the
wrong slot, or is not supported.

Ensure that the card is inserted properly with the gold
contact on the correct side. The green LED will light if
inserted properly.

Do not know how to remove a media card correctly.

Cause Solution

The computer’s software is used to safely eject the card. Open Computer, right-click on the corresponding drive icon,
and select Eject. Then pull the card out of the slot.

NOTE: Never remove the card when the green LED is
flashing
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After installing the media card reader and booting to Windows, the reader and the inserted cards are not recognized
by the computer.

Cause Solution

The operating system needs time to recognize the device if
the reader was just installed into the computer and you are
turning the PC on for the first time.

Wait a few seconds so that the operating system can
recognize the reader and the available ports, and then
recognize whatever media is inserted in the reader.

After inserting a media card in the reader, the computer attempts to boot from the media card.

Cause Solution

The inserted media card has boot capability. If you do not want to boot from the media card, remove it
during boot or do not select the option to boot from the
inserted media card during the boot process.

Solving Display Problems
If you encounter display problems, see the documentation that came with the monitor and to the
common causes and solutions listed in the following table.

Table D-6  Solving Display Problems

Blank screen (no video).

Cause Solution

Monitor is not turned on and the monitor light is not on. Turn on the monitor and check that the monitor light is on.

Bad monitor. Try a different monitor.

The cable connections are not correct. Check the cable connection from the monitor to the computer
and to the electrical outlet.

You may have a screen blanking utility installed or energy
saver features are enabled.

Press any key or click the mouse button and, if set, type your
password.

System ROM is corrupted; system is running in Boot Block
Emergency Recovery Mode (indicated by eight beeps).

Reflash the system ROM with the latest BIOS image.

You are using a fixed-sync monitor and it will not sync at the
resolution chosen.

Be sure that the monitor can accept the same horizontal
scan rate as the resolution chosen.

Computer is in standby mode. Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Monitor cable is plugged into the wrong connector. Systems may have a monitor connection on both the
motherboard or an add-in card. Try moving the monitor
connection to a different connector on the back of the
computer
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Table D-6  Solving Display Problems (continued)

Blank screen (no video).

Cause Solution

Monitor settings in the computer are not compatible with the
monitor.

1. In Control Panel, under Appearance and
Personalization, select Adjust screen resolution.

2. Use the sliding control to reset the resolution.

Monitor is configured to use an input that is not active. Use the monitor's on-screen menu controls to select the
input that is being driven by the system. Refer to the
monitor's user documentation for more information on the on-
screen controls and settings.

Blank screen and the power LED flashes Red five times, once every second, followed by a two second pause, and
the computer beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video memory error. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Blank screen and the power LED flashes Red six times, once every second, followed by a two second pause, and
the computer beeps six times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video graphics error. For systems with a graphics card:

1. Reseat the graphics card. Power on the system.

2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace the system
board.

Blank screen and the power LED flashes Red seven times, once every second, followed by a two second pause, and
the computer beeps seven times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

System board failure (ROM detected failure prior to video). Replace the system board.
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Monitor does not function properly when used with energy saver features.

Cause Solution

Monitor without energy saver capabilities is being used with
energy saver features enabled.

Disable monitor energy saver feature.

Dim characters.

Cause Solution

The brightness and contrast controls are not set properly. Adjust the monitor brightness and contrast controls.

Cables are not properly connected. Check that the graphics cable is securely connected to the
graphics card and the monitor.

Blurry video or requested resolution cannot be set.

Cause Solution

If the graphics controller was upgraded, the correct graphics
drivers may not be loaded.

Install the video drivers included in the upgrade kit.

Monitor is not capable of displaying requested resolution. Change requested resolution.

Graphics card is bad. Replace the graphics card.

The picture is broken up, rolls, jitters, or flashes.

Cause Solution

The monitor connections may be incomplete or the monitor
may be incorrectly adjusted.

1. Be sure the monitor cable is securely connected to the
computer.

2. In a two-monitor system or if another monitor is in close
proximity, be sure the monitors are not interfering with
each other’s electromagnetic field by moving them
apart.

3. Fluorescent lights or fans may be too close to the
monitor.

Monitor needs to be degaussed. Degauss the monitor. Refer to the documentation that came
with the monitor for instructions.

Image is not centered.

Cause Solution

Position may need adjustment. Press the monitor's Menu button to access the OSD menu.
Select ImageControl/ Horizontal Position or Vertical
Position to adjust the horizontal or vertical position of the
image.
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“No Connection, Check Signal Cable” displays on screen.

Cause Solution

Monitor video cable is disconnected. Connect the video cable between the monitor and computer.

CAUTION: Ensure that the computer power is off while
connecting the video cable.

“Out of Range” displays on screen.

Cause Solution

Video resolution and refresh rate are set higher than what
the monitor supports.

Restart the computer and enter Safe Mode. Change the
settings to a supported setting then restart the computer so
that the new settings take effect.

Vibrating or rattling noise coming from inside a CRT monitor when powered on.

Cause Solution

Monitor degaussing coil has been activated. None. It is normal for the degaussing coil to be activated
when the monitor is powered on.

Clicking noise coming from inside a CRT monitor.

Cause Solution

Electronic relays have been activated inside the monitor. None. It is normal for some monitors to make a clicking noise
when turned on and off, when going in and out of standby
mode, and when changing resolutions.

High pitched noise coming from inside a flat panel monitor.

Cause Solution

Brightness and/or contrast settings are too high. Lower brightness and/or contrast settings.
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Fuzzy focus; streaking, ghosting, or shadowing effects; horizontal scrolling lines; faint vertical bars; or unable to
center the picture on the screen (flat panel monitors using an analog VGA input connection only).

Cause Solution

Flat panel monitor’s internal digital conversion circuits may
be unable to correctly interpret the output synchronization of
the graphics card.

1. Select the monitor’s Auto-Adjustment option in the
monitor’s on-screen display menu.

2. Manually synchronize the Clock and Clock Phase on-
screen display functions. To download a SoftPaq that
will assist you with the synchronization, go to the
following Web site, select the appropriate monitor, and
download either SP32347 or SP32202:
http://www.hp.com/support

Graphics card is not seated properly or is bad. 1. Reseat the graphics card.

2. Replace the graphics card.

Certain typed symbols do not appear correct.

Cause Solution

The font you are using does not support that particular
symbol.

Use the Character Map to locate and select the appropriate
symbol. Click Start > All Programs > Accessories >
System Tools > Character Map. You can copy the symbol
from the Character Map into a document.
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Solving Audio Problems
If the computer has audio features and you encounter audio problems, see the common causes and
solutions listed in the following table.

Table D-7  Solving Audio Problems

Sound cuts in and out.

Cause Solution

Processor resources are being used by other open
applications.

Shut down all open processor-intensive applications.

Sound does not come out of the speaker or headphones.

Cause Solution

Software volume control is turned down or muted. Double-click the Speaker icon on the taskbar, then make
sure that Mute is not selected and use the volume slider to
adjust the volume.

Audio is hidden in Computer Setup. Enable the audio in Computer Setup: Security >
Device Security > System Audio.

The external speakers are not turned on. Turn on the external speakers.

The audio device may be connected to the wrong jack. Ensure that the device is connected to the correct jack on the
computer. The speakers should be plugged into the rear line-
out jack and the headphones should be plugged into the
front headphone jack.

External speakers plugged into the wrong audio jack on a
recently installed sound card.

See the sound card documentation for proper speaker
connection.

Digital CD audio is not enabled. Enable digital CD audio. In the Device Manager, right-click
on the CD/DVD device and select Properties. Make sure
Enable digital CD audio for this CD-ROM device is
checked.

Headphones or devices connected to the line-out connector
mute the internal speaker.

Turn on and use headphones or external speakers, if
connected, or disconnect headphones or external speakers.

Computer is in standby mode. Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Internal speaker is disabled in Computer Setup. Enable the internal speaker in Computer Setup. Select
Advanced > Device Options > Internal Speaker.

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection, so multiple audio devices may be listed in
Device Manager. Make sure the correct device is being
used.
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Table D-7  Solving Audio Problems (continued)

Sound does not come out of the speaker or headphones.

Cause Solution

Some applications can select which audio output device is
used.

Make sure the application has selected the correct audio
device.

The operating system controls may be set to use a different
audio device as the default output device than what is
expected.

Set the operating system to use the correct audio device.

Sound from headphones is not clear or muffled.

Cause Solution

Headphones are plugged into the rear audio output
connector. The rear audio output connector is for powered
audio devices and is not designed for headphone use.

Plug the headphones into the headphone connector on the
front of the computer.

Computer appears to be locked up while recording audio.

Cause Solution

The hard disk may be full. Before recording, make sure there is enough free space on
the hard disk. You can also try recording the audio file in a
compressed format.

Line-in jack is not functioning properly.

Cause Solution

Jack has been reconfigured in the audio driver or application
software.

In the audio driver or application software, reconfigure the
jack or set the jack to its default value.

There is no sound or sound volume is too low.

Cause Solution

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection, so multiple audio devices may be listed in
Device Manager. Make sure the correct device is being
used.

Some applications can select which audio output device is
used.

Make sure the application has selected the correct audio
device.

The operating system controls may be set to use a different
audio device as the default output device than what is
expected.

Set the operating system to use the correct audio device.
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Solving Printer Problems
If you encounter printer problems, see the documentation that came with the printer and to the
common causes and solutions listed in the following table.

Table D-8  Solving Printer Problems

Printer will not print.

Cause Solution

Printer is not turned on and online. Turn the printer on and make sure it is online.

The correct printer drivers for the application are not
installed.

1. Install the correct printer driver for the application.

2. Try printing using the MS-DOS command:

DIR C:\ > [printer port]

where [printer port] is the address of the printer being
used. If the printer works, reload the printer driver.

If you are on a network, you may not have made the
connection to the printer.

Make the proper network connections to the printer.

Printer may have failed. Run printer self-test.

Printer will not turn on.

Cause Solution

The cables may not be connected properly. Reconnect all cables and check the power cord and
electrical outlet.

Printer prints garbled information.

Cause Solution

The correct printer driver for the application is not installed. Install the correct printer driver for the application.

The cables may not be connected properly. Reconnect all cables.

Printer memory may be overloaded. Reset the printer by turning it off for one minute, then turn it
back on.

Printer is offline.

Cause Solution

The printer may be out of paper. Check the paper tray and refill it if it is empty. Select online.
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Solving Keyboard and Mouse Problems
If you encounter keyboard or mouse problems, see the documentation that came with the equipment
and to the common causes and solutions listed in the following table.

Table D-9  Solving Keyboard Problems

Keyboard commands and typing are not recognized by the computer.

Cause Solution

Keyboard connector is not properly connected. 1. On the Desktop, click Start, click the arrow on the lower
right corner of the Start menu, then select Shut Down.

2. After the shutdown is complete, reconnect the keyboard
to the back of the computer and restart the computer.

Program in use has stopped responding to commands. Shut down your computer using the mouse and then restart
the computer.

Keyboard needs repairs. See the Worldwide Limited Warranty for terms and
conditions.

Computer is in standby mode. Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key may be on. Press the Num Lock key. The Num Lock light should not be
on if you want to use the arrow keys. The Num Lock key can
be disabled (or enabled) in Computer Setup.

Table D-10  Solving Mouse Problems

Mouse does not respond to movement or is too slow.

Cause Solution

Mouse connector is not properly plugged into the back of the
computer.

Shut down the computer using the keyboard.

1. Press the Ctrl and Esc keys at the same time (or press
the Windows logo key) to display the Start menu.

2. Use the arrow keys to select Shut Down and then
press the Enter key.

3. After the shutdown is complete, plug the mouse
connector into the back of the computer (or the
keyboard) and restart.

Program in use has stopped responding to commands. Shut down the computer using the keyboard then restart the
computer.
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Table D-10  Solving Mouse Problems (continued)

Mouse does not respond to movement or is too slow.

Cause Solution

Mouse may need cleaning. Remove the roller ball cover on the mouse and clean the
internal components.

Mouse may need repair. See the Worldwide Limited Warranty for terms and
conditions.

Computer is in standby mode. Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Mouse will only move vertically, horizontally, or movement is jerky.

Cause Solution

Mouse roller ball or the rotating encoder shafts that make
contact with the ball are dirty.

Remove roller ball cover from the bottom of the mouse and
clean the internal components with a mouse cleaning kit
available from most computer stores.
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Solving Hardware Installation Problems
You may need to reconfigure the computer when you add or remove hardware, such as an additional
drive or expansion card. If you install a plug and play device, Windows automatically recognizes the
device and configures the computer. If you install a non–plug and play device, you must reconfigure
the computer after completing installation of the new hardware. In Windows, use the Add Hardware
Wizard and follow the instructions that appear on the screen.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to
cool before touching.

Table D-11  Solving Hardware Installation Problems

A new device is not recognized as part of the system.

Cause Solution

Device is not seated or connected properly. Ensure that the device is properly and securely connected
and that pins in the connector are not bent down.

Cable(s) of new external device are loose or power cables
are unplugged.

Ensure that all cables are properly and securely connected
and that pins in the cable or connector are not bent down.

Power switch of new external device is not turned on. Turn off the computer, turn on the external device, then turn
on the computer to integrate the device with the computer
system.

When the system advised you of changes to the
configuration, you did not accept them.

Reboot the computer and follow the instructions for
accepting the changes.

A plug and play board may not automatically configure when
added if the default configuration conflicts with other devices.

Use Windows Device Manager to deselect the automatic
settings for the board and choose a basic configuration that
does not cause a resource conflict. You can also use
Computer Setup to reconfigure or disable devices to resolve
the resource conflict.

USB ports on the computer are disabled in Computer Setup. Run the Computer Setup utility and ensure that Device
available is selected for appropriate USB ports under
Security > USB Security.

Computer will not start.

Cause Solution

Wrong memory modules were used in the upgrade or
memory modules were installed in the wrong location.

1. Review the documentation that came with the system to
determine if you are using the correct memory modules
and to verify the proper installation.

NOTE: DIMM1 or XMM1 must always be installed.

2. Observe the beeps and LED lights on the front of the
computer. Beeps and flashing LEDs are codes for
specific problems.

3. If you still cannot resolve the issue, contact Customer
Support.
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Power LED flashes Red five times, once every second, followed by a two second pause, and the computer beeps
five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Memory is installed incorrectly or is bad. CAUTION: To avoid damage to the DIMMs or the system
board, you must unplug the computer power cord before
attempting to reseat, install, or remove a DIMM module.

1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

NOTE: DIMM1 or XMM1 must always be installed.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Power LED flashes Red six times, once every second, followed by a two second pause, and the computer beeps six
times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Graphics card is not seated properly or is bad, or system
board is bad.

For systems with a graphics card:

1. Reseat the graphics card. Power on the system.

2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace the system
board.

Power LED flashes Red ten times, once every second, followed by a two second pause, and the computer beeps ten
times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Bad option card. 1. Check each option card by removing the cards one at
time (if multiple cards), then power on the system to see
if fault goes away.

2. Once bad card is identified, remove and replace bad
option card.

3. Replace the system board.
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Solving Network Problems
Some common causes and solutions for network problems are listed in the following table. These
guidelines do not discuss the process of debugging the network cabling.

Table D-12  Solving Network Problems

Wake-on-LAN feature is not functioning.

Cause Solution

S5 Maximum Power Saving feature is enabled. Disable the S5 Maximum Power Saving option in Computer
Setup. Select Power > Hardware Power Management > S5
Maximum Power Saving.

S5 Wake on LAN is disabled. : Enable the S5 Wake on LAN option in Computer Setup.
Select Advanced > Device Options > S5 Wake on LAN.

Wake-on-LAN is not enabled. To enable Wake-on-LAN:

1. Select Start > Control Panel.

2. Under Network and Internet, select View network
status and tasks.

3. Click Local Area Connection.

4. Click the Properties button.

5. Click the Configure button.

6. Click the Power Management tab, then select the
check box to Allow this device to wake the computer.

Network driver does not detect network controller.

Cause Solution

Network controller is disabled. 1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system
via Device Manager.

Incorrect network driver. Check the network controller documentation for the correct
driver or obtain the latest driver from the manufacturer’s Web
site.

Network status link light never flashes.

NOTE: The network status light is supposed to flash when there is network activity.

Cause Solution

No active network is detected. Check cabling and network equipment for proper connection.

Network controller is not set up properly. Check for the device status within Windows, such as Device
Manager for driver load and the Network Connections applet
within Windows for link status.
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Table D-12  Solving Network Problems (continued)

Network status link light never flashes.

NOTE: The network status light is supposed to flash when there is network activity.

Cause Solution

Network controller is disabled. 1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system
via Device Manager.

Network driver is not properly loaded. Reinstall network drivers.

System cannot autosense the network. Disable auto-sensing capabilities and force the system into
the correct operating mode.

Diagnostics reports a failure.

Cause Solution

The cable is not securely connected. Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The cable is attached to the incorrect connector. Ensure that the cable is attached to the correct connector.

There is a problem with the cable or a device at the other
end of the cable.

Ensure that the cable and device at the other end are
operating correctly.

Network controller interrupt is shared with an expansion
board.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller is defective. Contact an authorized service provider.

Diagnostics passes, but the computer does not communicate with the network.

Cause Solution

Network drivers are not loaded, or driver parameters do not
match current configuration.

Make sure the network drivers are loaded and that the driver
parameters match the configuration of the network controller.

Make sure the correct network client and protocol is installed.

The network controller is not configured for this computer. Select the Network icon in the Control Panel and configure
the network controller.

Network controller stopped working when an expansion board was added to the computer.

Cause Solution

Network controller interrupt is shared with an expansion
board.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller requires drivers. Verify that the drivers were not accidentally deleted when the
drivers for a new expansion board were installed.

The expansion board installed is a network card (NIC) and
conflicts with the embedded NIC.

Under the Computer Setup Advanced menu, change the
resource settings for the board.
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Network controller stops working without apparent cause.

Cause Solution

The files containing the network drivers are corrupted. Reinstall the network drivers, using the Recovery Disc Set
created from the hard drive's Recovery Partition.

The cable is not securely connected. Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The network controller is defective. Contact an authorized service provider.

New network card will not boot.

Cause Solution

New network card may be defective or may not meet
industry-standard specifications.

Install a working, industry-standard NIC, or change the boot
sequence to boot from another source.

Cannot connect to network server when attempting Remote System Installation.

Cause Solution

The network controller is not configured properly. Verify Network Connectivity, that a DHCP Server is present,
and that the Remote System Installation Server contains the
NIC drivers for your NIC.

System setup utility reports unprogrammed EEPROM.

Cause Solution

Unprogrammed EEPROM. Contact an authorized service provider.

Solving Memory Problems
If you encounter memory problems, some common causes and solutions are listed in the following
table.

CAUTION: Power may still be supplied to the DIMMs when the computer is turned off (depending
on the Management Engine (ME) settings). To avoid damage to the DIMMs or the system board, you
must unplug the computer power cord before attempting to reseat, install, or remove a DIMM module.

For those systems that support ECC memory, HP does not support mixing ECC and non-ECC
memory. Otherwise, the computer will not boot the operating system.

NOTE: The memory count will be affected by configurations with the Management Engine (ME)
enabled. The ME uses 8MB of system memory in single channel mode or 16MB of memory in dual-
channel mode to download, decompress, and execute the ME firmware for Out-of-Band (OOB), third-
party data storage, and other management functions.
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Table D-13  Solving Memory Problems

System will not boot or does not function properly after installing additional memory modules.

Cause Solution

A memory module is not installed in the DIMM1 or XMM1
socket.

Ensure that a memory module is installed in the DIMM1 or
XMM1 socket on the system board. This socket must be
populated with a memory module.

Memory module is not the correct type or speed grade for
the system or the new memory module is not seated
properly.

Replace module with the correct industry-standard device for
the computer. On some models, ECC and non-ECC memory
modules cannot be mixed.

Out of memory error.

Cause Solution

Memory configuration may not be set up correctly. Use the Device Manager to check memory configuration.

You have run out of memory to run the application. Check the application documentation to determine the
memory requirements.

Memory count during POST is wrong.

Cause Solution

The memory modules may not be installed correctly. Check that the memory modules have been installed
correctly and that proper modules are used.

Integrated graphics may use system memory. No action required.

Insufficient memory error during operation.

Cause Solution

Too many Terminate and Stay Resident programs (TSRs)
are installed.

Delete any TSRs that you do not need.

You have run out of memory for the application. Check the memory requirements for the application or add
more memory to the computer.

Power LED flashes Red five times, once every second, followed by a two second pause, and the computer beeps
five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Memory is installed incorrectly or is bad. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.
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Solving Processor Problems
If you encounter processor problems, common causes and solutions are listed in the following table.

Table D-14  Solving Processor Problems

Poor performance is experienced.

Cause Solution

Processor is hot. 1. Make sure the airflow to the computer is not blocked.

2. Make sure the fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Power LED flashes Red three times, once every second, followed by a two second pause.

Cause Solution

Processor is not seated properly or not installed. 1. Check to see that the processor is present.

2. Reseat the processor.

Power LED flashes Red eleven times, once every second, followed by a two second pause.

Cause Solution

The current processor does not support a feature previously
enabled on this system.

1. Install a TXT capable processor.

2. Disable TXT in the Computer Setup (F10) utility.

3. Reinstall the original processor.

Solving CD-ROM and DVD Problems
If you encounter CD-ROM or DVD problems, see the common causes and solutions listed in the
following table or to the documentation that came with the optional device.

Table D-15  Solving CD-ROM and DVD Problems

System will not boot from CD-ROM or DVD drive.

Cause Solution

The device is attached to a SATA port that has been hidden
in the Computer Setup utility.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Removable Media Boot is disabled in the Computer Setup
utility.

Run the Computer Setup utility and enable booting to
removable media in Storage > Storage Options. Ensure
CD-ROM is enabled in Storage > Boot Order.

Network Server Mode is enabled in Computer Setup. Run the Computer Setup utility and disable Network Server
Mode in Security > Password Options.
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Table D-15  Solving CD-ROM and DVD Problems (continued)

System will not boot from CD-ROM or DVD drive.

Cause Solution

Non-bootable CD in drive. Try a bootable CD in the drive.

Boot order not correct. Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Drive not found (identified).

Cause Solution

Cable could be loose. Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 164 section. If the system still
does not recognize the new device, check to see if the
device is listed within Computer Setup. If it is listed, the
probable cause is a driver problem. If it is not listed, the
probable cause is a hardware problem.

If this is a newly installed drive, run the Computer Setup
utility and try adding a POST delay under Advanced >
Power-On Options.

The device is attached to a SATA port that has been hidden
in Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up. Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.

CD-ROM or DVD devices are not detected or driver is not loaded.

Cause Solution

Drive is not connected properly or not properly configured. See the documentation that came with the optional device.

Movie will not play in the DVD drive.

Cause Solution

Movie may be regionalized for a different country. See the documentation that came with the DVD drive.

Decoder software is not installed. Install decoder software.

Damaged media. Replace media.

Movie rating locked out by parental lock. Use DVD software to remove parental lock.

Media installed upside down. Reinstall media.
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Cannot eject compact disc (tray-load unit).

Cause Solution

Disc not properly seated in the drive. Turn off the computer and insert a thin metal rod into the
emergency eject hole and push firmly. Slowly pull the tray
out from the drive until the tray is fully extended, then remove
the disc.

CD-ROM, CD-RW, DVD-ROM, or DVD-R/RW drive cannot read a disc or takes too long to start.

Cause Solution

Media has been inserted upside down. Re-insert the media with the label facing up.

The DVD-ROM drive takes longer to start because it has to
determine the type of media played, such as audio or video.

Wait at least 30 seconds to let the DVD-ROM drive
determine the type of media being played. If the disc still
does not start, read the other solutions listed for this topic.

CD or DVD disc is dirty. Clean CD or DVD with a CD cleaning kit, available from most
computer stores.

Windows does not detect the CD-ROM or DVD-ROM drive. 1. Use Device Manager to remove or uninstall the device.

2. Restart the computer and let Windows detect the CD or
DVD driver.

Recording or copying CDs is difficult or impossible.

Cause Solution

Wrong or poor quality media type. 1. Try using a slower speed when recording.

2. Verify that you are using the correct media for the drive.

3. Try a different brand of media. Quality varies widely
between manufacturers.

Solving USB Flash Drive Problems
If you encounter USB flash drive problems, common causes and solutions are listed in the following
table.

Table D-16  Solving USB Flash Drive Problems

USB flash drive is not seen as a drive letter in Windows.

Cause Solution

The drive letter after the last physical drive is not available. Change the default drive letter for the flash drive in Windows.
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USB flash drive not found (identified).

Cause Solution

The device is attached to a USB port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure that “Device
available” is selected for “Front USB Ports” and “Rear USB
Ports” under Security > Device Security.

The device was not properly seated before power-up. Ensure the device is fully inserted into the USB port before
applying power to the system

System will not boot from USB flash drive.

Cause Solution

Boot order is not correct. Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Removable Media Boot is disabled in the Computer Setup
utility.

Run the Computer Setup utility and enable booting to
removable media in Storage > Storage Options. Ensure
USB is enabled in Storage > Boot Order.

The computer boots to DOS after making a bootable flash drive.

Cause Solution

Flash drive is bootable. Install the flash drive only after the operating system boots.

Solving Front Panel Component Problems
If you encounter problems with devices connected to the front panel, refer to the common causes and
solutions listed in the following table.

Table D-17  Solving Front Panel Component Problems

A USB device, headphone, or microphone is not recognized by the computer.

Cause Solution

Device is not properly connected. 1. Turn off the computer.

2. Reconnect the device to the front of the computer and
restart the computer.

The device does not have power. If the USB device requires AC power, be sure one end is
connected to the device and one end is connected to a live
outlet.

The correct device driver is not installed. 1. Install the correct driver for the device.

2. You might need to reboot the computer.

The cable from the device to the computer does not work. 1. If possible, replace the cable.

2. Restart the computer.

Solving Front Panel Component Problems 173



Table D-17  Solving Front Panel Component Problems (continued)

A USB device, headphone, or microphone is not recognized by the computer.

Cause Solution

The device is not working. 1. Replace the device.

2. Restart the computer.

USB ports on the computer are disabled in Computer Setup. Run the Computer Setup utility and ensure that Device
available is selected for appropriate USB ports under
Security > USB Security.

Solving Internet Access Problems
If you encounter Internet access problems, consult your Internet Service Provider (ISP) or refer to the
common causes and solutions listed in the following table.

Table D-18  Solving Internet Access Problems

Unable to connect to the Internet.

Cause Solution

Internet Service Provider (ISP) account is not set up
properly.

Verify Internet settings or contact your ISP for assistance.

Modem is not set up properly. Reconnect the modem. Verify the connections are correct
using the quick setup documentation.

Web browser is not set up properly. Verify that the Web browser is installed and set up to work
with your ISP.

Cable/DSL modem is not plugged in. Plug in cable/DSL modem. You should see a “power” LED
light on the front of the cable/DSL modem.

Cable/DSL service is not available or has been interrupted
due to bad weather.

Try connecting to the Internet at a later time or contact your
ISP. (If the cable/DSL service is connected, the “cable” LED
light on the front of the cable/DSL modem will be on.)

The CAT5 UTP cable is disconnected. Connect the CAT5 UTP cable between the cable modem
and the computers’s RJ-45 connector. (If the connection is
good, the “PC” LED light on the front of the cable/DSL
modem will be on.)

IP address is not configured properly. Contact your ISP for the correct IP address.

Cookies are corrupted. (A “cookie” is a small piece of
information that a Web server can store temporarily with the
Web browser. This is useful for having the browser
remember some specific information that the Web server can
later retrieve.)

1. Select Start > Control Panel.

2. Click Network and Internet.

3. Click Internet Options.

4. In the Browsing history section on the General tab,
click the Delete button.

5. Select the Cookies check box and click the Delete
button.
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Cannot automatically launch Internet programs.

Cause Solution

You must log on to your ISP before some programs will start. Log on to your ISP and launch the desired program.

Internet takes too long to download Web sites.

Cause Solution

Modem is not set up properly. Verify that the modem is connected and communicating
properly.

1. Select Start > Control Panel.

2. Click on Hardware and Sound.

3. Click on Device Manager.

4. Double-click Modems.

5. Double-click Agere Systems PCI-SV92PP Soft
Modem.

6. On the General tab, click Diagnostics.

7. Click Query Modem. A “Success” response indicates
the modem is connected and working properly.
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Solving Software Problems
Most software problems occur as a result of the following:

● The application was not installed or configured correctly.

● There is insufficient memory available to run the application.

● There is a conflict between applications.

● Be sure that all the needed device drivers have been installed.

● If you have installed an operating system other than the factory-installed operating system,
check to be sure it is supported on the system.

If you encounter software problems, see the applicable solutions listed in the following table.

Table D-19  Solving Software Problems

Computer will not continue and no HP logo screen has appeared.

Cause Solution

POST error has occurred. Observe the beeps and LED lights on the front of the
computer. See Appendix A, POST Error Messages
on page 128 to determine possible causes.

See the Restore Kit or the Worldwide Limited Warranty for
terms and conditions.

Computer will not continue after HP logo screen has appeared.

Cause Solution

System files may be damaged. Use recovery diskette to scan hard drive for errors.

“Illegal Operation has Occurred” error message is displayed.

Cause Solution

Software being used is not Microsoft-certified for your
version of Windows.

Verify that the software is certified by Microsoft for your
version of Windows (see program packaging for this
information).

Configuration files are corrupt. If possible, save all data, close all programs, and restart the
computer.
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Contacting Customer Support
For help and service, contact an authorized reseller or dealer. To locate a reseller or dealer near you,
visit http://www.hp.com.

NOTE: If you take the computer to an authorized reseller, dealer, or service provider for service,
remember to provide the setup and power-on passwords if they are set.

Refer to the number listed in the warranty or in the Support Telephone Numbers guide for technical
assistance.
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E Password Security and Resetting
CMOS

This computer supports security password features, which can be established through the Computer
Setup Utilities menu.

This computer supports two security password features that are established through the Computer
Setup Utilities menu: setup password and power-on password. When you establish only a setup
password, any user can access all the information on the computer except Computer Setup. When
you establish only a power-on password, the power-on password is required to access Computer
Setup and any other information on the computer. When you establish both passwords, only the
setup password will give you access to Computer Setup.

When both passwords are set, the setup password can also be used in place of the power-on
password as an override to log in to the computer. This is a useful feature for a network administrator.

If you forget the password for the computer, you can clear that password so you can gain access to
the information on the computer by resetting the password jumper.

CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is important to
back up the computer CMOS settings before resetting them in case they are needed later. Back up is
easily done through Computer Setup. See Computer Setup (F10) Utility on page 7 for information on
backing up the CMOS settings.
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Resetting the Password Jumper
To disable the power-on or setup password features, or to clear the power-on or setup passwords,
complete the following steps:

1. Shut down the operating system properly, then turn off the computer and any external devices,
and disconnect the power cord from the power outlet.

2. With the power cord disconnected, press the power button again to drain the system of any
residual power.

WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet, and allow the internal system
components to cool before touching.

CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can
result in damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Safety & Regulatory Information guide for more
information.

3. Remove the access panel.

4. Locate the header and jumper labeled CLR_PASS on models 3400/3405 or PASSWORD on
model 3410.

NOTE: The password jumper is blue so that it can be easily identified. For assistance locating
the password jumper and other system board components, see the Illustrated Parts & Service
Map (IPSM). The IPSM can be downloaded from http://www.hp.com/support.

5. Remove the jumper from pins 2 and 3.

6. Place the jumper on pins 1 or 2.

7. Put the jumper back on pins 2 or 3.

8. Replace the access panel.

9. Reconnect the external equipment.

10. Plug in the computer and turn on power. Allow the operating system to start. This clears the
current passwords and disables the password features.

11. To establish new passwords, use Computer Setup.

Clearing and Resetting the CMOS
The computer’s configuration memory (CMOS) stores information about the computer’s configuration.

The CMOS button resets CMOS but does not clear the power-on and setup passwords.

Clearing CMOS will clear the Active Management Technology (AMT) settings in the Management
Engine BIOS Extension (MEBx), including the password. The password will default to “admin” and will
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need to be reset. The AMT settings will also need to be reset. To access the MEBx, press Ctrl+P
during POST.

1. Shut down the operating system properly, then turn off the computer and any external devices,
and disconnect the power cord from the power outlet.

2. With the power cord disconnected, press the power button again to drain the system of any
residual power.

WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet, and allow the internal system
components to cool before touching.

CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can
result in damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Safety & Regulatory Information guide for more
information.

3. Remove the access panel.

4. Locate the header and jumper labeled CLR_CMOS on models 3400/3405 or CMOS on model
3410.

NOTE: The password jumper is blue so that it can be easily identified. For assistance locating
the password jumper and other system board components, see the Illustrated Parts & Service
Map (IPSM). The IPSM can be downloaded from http://www.hp.com/support.

5. Remove the jumper from pins 2 and 3.

6. Place the jumper on pins 1 or 2.

7. Put the jumper back on pins 2 or 3.

8. Replace the access panel.

9. Reconnect the external equipment.

10. Plug in the computer and turn on power. Allow the operating system to start. This clears the
current passwords and disables the password features.

NOTE: You will receive POST error messages after clearing CMOS and rebooting advising you that
configuration changes have occurred. Use Computer Setup to reset any special system setups along
with the date and time.

For instructions on Computer Setup, see Computer Setup (F10) Utility on page 7.
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F Backup and Recovery

Windows 7 – Backup and Recovery
To protect your information, use Windows® Backup and Restore to back up individual files and
folders, back up your entire hard drive (select models only), create system repair discs (select models
only), or create system restore points. In case of system failure, you can use the backup files to
restore the contents of your computer.

Windows Backup and Restore provides the following options:

● Creating a system repair disc (select models only)

● Backing up individual files and folders

● Creating a system image (select models only)

● Scheduling automatic backups (select models only)

● Creating system restore points

● Recovering individual files

● Restoring the computer to a previous state

● Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.

Backing Up Your Information

Recovery after a system failure is as complete as your most current backup. You should create
system repair discs (select models only) and your initial backup immediately after software setup. As
you add new software and data files, you should continue to back up your system on a regular basis
to maintain a reasonably current backup. The system repair discs (select models only) are used to
start up (boot) the computer and repair the operating system in case of system instability or failure.
Your initial and subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.
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Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.

The screen image is added to the document.

4. Save the document.

● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend
on the type of optical drive installed in your computer.

NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

● When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

To create a backup using Backup and Restore, follow these steps:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create a system repair disc (select models only).

NOTE: Windows® includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.
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Performing a Recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

● F11 recovery tools: You can use the F11 recovery tools to recover your original hard drive
image. The image includes the Windows operating system and software programs installed at
the factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
discs you previously created (select models only), you must purchase a Windows 7 operating system
DVD to reboot the computer and repair the operating system. For additional information, refer to the
“Using a Windows 7 operating system DVD (purchased separately)” section in this guide.

Using the Windows Recovery Tools

To recover information you previously backed up, follow these steps:

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to recover your system settings, your computer (select models
only), or your files.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

To recover your information using Startup Repair, follow these steps:

CAUTION: All files you have created and any software installed on the computer are permanently
removed. When reformatting is complete, the recovery process restores the operating system, as well
as the drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition and the HP Recovery partition.

To check for the Windows partition, select Start > Computer.

To check for the HP Recovery partition, select Start, right-click Computer, click Manage, and
then click Disk Management.

NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs using the System Recovery discs that you can obtain from
HP Support.

3. If the Windows partition and the HP Recovery partition are listed, restart the computer, and then
press F8 before the Windows operating system loads.

4. Select Repair Your Computer. The following options display: Startup Repair, System Restore,
System Image Recovery, Windows Memory Diagnostics, Command Prompt, Recovery
Manager.
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5. Select one of the first three listed tools to repair your computer.

6. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.

Using F11

CAUTION: Using F11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The F11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled.

If Windows 7 is not responding, but the computer is working, follow these steps to perform a System
Recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: select Start, right-click
Computer, click Manage, and then click Disk Management.

NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs using the System Recovery discs that you can obtain from
HP Support.

3. Press the Power button to turn on the computer.

4. As soon as you see the initial company logo screen appear, repeatedly press the F11 key on
your keyboard until the Windows is Loading Files… message appears on the screen.

5. Under I need help immediately, tap System Recovery.

6. If you are prompted to back up your files, and you have not done so, tap Back up your files
first (recommended), and then tap Next. Otherwise, tap Recover without backing up your
files, and then tap Next.

7. System Recovery begins. After System Recovery is complete, tap Finish to restart the
computer.

Using a Windows 7 Operating System DVD (purchased separately)

If you are unable to boot (start up) your computer and you cannot use the system repair discs you
previously created (select models only), you must use System Recovery discs that you can obtain
from HP Support to reboot the computer and repair the operating system. Make sure that your most
recent backup (stored on discs or on an external drive) is easily accessible.

CAUTION:  All files you have created and any software installed on the computer are permanently
removed. When reformatting is complete, the recovery process helps you restore the operating
system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD, follow these steps:
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NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical
drive before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.
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G Specifications

MT Specifications
Table G-1  Specifications

Chassis

Height

Width

Depth

14.49 in

6.50 in

15.31 in

36.8 cm

16.5 cm

38.9 cm

Approximate Weight 15.28 - 15.83 lb 6.932 - 7.18 kg

Temperature Range

Operating

Nonoperating

32° to 104°F

-22° to 149°F

0° to 40°C

-30° to 65°C

Relative Humidity (noncondensing)

Operating

Non-operating

15-95%

15-95%

15-95%

15-95%

Maximum Altitude (unpressurized)

Operating

Nonoperating

7,500 ft

15,000 ft

2286 m

4572 m

Power Supply

Energy Consumption

Heat Dissipation*

Normal Operation

Sleep (Energy Star Low Power Mode)

Off

230 VAC

55.6 W

1.45 W

0.90 W

Model

Rated Voltage Range

300W

100-240 VAC

1 *Heat dissipation is calculated based on the measured watts, assuming the service level is attained for one hour.
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SFF Specifications
Table G-2  Specifications

Chassis

Height

Width

Depth

12.77 in

4.98 in

15.61 in

32.5 cm

10.4 cm

39.7 cm

Approximate Weight 13.9 lb 6.3 kg

Temperature Range

Operating

Nonoperating

32° to 104°F

-22° to 149°F

0° to 40°C

-30° to 65°C

Relative Humidity (noncondensing)

Operating 15-95%

15-95%

15-95%

15-95%

Maximum Altitude (unpressurized)

Operating

Nonoperating

7,500 ft

15,000 ft

2286 m

4572 m

Power Supply

Energy Consumption

Normal Operation

Sleep (Energy Star Low Power Mode)

Off

142.7 KWh

39.61 W

1.55 W

0.67 W

Model

Rated Voltage Range

220W

100-240 VAC
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Index

Symbols/Numerics
24-pin power pin assignments

123
4-pin power pin assignments 120

A
access panel

removal and replacement 44
SFF removal and

replacement 81
SFF spare part number 81
spare part number 19, 26, 44

access panel, SFF
spare part number 27, 32

audible codes 137
audio problems 159

B
backing up files 181
Backup and Restore 181, 182
battery

disposal 42
removal and replacement 78,

117
beep codes 137
booting options

Full Boot 128
Quick Boot 128

C
cable connections 57, 94
cable management 56, 93
cable pinouts

SATA data 34
cautions

AC power 36
cables 42
cooling fan 41
electrostatic discharge 36

keyboard cleaning 40
keyboard keys 40

CD-ROM or DVD problems 170
cleaning

computer 39
mouse 41
safety precautions 39

CMOS
backing up 178
clearing and resetting 179

computer cleaning 39
connecting drive cables 59
connections

system board 57, 94
connector pin assignments 119
country power cord set

requirements 127
creating a backup 181
Customer Support 141, 177

D
disassembly preparation 43

SFF 80
diskette problems 148
drive connectors 60
drives

connecting cables 59
installing 59
removal and replacement 58
SFF cable connections 96
SFF installation 96
SFF locations 95

DVI pin assignments 122

E
electrostatic discharge (ESD) 36

preventing damage 37

error
codes 128, 137
messages 129

ethernet
BNC pin assignments 119

expansion card
SFF installation 89
SFF removal 89

expansion card sockets 51, 52,
89

expansion slot cover
removing 53
replacing 55

F
F11 recovery 184
fan

power supply 41
removal and replacement 69
SFF spare part number 107
spare part number 22, 25, 69

fan sink
removal and replacement 71
SFF spare part number 109
spare part number 22, 25, 71

fan sink, SFF
spare part number 30, 33

fan, SFF
spare part number 30, 33

features 1
flash drive problems 172
flashing LEDs 137
front bezel

removal and replacement 45
SFF removal and

replacement 83
SFF spare part number 83
spare part number 19, 45
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front bezel,
spare part number 26

front bezel, SFF
spare part number 27, 33

front fan
SFF removal and

replacement 107
front I/O and card reader assembly

SFF spare part number 104
spare part number 30, 33

Front I/O and USB assembly
spare part number 22, 26, 65

front I/O device
removal and replacement 65

front I/O, power switch assembly
SFF removal and

replacement 104
front panel problems 173

G
general problems 144
graphics card, spare part

number 31, 32, 89
grounding methods 37

H
hard drive

proper handling 42
removing 63
SATA characteristics 34
SFF installation 98
SFF removal 98
spare part number 32
spare part numbers 23, 24,

31, 32
hard drive problems 150
hard drive recovery 184
hardware installation problems

164
headphone pin assignments 120
heat sink

removal and replacement 71
SFF removal and

replacement 109
helpful hints 142
hood sensor

SFF removal and
replacement 102

I
installing

drive cables 59
SFF drive cables 96
SFF expansion card 89
SFF hard drive 98
SFF memory 84

Internet access problems 174

K
keyboard

cleaning 40
keyboard problems 162

L
LEDs

blinking power 137
blinking PS/2 keyboard 137

line-in audio pin assignments
120

line-out audio pin assignments
120

M
Media Card Reader problems

153
memory

populating sockets 47, 85
removal and replacement 46
SFF installation 84
specifications 46, 84

memory module
spare part number 46, 84

memory modules
spare part number 19, 24, 27,

31, 32
memory problems 168
microphone pin assignments 119
microtower components 3
monitor

pin assignments 121
monitor problems 154
mouse

cleaning 41
spare part number 22, 30

mouse problems 162

N
network problems 166
numeric error codes 129

O
operating guidelines 39
optical drive

removing 63
SFF removal 96
spare part numbers 23, 24,

31
optical drive problems 170
overheating, prevention 39

P
password

clearing 178
power-on 178
setup 178

PCI card 51, 52, 89
PCI Express card 51, 52, 54, 89
PCI Express pin assignments

124
POST error messages 128
power cord set requirements

country specific 127
power problems 147
power supply

fan 41
operating voltage range 186,

187
removal and replacement 76
SFF removal and

replacement 113
spare part number 19, 25

power supply, SFF
spare part number 27, 32

power switch/LED
removal and replacement 67

power switch/LED assembly
SFF spare part number 102
spare part number 21, 26, 67

power switch/LED assembly, SFF
spare part number 29, 33

power-on password 178
preparation for disassembly 43
printer problems 161
problems

audio 159
CD-ROM or DVD 170
diskette 148
flash drive 172
front panel 173
general 144
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hard drive 150
hardware installation 164
Internet access 174
keyboard 162
Media Card Reader 153
memory 168
monitor 154
mouse 162
network 166
power 147
printer 161
processor 170
software 176

processor
removal and replacement 73
SFF removal and

replacement 111
spare part number 19, 24, 27,

32
processor problems 170

R
recovering information 183
recovery partition 184
removal and replacement

access panel 44
battery 78, 117
drives 58
fan 69
fan sink 71
front bezel 45
front I/O device 65
heat sink 71
memory 46
power supply 76
power switch 67
processor 73
SFF front bezel 81, 83
SFF front fan 107
SFF front I/O, power switch

assembly 104
SFF heat sink 109
SFF hood sensor 102
SFF power supply 113
SFF processor 111
SFF system board 115
system board 77

removing
expansion slot cover 53
hard drive 63

optical drive 63
PCI Express card 54
PCI Express x1 card 54
SFF expansion card 89
SFF hard drive 98
SFF optical drive 96

resetting
CMOS 178
password jumper 178

restoring the hard drive 184

S
safety and comfort 141
safety precautions

cleaning 39
SATA

connectors on system board
34

data cable pinouts 34
hard drive characteristics 34

SATA cable
spare part number 21

SATA cable, SFF
spare part number 29

screws, correct size 41
SDRAM (synchronous dynamic

random access memory 46
serial interface pin assignments

121
service considerations 41
serviceability features 43
setup password 178
SFF

access panel, spare part
number 27, 32

disassembly preparation 80
fan sink, spare part number

30, 33
fan, spare part number 30, 33
front bezel removal and

replacement 81, 83
front bezel, spare part

number 27, 33
front fan removal and

replacement 107
front I/O, power switch

assembly removal and
replacement 104

heat sink removal and
replacement 109

hood sensor removal and
replacement 102

power supply removal and
replacement 113

power supply, spare part
number 27, 32

power switch/LED assembly,
spare part number 29, 33

preparation for disassembly
80

processor removal and
replacement 111

SATA cable, spare part
number 29

system board removal and
replacement 115

system board, spare part
number 27

small form factor components 4
software

problems 176
servicing computer 41

spare part number
tamper-resistent wrench 41
Torx T-15 screwdriver 41

specifications
computer 186
memory 46, 84

static electricity 36
system board

removal and replacement 77
SATA connectors 34
SFF removal and

replacement 115
spare part number 19, 77

system board drive connections
60

system board,
spare part number 25

system board, SFF
spare part number 27

T
tamper-proof screws

tool 41
temperature control 39
tools, servicing 41
Torx T15 screwdriver 41
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U
USB pin assignments 119

V
ventilation, proper 39

W
Wake-on-LAN feature 166
Windows 7 operating system

DVD 184

Index 191


	Product Features
	Feature Overview
	Microtower Components
	Small Form Factor Components

	Installing and Customizing the Software
	Installing the Operating System
	Downloading Microsoft Windows Updates
	Installing or Upgrading Device Drivers (Windows systems)
	Accessing Disk Image (ISO) Files
	Protecting the Software

	Computer Setup (F10) Utility
	Computer Setup (F10) Utilities
	Using Computer Setup (F10) Utilities
	Computer Setup—File
	Computer Setup—Storage
	Computer Setup—Security
	Computer Setup—Power
	Computer Setup—Advanced

	Recovering the Configuration Settings

	Illustrated parts catalog
	Microtower Chassis Spare Parts
	Computer Major Components
	Cables
	Misc Parts
	Drives
	Misc Boards
	Sequential Part Number Listing

	Small Form Factor (SFF) Chassis Spare Parts
	Computer major components
	Cables
	Misc Parts
	Drives
	Misc Boards
	Sequential Part Number Listing


	Serial ATA (SATA) Drive Guidelines and Features
	SATA Hard Drives
	SATA Hard Drive Cables
	SATA Data Cable

	SMART ATA Drives
	Hard Drive Capacities

	Routine Care and Disassembly Preparation
	Electrostatic Discharge Information
	Generating Static
	Preventing Electrostatic Damage to Equipment
	Personal Grounding Methods and Equipment
	Grounding the Work Area
	Recommended Materials and Equipment

	Operating Guidelines
	Routine Care
	General Cleaning Safety Precautions
	Cleaning the Computer Case
	Cleaning the Keyboard
	Cleaning the Monitor
	Cleaning the Mouse

	Service Considerations
	Power Supply Fan
	Tools and Software Requirements
	Screws
	Cables and Connectors
	Hard Drives
	Lithium Coin Cell Battery


	Removal and Replacement Procedures – Microtower Chassis
	Serviceability Features
	Preparation for Disassembly
	Access Panel
	Front Bezel
	Memory
	DDR3-SDRAM DIMMs
	Populating DIMM Sockets
	Removing Memory Modules

	Expansion Cards
	Cable Management
	Cable Connections

	Drives
	Installing Additional Drives
	System Board Drive Connections
	Removing an Optical Drive
	Removing a Hard Drive


	Front I/O and USB Panel Housing Assembly
	Power Switch/LED Assembly
	System Fan
	Fan Sink Assembly
	Processor
	Power Supply
	System Board
	Battery

	Removal and Replacement Procedures – Small Form Factor (SFF) Chassis
	Preparation for Disassembly
	Access Panel
	Front Bezel
	Memory
	DDR3-SDRAM DIMMs
	Populating DIMM Sockets
	Removing DIMMs

	Expansion Card
	Cable Management
	Cable Connections

	Drives
	Drive Positions
	Removing Drives
	Removing an Optical Drive
	Removing the Hard Drive


	Power Switch
	Front USB Assembly
	Fan Assembly
	Fan Sink
	Processor
	Power Supply
	System Board
	Battery

	Connector Pin Assignments
	Ethernet BNC
	USB
	Microphone
	Headphone
	Line-in Audio
	Line-out Audio
	4-Pin Power (for CPU)
	Monitor
	Serial Interface, Powered and Non-Powered
	DVI Connector
	24-Pin Power
	PCI Express
	PCI Express

	Power Cord Set Requirements
	General Requirements
	Japanese Power Cord Requirements
	Country-Specific Requirements

	POST Error Messages
	POST Numeric Codes and Text Messages
	Interpreting POST Diagnostic Front Panel LEDs and Audible Codes

	Troubleshooting Without Diagnostics
	Safety and Comfort
	Before You Call for Technical Support
	Helpful Hints
	Solving General Problems
	Solving Power Problems
	Solving Diskette Problems
	Solving Hard Drive Problems
	Solving Media Card Reader Problems
	Solving Display Problems
	Solving Audio Problems
	Solving Printer Problems
	Solving Keyboard and Mouse Problems
	Solving Hardware Installation Problems
	Solving Network Problems
	Solving Memory Problems
	Solving Processor Problems
	Solving CD-ROM and DVD Problems
	Solving USB Flash Drive Problems
	Solving Front Panel Component Problems
	Solving Internet Access Problems
	Solving Software Problems
	Contacting Customer Support

	Password Security and Resetting CMOS
	Resetting the Password Jumper
	Clearing and Resetting the CMOS

	Backup and Recovery
	Windows 7 – Backup and Recovery
	Backing Up Your Information
	Performing a Recovery
	Using the Windows Recovery Tools
	Using F11
	Using a Windows 7 Operating System DVD (purchased separately)



	Specifications
	MT Specifications
	SFF Specifications

	Index


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Gray Gamma 2.2)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.5
  /CompressObjects /All
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.1000
  /ColorConversionStrategy /sRGB
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 524288
  /LockDistillerParams true
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings false
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Remove
  /UCRandBGInfo /Remove
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
    /Courier
    /Courier-Bold
    /Courier-BoldOblique
    /Courier-Oblique
    /Helvetica
    /Helvetica-Bold
    /Helvetica-BoldOblique
    /Helvetica-Oblique
    /Symbol
    /Times-Bold
    /Times-BoldItalic
    /Times-Italic
    /Times-Roman
    /ZapfDingbats
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 150
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 150
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /ColorImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 150
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 150
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /GrayImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 600
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.33333
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects true
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile (None)
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /False

  /CreateJDFFile false
  /SyntheticBoldness 1.000000
  /Description <<
    /ENU (FOR Acrobat 9 HPIE Screen Optimized PDF compatible with Sceenshots under 225 dpi)
  >>
>> setdistillerparams
<<
  /HWResolution [600 600]
  /PageSize [612.000 792.000]
>> setpagedevice


